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N to Zenganar

KATA PENGANTAR

Alhamdulillah, Segala puji hanya bagi Allah, yang telah memberikan Karunia-nya sehingga penulis
dapat menyelesaikan buku panduan ini. Buku Panduan ini untuk melengkapi sekaligus sebagai
panduan sederhana dalam menggunakan distro linux Asril OS 10.0 Tebbu. Pada dasarnya buku
panduan ini hanyalah menguraikan secara sederhana program-program yang disertakan pada rilis
Asril OS kali ini.

Buku panduan ini di dipersembahkan untuk para pengguna open source di seluruh Indonesia.
Penulis juga mengucapkan terima kasih kepada temen-temen di dunia nyata dan dunia maya,
khususnya di forum-forum komunitas linux, yang telah memberikan dukungan sehingga Tim
Pengembang Asril OS dapat menyelesaikan pengembangan distro linux Asril OS ini.

Semoga dengan adanya buku panduan ini selain sebagai pelengkap distro linux Asril OS diharapkan
juga dapat meningkatkan kesadaran masyarakat untuk menghargai hak cipta orang lain serta
mengurangi budaya yang keliru yaitu nyaman menggunakan perangkat lunak bajakan. Akhir kata
buku panduan ini masih bayak kekurangan sehingga perlu adanya saran dan kritik untuk perbaikan.

Cirebon, Oktober 2023

Penulis
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BAB 1 Apa itu Linux dan Asril OS

1.1 Apa itu Linux?

Kata Linux saat ini semakin banyak didengar oleh pecinta Teknologi Informasi dan Komunikasi
(TIK) di seluruh dunia termasuk di Indonesia. Saat ini, Linux telah menjadi salah satu sistem
operasi yang banyak digunakan di berbagai kalangan, seperti kalangan bisnis, pendidikan, dan
pemerintahan. Hal ini disebabkan oleh Linux yang bersifat terbuka dan merdeka. Siapapun bisa
mengembangkannya dan menggunakannya secara bebas.

Linux merupakan kernel atau dasar dari sistem operasi yang pertama kali ditulis oleh seorang
mahasiswa Finlandia bernama Linus Benedict Torvalds pada tahun 1991. Hasil karyanya
dilisensikan secara bebas dan terbuka (Free Software) sehingga siapa saja boleh
mengembangkannya.

Kemudian Richard Stallman, seorang aktivis perangkat lunak pendiri Free Sofware Foundation
(FSF) berniat untuk menggabungkan Linux ke dalam proyek sistem operasinya yang bernama GNU
(GNU is Not Unix). Karena pada saat itu, proyek GNU sama sekali belum selesai
mengimplementasikan kernel sistem operasi. Akhirnya, dengan dirilisnya kernel Linux, terjadilah
perkawinan antara peralatan (tools) yang dibuat oleh proyek GNU dengan kernel Linux yang dibuat
oleh Linus Torvalds, sehingga menghasilkan sistem operasi baru bernama GNU/Linux, sebuah
sistem operasi yang mirip dengan UNIX. Kesemua komponen dari sistem operasi GNU/Linux
dilisensikan berdasarkan lisensi yang disebut GNU General Public License (GPL) yang ditulis
sendiri oleh Richard Stallman. Lisensi ini memungkinkan setiap orang untuk secara bebas
mengembangkan bahkan menjual Linux dengan syarat semua pengembangan yang telah dilakukan
harus juga dipublikasikan kepada umum.

Pada perkembangan selanjutnya, Linux juga dipaketkan dengan perangkat lunak lain untuk
keperluan tertentu seperti server, desktop, perkantoran, internet, multimedia, dan lain-lain sehingga
menjadikannya apa yang disebut dengan distribusi Linux atau yang sering dikenal dengan istilah
distro Linux. Karena sifat Linux yang terbuka, siapapun bisa memaketkan Linux dengan perangkat
lunak pilihannya dengan cara pemaketan masing-masing untuk membuat distribusi Linux.

Saat ini, banyak sekali terdapat distro-distro Linux yang memiliki segmen pasar, fitur, kelengkapan
dan cita rasa yang berbeda. Anda bisa melihat semua distribusi Linux yang ada melalui situs
http://www.distrowatch.com. Distro Linux juga bisa disebut sebagai sistem operasi atau operating
system (OS) karena sudah memiliki perangkat lunak untuk melakukan operasi pada komputer.

Linux pada awalnya berkembang di lingkungan server, karena Linux sangat handal dalam hal
kestabilan sistem. Namun, dengan semakin pesatnya dunia perangkat lunak terbuka, Linux kini juga
merambah ke dunia desktop. Perkembangan sangat pesat ini tidak lepas dari peran para sukarelawan
yang berjasa dalam menyumbangkan ide dan tenaganya untuk mengembangkan Linux.

1.2 Kelebihan Linux

Sebagai suatu sistem operasi, Linux secara umum memiliki berbagai kelebihan dan kekurangan
daripada sistem operasi lainnya. Berikut adalah kelebihan dari Linux :

* Linux bisa didapatkan secara bebas tanpa perlu membayar lisensi. Anda juga bisa
mengunduh kode sumber Linux jika ingin melihatnya tanpa ada batasan apapun.

* Linux memiliki koleksi perangkat lunak tersendiri yang sangat lengkap untuk keperluan
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laptop, desktop dan server. Jika perangkat lunak yang tersedia terasa kurang, Anda dapat
menambahkannya dengan mudah melalui repository yang tersedia.

* Linux sangat stabil karena jarang sekali crash maupun hang. Anda juga tidak perlu bahkan
tidak pernah melakukan restart jika melakukan konfigurasi sistem.

* Linux lebih aman terhadap virus, karena selain jumlah virus di Linux sangat sedikit. Linux
juga sangat ketat dalam hal pengelolaan keamanan.

* Perbaikan kutu (bug) atau cacat yang terdapat di Linux sangat cepat, karena Linux
dikembangkan secara komunitas dan setiap komunitas bisa memberikan masukan-masukan
dan perbaikan untuk kutu atau cacat tersebut.

Apapun yang memiliki kelebihan pasti memiliki kekurangan, karena pada hakikatnya apa yang
diciptakan oleh manusia tidak akan pernah sempurna. Berikut adalah berbagai kekurangan dari
Linux :

* Linux kurang memiliki dukungan dari produsen perangkat keras dalam hal penyediaan
perangkat lunak pengendali (driver). Hampir semua perangkat lunak pengendali yang saat
ini ada di Linux merupakan hasil jerih payah komunitas, dan sebagian kecil murni
dukungan dari produsen perangkat keras.

* Linux masih kurang didukung oleh beberapa pembuat permainan. Kebanyakan permbuat
permainan masih menggunakan sistem operasi Microsoft Windows sebagai platform
mereka.

1.3 Apa itu Asril 0OS?

Asril OS merupakan Distro Linux Lokal Indonesia yang berisikan perangkat lunak (software) yang
dapat digunakan untuk keperluan desktop, laptop dan notebook. Asril OS dilengkapi dengan
berbagai pernak-pernik khas Indonesia, distro ini cocok digunakan untuk pengguna komputer di
Indonesia.

Asril OS dikembangkan oleh Asril Marhamah bersama Tim Pengembang Asril OS. Asril OS bisa
didapatkan oleh siapa saja tanpa perlu membayar untuk mengunduhnya. Pengembangan Asril OS
dimaksudkan sebagai distribusi alternatif dalam menggunakan perangkat lunak yang bebas dan
legal. Asril OS menawarkan lingkungan kerja dengan Desktop Cinnamon yang mudah dalam
penggunaan yang dilengkapi dengan Program Office, Desain Grafis, Multimedia, Pendidikan,
Islami, Internet dan lain-lain.

1.4 Asal nama Asril OS

Asril OS, kalau dibaca bersambung menjadi asrilos. Frase asrilos terdiri dari dua kata yakni asri dan
los. Menurut Kamus Besar Bahasa Indonesia Asri yang berarti Indah dan los berarti bebas, lepas.
Maka digunakanlah semboyan "Indah, bebas, lepas" untuk distro yang sederhana ini. Asril OS bisa
juga diartikan sebagai Distro Linux yang dikembangkan oleh Asril Marhamah, sekaligus
memberikan identitas pada yang membuat distro linux ini.

1.5 Fitur Asril OS

Asril OS secara bawaan sudah terpasang banyak sekali program yang siap pakai untuk keperluan
sehari-hari. Bila perlu, Anda bisa memasang program lain dari katalog yang tersedia. Adapun fitur-
fitur Asril OS secara umum adalah sebagai berikut:

1. Menggunakan kernel Linux versi terbaru dengan dukungan perangkat keras yang banyak.
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Menggunakan Desktop Environment Cinnamon

Perangkat lunak untuk keperluan Anda berkomputer, seperti keperluan perkantoran, desain
grafis, multimedia, pendidikan, islami, internet, dan lain-lain.

Tersedia antarmuka menggunakan Bahasa Indonesia, sehingga bisa lebih dimengerti oleh
orang awam,

Sudah menyertakan dukungan format multimedia yang lengkap, seperti untuk memutar
mp3, DVD, dan format lainnya,

Menggunakan tema dan tampilan grafis yang intuitif dan ramah pengguna ( user friendly).
LibreOffice untuk keperluan perkantoran yang sangat mirip dan kompatibel dengan
Microsoft Office, dilengkapi dengan banyak Clip Art, palet (template) dan ekstensi.

GIMP dan Inkscape untuk kebutuhan grafis,

Peramban web Chromium untuk mengakses situs Internet,

. Program islami seperti Minbar, Monajat, HadisWeb, Zakat Kalkulator, Ayat, SalafiDB, Zekr,

Hijri Applet dan sebagainya.
dan masih banyak lagi perangkat lunak lainnya

1.1 Informasi Sistem

1.6 Info Lebih Lanjut

Info lebih lanjut mengenai Asril OS ini, anda dapat mengunjungi :

1.
2.
3.

https://www.asrilos.or.id/ web resmi Asril OS
https://www.facebook.com/AsrilOS Fans Page resmi Asril OS
http://asril-os.sourceforge.net/ SourceForge Page resmi Asril OS



http://asril-os.sourceforge.net/
https://www.facebook.com/AsrilOS
https://www.asrilos.or.id/
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BAB 2 Memasang Asril OS

Bab ini akan membahas bagaimana cara memasang Asril OS pada komputer. Pemasangan Asril OS
akan sangat mudah dilakukan apabila anda sudah memahami persiapan dan langkah-langkah apa
saja yang perlu dilakukan.

2.1 Kebutuhan Sistem

Sebelum melakukan pemasangan, terlebih dahulu komputer anda harus memenuhi syarat spesifikasi
minimal agar Asril OS bisa berjalan dengan lancar. Berikut ini adalah spesifikasi minimal untuk
Asril OS 10.0 Tebbu :

1. Prosessor dengan arsitektur amd64 (prosessor 64-bit).

Memori RAM 2 GB (direkomendasikan 4 GB untuk lebih baik).

Kartu video atau VGA minimal memiliki resolusi 800x600 (direkomendasikan 1024 x 768).
Harddisk dengan ukuran 40 GB (direkomenasikan 80 GB, lebih besar lebih baik).
Dukungan DVD Drive atau USB Port.

SN S

2.2 Cara Mendapatkan Asril OS

Untuk mendapatkan DVD Asril OS, anda bisa mengunduh file ISO-nya dari web resmi Asril OS.
Berkas ISO tersebut selanjutnya di burning ke DVD kosong menggunakan aplikasi pembakar CD /
DVD seperti Brasero, K3b, Nero, Roxio, dsb. Bagi anda yang memiliki koneksi terbatas atau
bahkan tidak memiliki internet sama sekali, jangan khawatir. Untuk mendapatkannya anda bisa
membeli DVD Asril OS dengan memesannya kepada kami, untuk info selengkapnya silahkan cek di
web resmi Asril OS.

2.3 Persiapan Menjelang Pemasangan

Sebelum melakukan pemasangan Asril OS lakukan beberapa persiapan seperti berikut:

1. Persiapkan DVD Asril OS sebagai bekal proses pemasangan, baca kembali sub bab
sebelumnya untuk mengetahui cara mendapatkan DVD Asril OS, pastikan DVD dalam
keadaan baik agar proses pemasangan lancar.

2. Backup atau buat cadangan dari data penting anda ke media penyimpanan cadangan (seperti
Flashdisk, Harddisk, CD/DVD) agar data anda aman dan terhindar dari resiko kehilangan.

3. Tentukan skema partisi harddisk yang anda inginkan. Partisi merupakan bagian ruang-ruang
data yang terdapat pada harddisk. Jika anda ingin melakukan dual-boot (terdapat dua sistem
operasi dalam satu komputer), anda harus membuat partisi baru pada harddisk komputer
yang nantinya akan digunakan sebagai tempat pemasangan Asril OS. Pembahasan lebih
lanjut akan dijelaskan pada sub bab pemasangan.

4. Pastikan untuk menjaga kestabilan tegangan listrik. Hal ini untuk menghindari listrik yang
tiba-tiba padam pada saat pemasangan dan menyebabkan terjadinya kerusakan fisik pada
komputer (terutama harddisk).

5. Lakukan penyetelan BIOS agar komputer membaca CD/DVD terlebih dahulu untuk proses
booting. Silahkan merujuk ke manual komputer atau motherboard anda mengenai cara
melakukan penyetelan ini.
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2.4 Persiapan Partisi

Sebelum mulai pemasangan, terlebih dahulu persiapkan partisi kosong untuk yang akan digunakan
sebagai tempat pemasangan Asril OS, misal di Windows, anda mempunyai drive C, dan D. salin
data yang ada di drive D ke media lain (flashdisk, external harddisk, atau harddisk lain). Drive D
akan kita gunakan sebagai tempat instalasi Asril OS. Jika anda mempunyai drive C, D, dan E, anda
bisa memindahkan data di drive E ke drive D, lalu drive E yang akan kita gunakan untuk instalasi
Asril OS. Jika semua bagian harddisk sudah terpartisi, anda bisa memotong partisi harddisk terakhir
dengan langkah berikut ini:

Peringatan! Jika partisi tersebut merupakan partisi windows, lakukan terlebih dahulu
defragmenting melalui tools “Disk Defragmenter” yang terdapat di sistem operasi Microsoft
Windows. Hal ini untuk menghindari partisi yang rusak pada saat melakukan pemotongan partisi.

1. Buka aplikasi editor partisi melalui Menu > Preferensi > Gparted (Editor Partisi).

2. Pada baris partisi yang ditampilkan, klik kanan pada partisi terakhir (yang paling kanan),
lalu pilih menu [>Ubah Ukuran/Pindahkan?<].

3. Tentukan ukuran baru dari partisi yang anda potong pada opsi [>Ukuran Baru (MiB)<].
Kemudian klik tombol [>Ubah Ukuran/Pindahkan?<].

4. Terakhir, klik tombol [>Terapkan<] pada toolbar untuk menerapkan perubahan yang
dilakukan.

Sekarang anda telah memiliki partisi kosong yang bisa anda manfaatkan untuk memasang Asril OS.

2.4.1 Catatan Mengenai Partisi

Partisi Primary /Primer

Jenis partisi ini merupakan jenis partisi utama diharddisk untuk system operasi pada
umumnya. Partisi primer hanya bisa dibuat maksimal 4 partisi, hal ini sangat berbeda
dengan sistem DOS yang hanya mengijinkan satu jenis partisi primer untuk sistem. Jika
kita memakai sistem operasi Linux jenis partisi ini akan terbaca sebagai partisi 1, 2, 3 dan
4. Misalnya terbaca sebagai sdal, sda2, sda3 dan sda4, sedangkan jika kita menggunakan
Sistem Operasi Windows akan terbaca sebagai partisi C,D,E dan F.

Partisi Extended /Perluasan

Merupakan partisi perluasan untuk mengatasi kekurangan partisi primer dimana hanya
dimungkinkan adanya 4 partisi. Jika ingin memiliki partisi lebih dari 4 maka partisi
extended /perluasan dibutuhkan yaitu dengan cara mengorbankan satu jenis partisi primer
kemudian digunakan sebagai partisi extended /perluasan.Didalam partisi perluasaan ini
nantinya dibuat partisi logical untuk mendapatkan partisi yang lebih banyak. Partisi
extended tidak dapat digunakan menyimpan data. Partisi jenis ini selalu menempati
nomor partisi +1 dari partisi primer. Misalnya ada 2 jenis partisi primer di harddisk sdal
dan sda2, maka posisi partisi extended adalah sda3.

Partisi Logical
Jenis partisi logical selalu dibuat didalam partisi extended /perluasan. Jika kita lihat
sepintas maka nomor partisi akan akan lompat 1 nomor. Misalnya kita membuat 5 jenis

partisi logical di sda3 maka masing-masing akan terbaca sebagai sda4, sda5 dan sda7,
sda8 dan seterusnya.
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2.5 Memasang Asril OS Melalui Live DVD

Untuk pemasangan melalui Live DVD, anda harus mempersiapkan Live DVD Asril OS. Masukkan
DVD tersebut ke dalam CD/DVD-ROM drive pada komputer anda. Restart komputer anda dan
anda akan melihat menu awal dari Live DVD Asril OS, tekan tombol Enter untuk masuk ke modus
Live DVD atau tunggu 10 detik, maka Distro Asril OS akan mulai dijalankan melalui DVD.

fisril 05 Live Disc Boot Options

Boot AspilNUBSInESafe Geaphics Mode
Direct InsStallSAsEilsIE

Run memtest

Check Asril 05 Distrosintegeity
Boot the First PC Havd Disk

Boot the First VirtualboxsHard Disk

Press [Tabl to edit Options

Automatic boot in 3 seconds...

2.1 Menu Boot Asril OS 10.0 Tebbu

Tunggu sebentar sampai proses booting selesai. (Apabila diminta nama pengguna gunakan nama
pengguna live tanpa password). Setelah proses booting selesai, maka anda akan melihat desktop
Asril OS. Anda bisa mencobanya terlebih dahulu sebelum memasangnya ke harddisk.

@ ".:r;-‘*j £) D D% ®fim €18 5 () @ sen,14Agu23,18:10

2.2 Desktop Asril OS 10.0 Tebbu
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Untuk melakukan pemasangan Asril OS, klik ganda ikon Asril OS Installer yang ada di desktop atau
klik Menu Utama > Preferensi > Asril OS Installer. Dan kemudian sebuah wahana pandu akan
membantu Anda dalam pemasangan Asril OS. Jika berjalan dengan baik, maka anda akan
mendapatkan tampilan selamat datang seperti gambar berikut ini.

2.3 Pilihan Bahasa

Pilih bahasa yang akan digunakan dalam Penglnstalan (Standar Bahasa Indonesia). Setelah itu,
lanjutkan dengan menekan tombol "Lanjutkan", maka anda akan mendapatkan tampilan untuk
memilih susunan keyboard seperti tampak pada gambar berikut ini.

2.4 Pilihan Susunan Keyboard

Disina anda akan diberi pilihan untuk menentukan susunan Keyboard yang akan digunakan
(Standar Inggris (AS) — Inggris (AS). Setelah itu lanjutkan dengan menekan tombol “Lanjutkan”,
maka anda akan mendapatkan tampilan untuk menyambungkan ke jaringan nirkabel (Wi-Fi) seperti
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tampak pada gambar berikut ini.

2.5 Jaringan Nirkabel

Disini, anda akan diberi pilihan apakah akan menyambung ke Jaringan Nirkabel (jika ada) atau
tidak. Abaikan saja, langsung tekan tombol “Lanjutkan” lagi untuk melanjutkan, maka anda akan
mendapatkan tampilan seperti gambar berikut.

2.6 Kodek Multimedia
Disini anda akan diberi pilihan untuk memasang kodek Multimedia, abaikan saja karena sudah
terpasang secara default. Langsung tekan tombol “Lanjutkan” lagi untuk melanjutkan, maka anda
akan mendapatkan tampilan seperti tampak pada gambar berikut ini.



2.7 Jenis Instalasi

ini, anda akan diberi pilihan untuk Jenis Instalasi.

Pada panduan ini Jenis Instalasi
yang dipilih yakni "Hapus diska dan pasang Asril OS" karena kita akan memasang Sistem Operasi
Asril OS secara otomatis. Jika sudah yakin, silahkan lanjutkan dengan tekan tombol “Lanjutkan”
maka anda akan mendapatkan tampilan seperti pada gambar berikut ini.

2.8 Hapus Harddisk dan Pasang

Jika sudah yakin, silahkan lanjutkan dengan tekan tombol “Pasang Sekarang”, maka anda kan
mendapatkan peringatan seperti tampak pada gambar berikut.



2.9 Peringatan

Disini anda mendapatkan peringatan, apakah akan menghapus seluruh harddisk beserta semua
datanya kemudian membuat partisi baru secara otomatis.

Jika sudah yakin, silahkan tekan lanjutan,
untuk melanjutkan ke tahap selanjutnya, maka anda akan mendapatkan tampilan seperti gambar
berikut.

2.10 Lokasi Anda

Silahkan pilih lokasi anda (atau biarkan saja secara default) dan lanjutkan ke tahap selanjutnya
dengan menekan tombol "Lanjutkan", maka anda akan mendapatkan tampilan konfigurasi
Pengguna seperti tampak pada gambar berikut ini.



N 1 i OS

Siapakah Anda?

N A ~

MNama komputer Anda:

Mama tersebut dipakai ketika saat berkomunikasi dengan komputer lain.

Tentukan nama pengguna: :

() Masuk secara ctomatis
() Memerlukan sandi untuk masuk
D Enkripsi Folder beranda saya

N o Kemball ][ Lsniwtkan |

2.11 Profil Pengguna

Silahkan masukkan Nama Anda, Nama Komputer Anda, Tentukan Nama Pengguna dan kata sandi
anda, serta pilihan untuk LogIn, ini sebagai Profil Pengguna anda. Setelah selesai, lanjutkan ke
tahap selanjutnya dengan menekan tombol "Lanjutkan"”, maka anda akan mendapatkan tampilan
Slide Show (ubiquity) dari Sistem Operasi Asril OS, seperti tampak pada gambar berikut ini.

Pasang

Welcome to Asril OS

Welcome and thank you For choosing
Asril 08, This slideshow will show you
around while the system is being
installed on your computer.

)} Menyalin berkas... Lewati
|

2.12. Tampilan Ubiquity
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Dan apabila Proses Instalasi telah selesai, maka akan ada pemberitahuan bahwa Instalasi sudah
selesai, seperti tampak pada gambar berikut ini. Anda dapat terus menggunakannya secara Live atau
merestar komputer anda dan mencoba menggunakan hasil Instalasi anda, seperti tampak pada
gambar berikut ini.

2.13 Instalasi Selesai

Selamat. Instalasi Asril OS ke dalam HardDisk anda telah berhasil. Anda dapat menggunakannya
seperti biasanya anda menggunakan komputer anda.

Untuk mencoba hasil Instalasi anda apakah berhasil atau tidak? Restart komputer anda dan pada
pilihan Boot pertama pilih HardDisk yang sudah anda Install Asril OS 10.0 Tebbu didalamnya tadi.
Jika berhasil, anda akan mendapatkan tampilan Desktop Asril OS, seperti tampak pada gambar 3.1.
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BAB 3 Desktop Asril OS

Asril OS menyediakan lingkungan kerja atau desktop environment yang sangat mudah digunakan
bernama Cinnamon. Desktop ini juga sangat sederhana, namun sangat lengkap dari sisi fitur. Pada
bab ini, dijelaskan mengenai pengenalan bagian serta pengaturan pada desktop Cinnamon yang ada
di Asril OS untuk keperluan bekerja sehari-hari.

3.1 Bagian-bagian Desktop

Saat komputer dinyalakan, Anda akan masuk ke dalam sistem Asril OS.

D% ® Jy= &£18 L ) @ Sen, 14agu23,18:10

3.1 Desktop Asril OS

Desktop Asril OS terdiri dari dua bagian utama, yaitu Area Kerja dan Panel. Area kerja merupakan
tempat dimana jendela-jendela program ditempatkan serta ikon-ikon desktop ditampilkan.
Sedangkan panel berisikan menu utama, ikon-ikon dan objek yang membantu Anda dalam bekerja.

3.2 Tombol Menu Utama

Menu Utama dari desktop Asril OS terdiri dari beberapa menu Panel yang siap Anda gunakan,
menu Panel ini terdiri dari berbagai kategori, seperti Perangkat Lunak Islami, Aksesoris,
Pendidikan, Grafik, Internet, Perkantoran, Suara & Video, Preferensi, dan Administrasi. Untuk
membuka suatu program, silahkan pilih pada menu yang anda kehendaki, kemudian klik program
yang akan dibuka. Menu Administrasi untuk membuka beberapa peralatan yang digunakan untuk
mengatur sistem yang berhubungan dengan perangkat keras, menu Preferensi untuk melakukan
pengaturan desktop maupun pengaturan sistem. Program Favorit di panel sebelah kiri. Menu Utama
ini ditandai dengan ikon logo Asril OS yang terletak di pojok kiri bawah desktop Asril OS.
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3.3 Jam dan Tanggal

Kadang kala Jam dan tanggal di notifikasi tidak sesuai dengan dengan keadaan yang ada, untuk
melakukan pengaturan Jam dan tanggal tersebut, lakukan langakh berikut ; klik Notifikasi jam dan
tanggal tersebut lalu pilih Pengaturan Tanggal dan Waktu atau bisa juga melalui Menu Utama >
Preferensi > Pengaturan Sistem pada sub menu Preferensi pilih “Date & Time”, pada jendela yang
ada. Silahkan pilih mau “Gunakan waktu jaringan” atau mengaturnya secara manual <untuk
mengatur secara manual, silahkan buka kunci-nya dan masukkan password anda kemudian sesuai

dengan keinginan anda.

( )

ke @ OO0 -

3.2 Menu Utama

3.3 Date & Time

Waktu Jaringan @:]

a a

21 :48

v v
[s |=[+] [mnar  ~| [2016 [=[+]
wilayah: [Asca "'J Kota: [Jai_(a_na- 7] l & Buka kunci J

Format

Pergunakan format 24 jam
Tampilkan tanggal CB




Y Desktop asritos
3.4 Daftar Jendela dan Notifikasi

ﬁ.@ h“d@ z ﬂ “Dve s =2 B = () ® sab,210kt23,22:02
3.4 Jendela dan Notifikasi

Bilah ini berisi daftar program yang terbuka pada suatu area kerja terletak di sebelah kiri dan
menampilkan notifkasi program yang sedang aktif terletak di sebelah kanan.

3.5 Pojok Interaktif

Asril OS secara default menyediakan dua buah area kerja yang bisa Anda gunakan. Jika sebuah area
kerja penuh, Anda bisa berpindah ke area kerja lainnya dengan memanfaatkan “pojok interaktif”
dengan mengarahkan mouse pointer anda ke pojok kiri atas desktop. Anda dapat menggeser suatu
jendela dari suatu area kerja ke area kerja lainnya dengan cara klik dan tahan program tersebut
kemudian seret ke tujuan area kerja lainnya.

3.5 Pojok Interaktif

3.6 Bekerja dengan Program

Untuk membuka suatu program pada Asril OS, Anda bisa membukanya dengan klik Menu Utama.
Program yang berada di dalam menu tersebut dikelompokkan berdasarkan jenisnya, yaitu :
Perangkat Lunak Islami, Aksesoris, Pendidikan, Grafik, Internet, Perkantoran, Suara & Video,
Preferensi, Administrasi, Tempat dan Berkas Terkini. Jadi, Anda bisa lebih mudah mencari program
yang ingin Anda buka. Untuk membuka Menu Utama, anda bisa menggunakan Tombol WIN
(jendela) yang ada di keyboard anda.
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3.7 Menambahkan Menu Program pada Panel

Anda dapat menambah atau mengurangi Program yang sering dipakai pada panel bagian bawah
sesuai dengan keinginan. Anda bisa melakukannya dengan meng-klik kanan program yang akan
anda masukan ke dalam Panel bawah, kemudian pilih opsi tambahkan ke panel, untuk
menghapusnya klik kanan pada program tersebut menggunakan Tetikus kemudian pilih “Buang”.

3.8 Mengunci Layar

Jika Anda hendak meninggalkan komputer dalam keadaan hidup dan Anda tidak ingin komputer
diutak-atik oleh orang lain, Anda bisa mengunci layar komputer Anda. Sehingga, jika ingin kembali
bekerja dengan desktop, Anda harus kembali memasukkan sandi Anda terlebih dahulu. Untuk
melakukan hal ini, Anda bisa mengaktifkan fitur kunci layar dengan memilih Menu Utama
kemudian pada panel sebelah kanan pilih “Kunci Layar” (lihat pada gambar 3.2) atau
menggunakan tombol pintas dengan menekan tombol Ctrl+Alt+L pada papan ketik Anda.

Pada kondisi terkunci monitor komputer akan menampilkan tanggal dan waktu dengan latar
belakang desktop, kalau sudah lama menjadi hitam (blank). Jika ingin mengaktitkan desktop, geser
mouse atau tekan sembarang tombol di keyboard, lalu masukkan sandi Anda kembali.

06:48

Minggu, Februari 21

3.6 Layar Terkunci

3.9 Pengaturan Latar Belakang

Anda bisa melakukan pengaturan penampilan melalui fitur yang sudah disediakan melalui Menu
Utama > Preferensi > Pengaturan Sistem pada sub Penampilan pilih “Latar Belakang”
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3.7 Latar Belakang

Pada edisi kali ini, ada dua jenis pemilihan Latar Belakang yang dapat anda gunakan. Anda dapat
menggunakan walpaper tunggal atau live walpaper (walpaper berganti-ganti sesuai dengan waktu
yang telah ditentukan). Untuk walpaper tunggal, silahkan pilih gambar yang sesuai dengan
keinginan anda, dengan meng-klik langsung gambar yang anda inginkan, sedangkan live walpaper,
silahkan pilih folder gambar sesuai dengan keinginan anda dan jangan lupa aktifkan “Play
backgrounds as a slideshow” pada bagian “Pengaturan”, silahkan tentukan waktu yang anda
inginkan. Jika anda merasa kurang puas dengan gambar yang ada, anda dapat menambahkannya
dengan mudah, dengan klik tombol “+” yang ada di pojok kiri bawah. Segera setelah pengaturan
selesai, Anda bisa melihat langsung perubahannya. Pengaturan lebih lanjut dengan klik “Pilihan
Lanjutan” yang ada di sebelah kiri bawah, silahkan pilih “Aspek Gambar” dan “Gradasi” yang anda
inginkan.

3.10 Pengaturan Informasi Pribadi

Untuk melakukan pengaturan informasi pribadi seperti nama, foto, kata sandi dan sebagainya untuk
disimpan oleh sistem, Anda bisa membuka pengaturannya melalui Menu Utama > Administrasi >
Pengguna dan Grup. Silahkan masukkan password anda.



Desktop Asril OS

Pengguna dan Grup -+ %

‘ Tambah | Hapus _I
3.8 Akun Pengguna

Pada jendela akun pengguna, Anda bisa memberi informasi pribadi Anda yaitu :

v
v
4
v
v

Gambar
Jenis Akun
Nama
Kata Sandi
Grup

Untuk mengganti informasi tersebut klik pada nilai saat ini dan selanjutnya bantuan petunjuk
panduan akan dimunculkan.

3.11 Mengakhiri Sesi

Untuk mengakhiri sesi bekerja Anda di Asril OS tanpa mematikan komputer, Anda bisa klik Menu
Utama pada panel sebelah kiri pilih “Keluar” (lihat pada gambar 3.2). Terdapat tiga perintah yang
bisa Anda jalankan, yaitu :

v
v
4

Keluar dari sistem ini sekarang?

3.9 Keluar

Ganti Pengguna > Untuk mengakhiri sesi dan login dengan pengguna lain.
Batal > Untuk membatalkan
Keluar > Untuk mengakhiri sesi dan keluar ke jendela login.



I .10y 15if 05

3.12 Mematikan Komputer

Untuk mematikan komputer, Anda bisa klik Menu Utama pada panel sebelah kiri pilih “Berhenti”
(lihat pada gambar 3.2). Terdapat empat perintah yang bisa Anda jalankan, yaitu :

Matikan sistem ini sekarang?

Matikan

3.10 Matikan

v Suspensi > Untuk mematikan komputer tanpa perlu mengakhiri sesi Anda. Sesi akan
disimpan ke Memori dan akan dikembalikan jika komputer kembali dihidupkan.

v Hidupkan Ulang > Untuk mengakhiri sesi, mematikan komputer dan menghidupkannya lagi.
v Batal > Untuk membatalkan
v Matikan > Untuk mengakhiri sesi dan mematikan komputer.
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BAB 4 Menggunakan Perambah Berkas

Untuk melakukan manajemen berkas pada komputer, Anda dapat menggunakan aplikasi perambah
berkas yang bernama Nemeo. Bab ini menjelaskan mengenai cara menggunakan Nemo untuk
keperluan manajemen berkas sekaligus mengenalkan konsep manajemen berkas yang ada di Asril
OS.

- I ——
i

4.1 Menggunakan Nemo

Untuk melakukan pengelolaan berkas menggunakan Nemo sangatlah mudah. Bagi Anda yang sudah
biasa menggunakan Microsoft Windows tidak akan mengalami kesulitan karena yang berbeda
hanyalah penampakannya saja (menu dan bahasa saja yang berbeda). Cara menyalin dan menempel
berkas dan atau direktori, menyeleksi direktori atau berkas tidak berbeda antara Asril OS dan
Windows. Demikian pula membuat direktori, mengganti nama direktori atau berkas, menghapus
direktori atau berkas juga sama dengan Windows. Membuka berkas atau direktori yang ada di
Nemo pun sama dengan Windows yaitu dengan klik ganda. Misalkan kita hendak menghapus
direktori atau berkas, kalau menggunakan tombol Delete berkas atau direktori akan dipindah ke
direktori tempat Sampah (Recycle Bin kalau di Windows) tetapi jika menggunakan menggunakan
tombol Shift+Delete berkas atau direktori akan benar — benar dihapus. Untuk membuka File
Manager Nemo, pilih Menu Utama > Aksesoris > Berkas. Anda juga bisa menggunakan menu
pintas dengan menakan tombol WIN (Jendela) + E, seperti yang biasa anda lakukan di Microsoft
Windows.

Semua Aplikasi

Grafik

n
w
03
=




N ko erambaf Beras

Berikut adalah folder yang ada Home Direktori Anda :

v [ Dokumen ] merupakan direktori di dalam direktori beranda yang diperuntukkan untuk
menyimpan dokumen.

v [ Musik ] merupakan direktori di dalam direktori beranda yang diperuntukkan untuk
menyimpan musik.

v [ Gambar ] merupakan direktori di dalam direktori beranda yang diperuntukkan untuk
menyimpan gambar atau foto.

v [ Video ] merupakan direktori di dalam direktori beranda yang diperuntukkan untuk
menaruh video.

v [ Unduban ] merupakan direktori di dalam direktori beranda yang diperuntukkan untuk
menaruh berkas unduhan.

Direktori-direktori tersebut tidaklah mutlak. Direktori tersebut sudah disediakan demi kenyamanan
Anda. Pada kenyataannya Anda (sebagai pengguna biasa) dapat membuat direktori sebanyak yang
Anda inginkan dan di mana saja asal di dalam direktori beranda.

4.2 Hirarki Partisi

C® 00« £1m~= () @ Sab, 20 Feb 21, 21:21

4.2 Hirarki Partisi

Di Asril OS, Anda tidak akan mengenal istilah drive seperti pada Microsoft Windows. Direktori
paling atas yang ada di sistem adalah direktori / atau root yang merupakan isi partisi sistem. Di
dalam direktori / terdapat berbagai subdirektori yang memiliki fungsi masing-masing, yaitu :

v [ /bin ] menyimpan binari atau program yang sangat penting untuk sistem.

v [ /boot ]| menyimpan data-data yang diperlukan untuk melakukan booting sistem

v [ /cdrom ] merupakan titik kait/mount point jika Anda memasukkan CD/DVD-ROM.
v

[ /dev ] menyimpan informasi yang bertautan dengan piranti keras yang terpasang ke sistem.
Biasanya diperlukan untuk merujuk suatu lokasi piranti keras yang ada di sistem.

v [ /etc ] menyimpan konfigurasi sistem berbentuk berkas teks.
v [ /home ] menyimpan data-data yang dimiliki oleh pengguna non-administratif.
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[ /lib ] menyimpan pustaka sistem yang sangat penting.

AN

v [ /media ] tempat untuk mengaitkan perangkat penyimpanan eksternal.

v [ /opt ] tempat untuk menyimpan berkas-berkas piranti lunak pihak ketiga misal xampp,
adobe reader.

v [ /sbin ] menyimpan binari atau program yang penting untuk melakukan administrasi sistem.

v [ /tmp ] menyimpan berkas-berkas yang bersifat sementara. Bila Anda sedang memutar
video streaming (youtube, dan lain-lain), berkas video yang dilihat tersimpan disini. Jadi
jika film yang Anda lihat sudah selesai, tinggal salin berkas ke direktori pilihan Anda. Ini
merupakan keuntungan menggunakan Asril OS melihat youtube sekaligus mengunduhnya
tanpa bantuan piranti lunak lain.

v [ /usr ] menyimpan berkas-berkas pendukung piranti lunak yang terpasang di sistem.
Gambar latar (Wallpaper), ikon, atau berkas suara yang digunakan sistem tersimpan disini.

v [ /var ] menyimpan berkas-berkas yang selalu berubah atau variabel, seperti catatan sistem,
surel pengguna, dan sebagainya.

4.3 Hak Akses Berkas dan atau direktori

Setiap berkas dan direktori memiliki pemilik serta izin masing-masing. Tidak semua direktori bisa
diakses dan diubah oleh semua pengguna. Hal ini untuk menjaga kestabilan sistem dan menghindari
pengguna yang ceroboh atau sengaja untuk merusak sistem. Pengguna biasa hanya bisa mengelola
berkas di dalam direktori /home/akunpengguna yang memang dimiliki oleh pengguna
bersangkutan. Anda bisa membukanya melalui Menu Utama > Tempat pada destop Asril OS. Selain
direktori tersebut, pengguna harus mempunyai izin khusus dari administrator sistem. Penamaan
berkas di Asril OS juga sangat berbeda dengan Windows. Di Asril OS, penamaan berkas
memperhatikan huruf besar dan huruf kecil (case sensitive). Jadi, Anda bisa membuat berbagai
berkas dengan nama yang sama, tetapi dengan derajat huruf yang berbeda. Contohnya, Anda bisa
membuat berkas “Dataku”, “dataKU”, “dataku”, “daTAku”, dan sebagainya dalam satu direktori
tanpa ada konflik.

Untuk membuka isi partisi selain partisi sistem atau suatu media penyimpanan, partisi yang ingin
Anda buka harus dikaitkan (mounting) ke suatu direktori (umumnya di bawah direktori /media)
sehingga isi dari partisi atau media penyimpanan tersebut bisa dilihat dan dikelola hanya dengan
membuka direktori tersebut. Jika sedang menggunakan desktop, Anda tidak perlu melakukan
pengaitan secara manual setiap ingin membuka isi media peyimpanan karena Asril OS sudah
melakukannya untuk Anda. Anda bisa melihat isi media penyimpanan melalui Menu Utama >
Tempat pada desktop Asril OS. Hal unik lainnya pada manajemen berkas di Asril OS adalah
pengaturan hak aksesnya yang sangat detail dan ketat. Setiap berkas atau direktori yang ada di
partisi Asril OS memiliki beberapa parameter mengenai hak akses, yaitu:

v [ Pengguna pemilik berkas/direktori ] berisi identitas pengguna dari pemilik suatu
berkas/direktori.

v [ Kelompok pemilik berkas/direktori ]| berisi identitas kelompok yang memiliki suatu
berkas/direktori.

v [ Hak akses untuk pemilik ] berisikan hak apa saja yang boleh dilakukan oleh pengguna
pemilik berkas/direktori terhadap suatu berkas/direktori.

v [ Hak akses untuk kelompok ] berisikan hak apa saja yang boleh dilakukan oleh
kelompok pemilik berkas/direktori terhadap suatu berkas/direktori.
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Unduhan Properti *x

Dasar | lzin | Bagi-Pakai

Pemilik:

Akses folder: | Membuat dan menghapus berkas |
Akses berkas: | - |
Kelompok: | asrilmarhamah -

Akses folder: |Akses berkas - |
Akses berkas: | - |
Lainnya

Akses folder: |Akses berkas - |

Akses berkas: | - |

Terakhir diubah: tidak diketahui

| Terapkan Hak Akses pada Berkas yang Disertakan |

| Bantuan | | Tutup

4.3 Hak Akses

Hak akses untuk yang lainnya, berisikan hak apa saja yang boleh dilakukan oleh pengguna selain
pemilik dan kelompok selain kelompok pemilik terhadap suatu berkas / direktori. Setiap objek hak
akses yang ada di atas memiliki tugas hak, yaitu: Baca (Read), Tulis (Write, dan Eksekusi
(eXecution). Setiap objek hak akses juga bisa memiliki perpaduan hak yang berbeda, ada yang bisa
dibaca saja, ada yang bisa dibaca dan dieksekusi saja, dan ada juga yang memiliki hak mutlak
(baca, tulis dan eksekusi).

Untuk mengatur hak akses dari berkas / direktori, klik kanan pada berkas / direktori yang ingin
diubah hak aksesnya, lalu klik pada menu Properti. Pada jendela Properti, klik pada tab Izin.

Berikut adalah penjelasan dari masing-masing pengaturan:

v [ Mengatur pemilik dari berkas / direktori | Yang hanya bisa mengatur pemilik dari suatu
berkas / direktori adalah administrator.

v [ Mengatur kelompok yang memiliki berkas / direktori ] Yang bisa mengatur bagian ini
adalah pemilik berkas/direktori tersebut.

v Mengatur hak apa saja yang bisa dilakukan oleh pemilik berkas.
v Mengatur hak apa saja yang bisa dilakukan oleh pengguna/kelompok pemilik berkas.

v Mengatur hak apa saja yang bisa dilakukan oleh pengguna selain pemilik atau anggota
kelompok.

Jika Anda mengatur hak akses pada direktori beserta berkas yang terdapat di dalam direktori
tersebut, Anda dapat mengklik [>Terapkan Hak ke Berkas yang Disertakan<]. Bila sudah selesai,
klik tombol [>Tutup<].
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4.4 Mengakses Media Penyimpanan Lain

Bila Anda memasang flashdisk atau harddisk eksternal, isi flashdisk/harddisk eksternal akan
langsung terbuka. Demikian pula bila Anda memasukkan CD atau DVD yang berisi berkas non-
multimedia, isi CD atau DVD akan langsung terbuka. Tetapi jika tidak, Anda dapat membuka media
penyimpanan (flashdisk, CD atau DVD atau eksternal harddisk) dengan mengklik Menu Utama >
Tempat lalu pilih media penyimpanan yang ingin Anda buka isinya.

Jika Anda sudah selesai menggunakan suatu media penyimpanan, Anda dapat melepasnya dengan
mengklik ikon di sebelah kanan nama media penyimpanan pada bagian kiri peramban berkas.
Alternatifnya, klik kanan pada media penyimpanan yang ingin dilepas dan klik menu
[>Keluarkan<].

4.5 Memampatkan Berkas/direktori

Berkas termampatkan berfungsi untuk mengelompokkan bebeberapa berkas/direktori menjadi
sebuah berkas untuk memudahkan proses backup. Tidak hanya dikelompokkan, data juga akan
diperkecil ukurannya sehingga sangat cocok untuk pertukaran data. Untuk melakukan arsip pada
Nemo, klik pada folder atau berkas (bisa juga memilih beberapa berkas sekaligus) yang ingin
dimampatkan, lalu klik kanan dan pilih menu [>Kompres<].

Kompres *
E Nama Berkas: | Gambar] | |.tangz = |
H Lokasi: "™ asrilmarhamah - |
P Opsi Lain
| Batal || Buat |
4.4 Kompres

Kemudian, tentukan nama berkas hasil pemampatan, lokasi serta format pemampatan. Format
pemampatan yang didukung antara lain: 7z, RAR, ZIP, TAR, TAR.GZ, dan lain-lain. Untuk
melakukan pengaturan tambahan seperti untuk menambahkan kata sandi, Anda bisa klik pada
[>Opsi lain<]. Setelah semua pengaturan selesai, klik pada tombol [>Buat<].

4.6 Format Perangkat USB

Di Linux anda juga dapat melakukan Format Perangkat USB dengan mudah. Tinggal klik kanan
pada FlashDisk / Memori yang akan di Format dan pilih “Format”. Anda juga dapat memberikan
label pada FlashDisk anda tersebut. Tipe yang didukung yakni FAT32, NTFS dan EXT4. Anda juga
dapat melakukannya melalui Menu Utama > Aksesoris > Pemormat Perangkat USB.

Pemormat Perangkat USB

Fromat: |Mu|ti-CarcI {/devfsdb) - 2GB - | sebagai

NTF5
Nama label: | Perangkat U | EXT4

‘ Tutup H Format ‘

4.5 Format Perangkat USB
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4.7 Mencari berkas/direktori

Untuk mencari berkas/direktori yang tidak Anda ketahui tempatnya, Anda bisa menggunakan fitur
pencarian yang sudah terintegrasi dengan peramban berkas Nemo. Untuk melakukan pencarian,
Anda bisa klik tombol cari pada bagian toolbar Nemo. Kemudian, ketik nama berkas yang ingin
dicari pada kotak yang disediakan, lalu tekan tombol Enter.

Mencari "deb" .
Berkas Sunting Tampilan Pergi Bookmark Bantuan
<540 88 ) ala) s ]
cari: | Q |
~ Komputer Saya Hasil pencarian Muat Ulang L ]
3 Beranda
e Lokasi = | l- asrilmarhamah « ®
Nama v Ukuran |Tipe |Lokasi
= elforkane_1.2-1_i386.deb 21,0 MB Arsip /homefasrimarhamah
il obiek c:\'):;'
Gl menu [ B[] mm [amMencar 'deb” 03B O @ =m i3

4.6 Cari Berkas

Jika menginginkan pencarian yang lain, silahkan ketik nama berkas yang ingin dicari pada kotak
[>Cari<], dan pilih lokasi pencarian pada [>Lokasi<]. Setelah semua selesai, klik tombol [>Muat
Ulang<] untuk melakukan pencarian lagi.

4.8 Berbagi direktori melalui Jaringan

Sebelum berbagi suatu direktori ke jaringan, Anda harus memasang paket Samba terlebih dahulu.
Samba merupakan server berbagi berkas yang bisa digunakan antar platform antara lain: Windows,
Asril OS, Mac OS X, Solaris, dan sebagainya. Cara memasang samba tergolong mudah. Buka
Nemo lalu pilih direktori yang hendak dibagi. Klik kanan direktori tersebut pilih menu Opsi Bagi-
Pakai.

Pemakaian Folder Bersama - + =

Pemakaian Folder Bersama

|5 Pakai bersama folder ini

Nama Bagi-pakai: | Unduhan |

Komentar: | |

["l1zinkan orang lain membuat dan menghapus berkas dalam folder ini

"] Akses tamu (untuk orang yang tidak memiliki akun pengguna)

| Batal l | Buat Bagi-Pakai

P

4.7 Bagi Pakai
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Beri centang pada [>Pakai bersama folder ini<] untuk mengaktifkan fitur berbagi direktori dan beri
nama sharing direktori yang akan dimunculkan pada saat mengakses direktori pada kotak teks yang
tersedia. Agar pengakses bisa menulis isi direktori yang terbagi, beri centang pada [>Izinkan orang
lain membuat dan menghapus berkas dalam folder ini<] dan beri centang [>Akses Tamu<] agar
direktori bisa diakses tanpa perlu autentifikasi identitas pengguna dan kata sandi. Setelah semua
selesai, klik tombol [>Buat Bagi-Pakai<]. Pilih [>Tambahkan perizinan secara otomatis<]. Akan
muncul emblem tangan di direktori yang kita bagi pakai. Sekarang, komputer lain di jaringan sudah
bisa mengakses direktori yang Anda bagi.

4.9 Salin File ke FlashDisk

Kalau di Windows anda mengenal istilah “Send to” untuk menyalin file ke FlashDisk. Di Asril OS
ini juga ada fungsi yang sama. Anda dapat melakukannya dengan mudah. Anda tinggal klik pada
file yang akan di salin dan pilih menu “Sunting” dari menu diatas dan pilih “Salin ke” silahkan pilih
direktori tujuan, FlashDisk yang terpasang akan otomatis akan ditampilkan, sehingga kita dapat
menyalin langsung ke FlashDisk kita. Mudah kan. Jika menyalin kedalam folder tertentu, anda
dapat memilih “Ramban”. Selain untuk menyalin file, anda juga dapat memindahkan file dengan
cara yang sama, tetapi dengan memilih menu “Pindah ke”.

C® 0@ €1m 50 @ Min, 21 Feb 21, 06:24

4.8 Salin ke FlashDisk



N ko erambaf Beras



N v, pus dun Beruntan Pranghat Lunak

BAB 5 Pasang, Hapus dan Perawatan Perangkat Lunak

Asril OS sudah menyertakan berbagai perangkat lunak untuk keperluan dasar seperti Program
Perkantoran, Desain Grafis, Multimedia, Pendidikan, Islami, Internet dll. Namun, jika Anda merasa
kurang dengan perangkat lunak yang sudah terpasang, Anda bisa melakukan pemasangan perangkat
lunak yang Anda inginkan sesuai dengan keperluan.

> —
5.1 Pengaturan Perangkat Lunak pada Asril OS

Cara pemasangan dan penghapusan perangkat lunak pada Asril OS sangat berbeda dengan cara
yang ada di sistem operasi Microsoft Windows. Jika pemasangan perangkat lunak di Windows
menggunakan sebuah installer atau program pemasang dari masing-masing perangkat lunak, maka
pada Asril OS pemasangan perangkat lunak dilakukan menggunakan sistem manajemen paket
perangkat lunak seperti pada Distro Linux lainnya. Manajemen paket yang ada di Asril OS bernama
APT.

Di Asril OS, hampir semua perangkat lunak berasal dari suatu tempat yang bernama lumbung paket
(package repository). APT adalah program yang berfungsi untuk mengunduh (dewnload) paket
yang Anda pilih dari lumbung dan memasangnya di komputer.
Dengan kata lain, Anda tidak perlu mengunduh sendiri paket perangkat lunak yang ingin Anda
pasang. Anda hanya perlu menentukan sumber paket atau lumbung paket perangkat lunak tersebut
melalui APT, dan meminta perangkat lunak yang ingin dipasang atau dihapus. Maka APT akan
melakukan apa yang Anda inginkan termasuk mengunduh paket, memasang, pemasangan
konfigurasi, melakukan konfigurasi sistem, pemutakhiran (update) serta penghapusan.
Lumbung paket bisa berada dari empat sumber, yaitu:

v Server Web

v Jaringan Lokal, misalnya dari server NFS,

v CD/DVD-ROM,

v Folder lokal.

Asril OS secara bawaan menggunakan lumbung paket dari Ubuntu dan Linux Mint yang berada di
situs masing-masing penyedia lumbung paket tersebut. Lumbung paket ini sudah berisikan berbagai
koleksi perangkat lunak yang lengkap dan siap untuk digunakan.

Selain lumbung paket tersebut, anda juga dapat menambahkan lumbung paket-lumbung paket yang
lainnya sesuai dengan keinginan anda.

5.2 Pengaturan Lumbung Paket

Untuk melakukan pengaturan lumbung paket APT, Anda bisa klik Menu Utama > Administrasi >
Synaptic Manajer Paket. Masukkan password anda, setelah Synaptic Manajer Paket terbuka, anda
bisa klik Pengaturan > Repositori. Berikut adalah cara-cara pengaturan lumbung paket dari setiap
jenis sumber.
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5.2.1 Lumbung Paket (Internet)

Jika Anda ingin melakukan pengaturan sumber perangkat lunak dari mirror resmi
Ubuntu atau Linux Mint, Anda bisa klik Pengaturan > Repositori. Pilih sumber
perangkat lunak yang akan diaktifkan, anda juga bisa menambahkan repositori baru
dengan menggunakan tombol “Baru” yang ada disebelah kiri bawah. Kalau sudah
selesai, silahkan klik “Muat Ulang” untuk memuat ulang sumber lumbung paket.

Repositori - + ¥
Diaktifkan |Jenis  |URI ¥, =4
M
B deb http://packages.linuxmint.com/ p|l
B deb http://extra.linuxmint.com/ p -
=] deb http:/farchive.ubuntu.com/ubuntu/ 5
B deb http:jfarchive.ubuntu.comjubuntuy 5
B deb http:/security.ubuntu.comfubuntu/ 5
= deb http://archive.canenical.comjubuntu/ 5 v
>
Baru Batal ] I Oke

5.1 Repositori

5.2.2 Lumbung Paket Jaringan Lokal (Intranet)

Beberapa institusi pendidikan dan kantor menyediakan lumbung paket secara lokal yang
bisa Anda manfaatkan untuk menekan biaya penggunaan bandwidth internet. Untuk
memanfaatkannya, silahkan tanya kepada administrator jaringan Anda tentang baris APT
dari lumbung paket termasuk lumbung paket untuk pemutakhiran (jika ada). Lalu
tambahkan baris APT baru sesuai dengan cara yang dijelaskan diatas.

Setelah semua pengaturan lumbung paket selesai dilakukan, klik tombol Tutup.
Kemudian APT akan meminta Anda untuk mengunduh informasi paket dari setiap
lumbung paket, klik pada tombol [>Muat Ulang<]. Sekarang, Anda siap melakukan
penambahan perangkat lunak untuk Asril OS.

5.3 Memasang dan Menghapus Perangkat Lunak

Terdapat dua cara untuk melakukan pemasangan dan penghapusan perangkat lunak. Yaitu melalui
fitur manajer paket Synaptic dan melalui antarmuka teks dengan perintah apt-get.

5.3.1 Manajer Paket Synaptic

Jika Anda ingin memasang atau menghapus perangkat lunak secara detail, Anda bisa
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5.3.2

menggunakan program Synaptic yang bisa Anda buka melalui Menu Utama >
Administrasi > Synaptic Manajer Paket.

Synaptic Manajer Paket - 4+ x
Berkas Sunting Paket Pengaturan Bantuan

Quick filter
(2] o

MuatUlang Terapkan Properti || |

Q Cari

w

‘ Paket | Versi Terpasang Versi Terbaru Deskripsi H

Baru di repositori | Oad 0.0.15+dfsg-3 Real-time strategy game of ancient warfare
Pinned Oad-data 0.0.15-1 Real-time strategy game of ancient warfare (data fi
Terpasang Oad-data-common 0.0.15-1 Real-time strategy game of ancient warfare (comm
Terpasang (dapat ditingkatkan) Oad-dbg 0.0.15+dfsg-3 Real-time strategy game of ancient warfare (debug

Terpasang (lokal atau sudah lama) Oxffff 0.6~git20130406-1 Open Free Fiasco Firmware Flasher

Terpasang (manual) 2ping 2.01 Ping utility to determine directional packet loss

Tidak dipasang

Bagian

Asal

Penyaring Ubahan

Hasil Pencarian

| l_I'
[ Status ]
| I
| I
| I
|

Architecture |

45616 paket terdaftar, 2168 terpasang, 0 rusak. 0 akan dipasang/ditingkatkan, 0 akan dicabut

5.2 Synaptic Manajer Paket

Ketikkan nama program pada kotak pencarian cepat. program ini menampilkan daftar
paket perangkat lunak secara detail. Selain Anda bisa menambah dan menghapus
program, Anda juga bisa melakukan hal yang sama untuk pustaka sistem yang tersedia.
Untuk menandai paket perangkat lunak yang ingin dipasang, klik kanan pada program
yang hendak dipasang lalu pilih menu [>Tandai untuk Dipasang<]. Sedangkan jika
ingin menghapus paket perangkat lunak, klik kanan pada program lalu pilih menu
[>Tandai untuk Dicabut<]. Kadangkala, suatu paket perangkat lunak akan meminta satu
atau beberapa paket perangkat lunak untuk dipasang (ketergantungan). Jika muncul
jendela yang menanyakan hal tersebut, Anda harus setuju untuk menandai paket
perangkat lunak yang dibutuhkan agar Anda bisa memasang paket perangkat lunak yang
Anda inginkan.

Untuk menerapkannya, Anda bisa klik tombol [>Terapkan<] pada toolbar dan klik
tombol [>Terapkan<] pada jendela konfirmasi. Maka APT akan memasang / menghapus
perangkat lunak yang Anda minta.

Melalui Perintah apt-get

Menggunakan perintah apt-get sangat sederhana sekali. Anda cukup ketikkan nama
paket perangkat lunak yang ingin dipasang / dihapus, maka APT akan melakukan hal
yang Anda inginkan. Untuk menggunakan fitur ini, bukalah antarmuka teks misalnya
melalui Terminal dengan Menu Utama > Aksesoris > Terminal.

Pada terminal ketikkan perintah berikut, lalu tekan tombol Enter untuk memasang paket
perangkat lunak (Ubah “namapaket” sesuai dengan nama paket perangkat lunak yang
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hendak Anda pasang).

asrilmarhamah@PICO-DJH-Model:~§ sudo apt-get install namapaket <*

Sedangkan untuk menghapus suatu perangkat lunak, ketik perintah berikut dan tekan
tombol Enter (Ingat! Ubah “namapaket” sesuai dengan perangkat lunak yang ingin
Anda hapus).

astilmarhamah@PICO-DJH-Model:~$ sudo apt-get remove namapaket <

Jika APT meminta pemasangan / penghapusan perangkat lunak yang dibutuhkan oleh
perangkat lunak yang Anda akan pasang / hapus, Anda harus menyetujuinya dengan
menekan tombol Y, lalu tekan tombol Enter.

>

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get install kino audacity <

5.4 Pemasangan melalui Berkas DEB

Selain melalui lumbung paket, Anda juga bisa memasang suatu perangkat lunak yang
didistribusikan dalam format berkas DEB. Untuk melakukan instalasi dari berkas paket DEB, Anda
bisa klik ganda pada berkas DEB tersebut melalui peramban berkas, maka akan muncul jendela
yang akan menuntun Anda dalam melakukan pemasangan.

Pemasang Paket - osdlyrics - + x
Berkas Edit Bantuan
Paket:  osdlyrics
Status: Butuh instalasi paket 3

Deskripsi | Rincian  Included files Lintian output

An 0SD lyrics show compatible with various media players.

0SD Lyrics is inspired by Ircdis. It is a third-party lyrics display pregram, and
focus on OSD lyrics display. OSD Lyrics currently supports following media players:

* Amarok 1.4 (High CPU usage)
= Amarok 2.0

* Audacious

* Banshee

* Exaile

* Rhythmbox OSD Lyrics can download lyrics from following web sites:

* Sogou

5.3 Pemasang Paket GDebi
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Pada jendela tersebut, Anda bisa klik tombol [>Instal Paket<]. Maka paket tersebut akan diinstal ke
komputer bersamaan dengan paket ketergantungannya, pastikan anda terhubung dengan internet
untuk memasang paket ketergantungannya.

5.5 Merawat Sistem

Secara berkala setiap Tim Pengembang dari masing-masing lumbung paket akan menerbitkan
paket-paket perangkat lunak dengan versi yang lebih baru ke dalam lumbung. Jika komputer Anda
terhubung ke Internet, maka keberadaan paket-paket baru tersebut akan diinformasikan kepada
Anda. Jika Anda mau menerima paket-paket baru tersebut, maka sistem akan dimutakhirkan oleh
APT dengan mengunduh dan memasang paket-paket itu.

Dengan melakukan pemutakhiran berkala menjadikan sistem Anda terawat karena pada versi baru,
biasanya telah dilakukan pemeriksaan dan perbaikan cacat yang telah diketahui sebelumnya.
Kadangkala versi baru diterbitkan untuk menutup celah-celah keamanan yang ditemui pada suatu
paket. Untuk melakukan pemutakhiran sistem, pastikan Anda sudah mengaktifkan informasi
pemutakhiran dari lumbung paket pada APT seperti yang sudah dijelaskan sebelumnya. Kemudian,
klik Menu Utama > Administrasi > Pengaturan Pembaruan untuk melakukan pemutakhiran sistem.

. c-H:

Berkas Ubah Tampilkan Bantuan

a El o o

Bersinkan PilihSemua | Penyegaran | Instal Perbaruan

Tipe | Tingkatan | Perbarui Paket Versi baru
& w @ E;ree{::c easy web browser from Mozilla. 40 Eotoainizoc
L 3 B ;:I;rtorl.se client-side URL transfer library (OpenSSL flavour). RS
L 3 B EIL;ELTS::?[CMZ to configure network interfaces (7472t
L 3 B EESEE?:]S@ runtime, using Hotspot JIT (headless). SIEE 113 0 vt 012,04
Ll 3 B gg:g{?:]:va runtime, using Hotspot JIT. U2 s Uil 10
L 'l‘ B8 E:;T;oceszor emulator. 20Lbg Zu

Deskripsi || Daftar perubahan

6 pembaruan yang disarankan tersedia (138MB), 2 diabaikan

5.4 Manajer Pembaruan

Klik tombol [>Penyegaran<] untuk memeriksa ketersediaan pemutakhiran. Jika terdapat paket-
paket perangkat lunak dengan versi baru, Anda bisa memberi centang paket perangkat lunak yang
hendak Anda perbarui. Untuk mengunduh dan memasang update, klik tombol [>Instal
Perbaruan<]. Maka APT akan melakukan pemutakhiran pada paket perangkat lunak yang Anda
pilih.

Selain cara yang dibahas di atas, Anda bisa melakukan pemutakhiran sistem melalui terminal.

Untuk melakukan hal ini, buka terminal melalui Menu Utama > Aksesoris > Terminal. Lakukan
pemeriksaan ketersediaan pemutakhiran dengan mengetik perintah seperti berikut, lalu tekan Enter :
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asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get update <*

Kemudian, ketik perintah seperti berikut untuk melakukan pemutakhiran paket perangkat lunak,
lalu tekan tombol Enter:

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get upgrade <*

~ INGAT! Pastikan Anda terhubung dengan lumbung paket update agar proses pemutakhiran
bisa berjalan dengan lancar:




N g Zerkantoran

BAB 6 Program Perkantoran

Untuk kebutuhan perkantoran, Asril OS menyediakan berbagai program yang siap pakai. Adapun
program Perkantoran yang disertakan pada Asril OS ini yaitu LibreOffice, PDF Chain, xCHM dan
Adobe Reader.

6.1 LibreOffice

LibreOffice merupakan program perkantoran open source yang dapat digunakan dengan bebas dan
didapatkan secara gratis. Penggunaan program ini sangat mirip dengan Microsoft Office 2003,
sehingga ramah terhadap pengguna yang sudah terbiasa menggunakan program tersebut.

Pada subbab ini, dijelaskan mengenai penggunaan paket program perkantoran LibreOffice untuk
keperluan pengolahan kata, pengolahan sheet dan presentasi. Diharapkan dengan membaca subbab
ini, Anda mampu menggunakan program-program tersebut untuk berproduktivitas, LibreOffice
sudah berbahasa Indonesia.

File Tools Help
I (open e
‘D Recent Files

D Templates v

Create:

I" Writer Document

b Calc Spreadsheet
- Welcome to LibreOffice.
l;, Impress Presentation

Use the sidebar to open or create a file.

> | Draw Drawing
if_ Math Formula

L_J Base Database

Help Extensions

’ Menu ».E sEAa™ Q_Libreofﬁce e ey 3 @ , @) @ © L. Sen, 4Jan 16, 23:48 O

6.1 LibreOffice

6.1.1 LibreOffice Writer

LibreOffice Writer merupakan program pengolah kata yang merupakan bagian dari paket
program perkantoran LibreOffice. Fitur dan penggunaan program ini sangat mirip dan
setara dengan Microsoft Word. Dalam subbab ini, dijelaskan mengenai pengenalan dan
sedikit penjelasan mengenai LibreOffice Writer.

Untuk membuka program ini, klik Menu Utama > Perkantoran > LibreOffice Writer.
Pada saat pertama kali dibuka, Anda akan melihat sebuah kertas kosong yang siap Anda
gunakan untuk keperluan pengolahan kata. Jika Anda ingin membuka dokumen yang
telah tersimpan, Anda bisa klik menu File > Open.
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BAB 6 Program Perkantoran.odt - LibreOffice Writer

Berkas Sunting Tampilan Sisip Format Tabel Perkakas AlQuran Jendela Bantuan x
L-5-Godd4a8a »r B-& ~- -~ =E-5 smeq e
1 . 1 1 - = = = = = = = =
[2 [Gaya Baku [v| [Timeshewromav12 |v] @ @ @ = = S| S EE=E =5 2~ -7 -0 -
L 1 ] -1 .2 3 -4 5 -6 7 8--9, 10 11 12+ 13 14, 15 .16 17 L18 + 99 |

BAB 6 Program Perkantoran

: Untk kebutuhan perkantoran, Asril OS menyediakan berbagal aplikasi yang siap pakal. Adapun
o~ program Perkantoran yang disertakan pada Asril OS ini yaiw LibreOffice, PDF Chain, xpdf, xCHM,
Penampil Dokumen, KingSoft Office.

6.1 Program Libreoffice

LibreOffice mempakan aplikasi perkantoran open source yang dapat digunakan dengan hebas dan
didapatkan secara gratis. Penggunaan aplikasi ini sangat mirip dengan Microsoft Office 2003, sehingga
ramah terhadap pengguna yang sudah terbiasa menggunakan aplikasi tersebut,

- Pada subbab ini, dijelaskan mengenai penggunaan paket aplikasi perkantoran LibreOffice untuk :

? keperluan pengolahan kata, pengolahan sheet dan presentasi. Diharapkan dengan membaca subbab ini, E
. Anda mampu menggunakan aplikasi-aplikasi tersebut untuk berproduktivitas, LibreOffice sudah =)
Keluar Pencarian [Cari K2 [T Cocok Huruf Besar Kecll ' Q

Halaman 1 /10  Kata (karakter): 2876 (21407} Gaya Baku  Inggris (AS) E] Ob0Mm - +——0——+ 100%

0+ D) Qph@® ma23n

@ Menu ] P[] ma WBAT6 Program per..

6.2 LibreOffice Writer

Berikut adalah format dokumen yang didukung oleh LibreOffice Writer :
Open Document Text (Format default yang telah menjadi standar ISO)
OpenOffice.org 1.x

Microsoft Word 97/2000/XP/2003

Microsoft Word 2007

Rich Text Format

HTML Document

Docbook XML

S S X <

Pengenalan Antarmuka

Seperti yang dijelaskan sebelumnya, antarmuka dari LibreOffice Writer sangat mirip
dengan program Microsoft Office Word 2003. Berikut adalah penjelasan dari masing-
masing bagian di dalam program ini :

1.
2.

Baris Menu, menampilkan daftar perintah yang bisa digunakan berupa menu.

Baris alat standar, menampilkan ikon-ikon yang merupakan perintah utama dan
esensial dalam bekerja di LibreOffice Writer, seperti perintah membuat dokumen
baru, membuka , menyimpan, mencetak, membatalkan perintah terakhir, menyalin
dsb.

Baris alat pemformatan, menampilkan ikon-ikon serta pengaturan untuk melakukan
format dokumen, seperti pengaturan fonta, jenis huruf, perataan teks, penomoran,
dsb.

Penggaris/ruler, merupakan alat bantu untuk mengukur panjang kertas, margin, serta
jarak tabulasi.

Baris status, menampilkan status dalam bekerja.

Berfungsi menggulung tampilan turun atau naik (vertikal) dan ke kiri atau ke kanan
(horisontal).
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Gl Menu '?]E]- I Tidak Berjudul T-L...

Tidak Berjudul 1 - LibreOffice Writer - + %
Berkas Sunting Tampilan Sisip Format Tabel Perkakas AlQuran Jendela Bantuan
-9 O { 88& &m n-d e EH-S T EES T @9
E | Gaya Baku | v]||[Liberationserf [¥|[12 [v| @ & g := E _; % §E = = = i L - A
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- v
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a
Keluar Pencarian [Cari |*| ] Cocok Huruf Besar Kecil Q
Halaman 1 /1 Kata (karakter): 0 (0) Gaya Baku Indonesia m | [ 000 M | = +——0——+ | 100%
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6.3 LibreOffice Writer

Selain baris alat yang ada, Anda juga bisa menambahkan beberapa baris alat lainnya
melalui menu Tampilan > Bilah alat > Baris alat yang ingin ditambahkan. Setiap baris
alat memiliki fungsi masing-masing dan sangat membantu mempercepat Anda dalam
bekerja. Walaupun fiturnya setara dan antarmukanya mirip dengan Microsoft Word.
Namun ada beberapa perintah di LibreOffice yang letaknya berbeda. Berikut adalah
perbedaan letak menu antara Word 2003 dengan Writer:

Microsoft Word

LibreOffice Writer

File > Page Setup

Format > Halaman

Format Font

Format > Karakter

Format > Border and Shading

Format > Halaman > Bingkai

Format > Tabs

Format > Paragraf > Tab

Format > Drop Cap

Format > Paragraf > Alur Teks

Insert > Picture > Wordart

Baris alat Menggambar > Galeri Fontwork

Insert > Picture > Chart

Sisip > Objek > Bagan

Perlu sedikit pembiasaan diri dan kesabaran untuk melatih diri agar terbiasa
menggunakan LibreOffice jika Anda belum terbiasa. Hal ini bisa Anda lakukan dengan
mencoba - coba mengerjakan suatu naskah dengan LibreOffice jika tidak dalam keadaan

sangat penting.
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Mengubah Inch menjadi Sentimeter

Biasanya pada komputer yang memakai Antarmuka berbahasa Inggris untuk ukuran
Penggaris, ukuran Halaman (kertas), ukuran kotak pada table, dll, menggunakan ukuran
Inchi, maka dengan tetap mepertahankan penggunakan ukuran Inchi akan mempersulit
penyutingan dokumen yang dibuat karena kita sudah terbiasa menggunakan ukuran
Sentimeter, untuk merubah ukuran “Inchi” ke “Sentimeter® lakukan langkah berikut :

Klik Perkakas > Opsi, karena dalam contoh ini program perkantoran yang sedang
dipakai “LibreOffice Writer” maka arahkan tetikus pada menu LibreOffice Writer klik
tombol panah yang mengarah ke bawah untuk membuka sub menu yang disediakan, klik
“Umum” ubah ukuran Inch menjadi “Sentimeter” kemudian klik “Ok”

Bantuan memformat
Kisi

Hurur Dasar (Barat)
Cetak

Opsi - LibreOffice Writer - Umum *

Ce‘tak E Perbaharui

alur

JWama Perbaharui taut ketika memuat Ctomatis

Huruf —~

Keamanan Selalu |5 Ruas

Personalisasi () Sesuai permintaan | Bagan

Penampilan .

Kemudahan Akses | Tidak pemah

Tingkat Lanjut Pengaturan
+ Muat/simpan Eo
+ Pengaturan Bahasa Satuan ukur l Hi
= LibreOffice Writer X o

Perhentian tab 1,25cm E|
Tampilan

Tabel Cacah Kata

Perubahan A

Perbandingan Pemisah tambahan -
Kompatibilitas

AutoCaption

Surel Surat Massal
LibreOffice Writer/Web
LibreOffice Base
Bagan
Intemet l

+ [+ [+

Oke J { Batal I { Bantuan I I Kembalikan

6.4 Inchi ke Sentimeter
Bekerja dengan Writer

Sebelum mengetik isi dokumen, Anda perlu mengatur terlebih dahulu pengaturan
halaman pada dokumen meliputi pengaturan ukuran kertas dan margin. Untuk
melakukan hal ini, klik menu Format > Halaman.

Gaya Halaman: Gaya Baku x
Pengorganisasi |Ha|aman| Latar Belakang Tajuk Kaki Bingkai Kolom Catatan Kaki
Format kertas
| Format: L ij
Lebar 21,59cm E\
Tinggi: 27,94cm E\
Orientasi: (@) Tegak
) Mendatar Baki kertas: |[Dari pengaturan pencetak] x|
Margin Pengaturan tataletak
Kiri: 2,00cm E| Tata letak halaman: |Kanan dan kiri : )
Kanan: 2,00cm El Format: [1. 2,3, ... . |
Atas: :Z.Ducm El "] Register-true
) Gaya Acuan:
Bawah: 2,00cm E| —
l Oke ‘ I Jerapkan ] I Batal ] [ Bantuan J I Atur Ulang
6.5 Atur Halaman
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Kemudian, klik tab [>Halaman<] dan aturlah ukuran kertas serta orientasi dokumen
yang diinginkan pada pengaturan [>Format kertas<], sedangkan untuk pengaturan
margin (jarak batas), aturlah pada pengaturan [>Margin<]. Setelah pengaturan selesai,
Anda bisa klik tombol Oke. Sekarang, Anda bisa mengetik dan mengedit isi dokumen
Anda. Untuk mempercepat waktu, Anda bisa gunakan keyboard shortcut berikut ini
untuk melakukan penyuntingan. Penggunaan keyboard shortcut akan meminimalisasi
penggunaan mouse.

Fungsi Keyboard Shortcut

Memblok (memilih) teks Shift+tanda panah kiri/kanan
Copy (menyalin) Ctrl+C

Cut (memotong) Ctrl+X

Paste (menempel apa yang disalin/dipotong) |Ctrl+V

Blok semua Ctrl+A

Undo (batalkan) Ctrl+Z

Redo (kembalikan apa yang dibatalkan Ctrl+Y

dengan perintah Undo)

Agar dokumen Anda lebih menarik, tentunya Anda perlu melakukan formatting pada
dokumen sehingga membuat dokumen Anda lebih cantik, elegan dan profesional. Untuk
melakukan hal ini, Anda bisa memblok teks yang ingin diformat lalu memanfaatkan
toolbar formatting yang terdapat di bagian atas penggaris. Selain itu, Anda juga bisa
memanfaatkan berbagai keyboard shortcut berikut ini :

Fungsi Keyboard Shortcut
Bold (menebalkan) Ctrl+B
Italic (miring) Ctrl+I
Underline (bergaris bawah) Ctrl+U
Double underline (garis bawah ganda) | Ctrl+D
Hilangkan format Ctrl+0
Heading 1-5 Ctrl+1-5
Rata kiri Ctrl+L
Rata kanan Ctrl+R
Rata kiri-kanan Ctrl+J
Subscript Ctrl+Shift+B
Superscript Ctrl+Shift+P

Untuk mengelola berbagai jenis gaya pemformatan, Anda bisa memanfaatkan fitur Gaya
dan pemformatan yang bisa Anda akses melalui menu Format > Gaya dan pemformatan
(F11). Melalui fitur ini, Anda bisa mengatur berbagai gaya formatting untuk format
paragraf, karakter, halaman, bingkai dan daftar.
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Gaya dan Pemformatan »
[ aRsEm & 1= -

Alamat

Catatan Akhir

Catatan Kaki

Garis Horisontal
+Indeks

Isi Bingkai

Isi Senarai
+lsi Tabel
+Judul

Kali

Kaki Kanan

Kaki Kiri
+Kapsi

Kata penutup

Kepala Kanan

Kepala Kiri

Kutipan

Pengirim

Tajuk

Tajuk Senarai

Tanda Tangan

Teks vann telah difommat

6.6 Gaya dan Pemformatan

v

Jika Anda ingin menggambar bentuk atau objek lainnya, Anda bisa memanfaatkan baris
alat menggambar yang bisa Anda buka melalui menu Tampilan > Bilah alat >
Menggambar. Sama seperti toolbar drawing di Microsoft Word, di sini Anda bisa
menggambar suatu bentuk, menyisipkan gambar, mengatur bayangan dan 3D pada objek.

h / BOVTO O -O-& -0 Dy iR 4
6.7 Baris alat menggambar

Untuk menyimpan hasil pekerjaan anda, klik menu Berkas > Simpan. Lalu, tentukan
lokasi penyimpanan berkas serta format berkas yang diinginkan. Kemudian, klik tombol
[>Simpan<]. Anda juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol
Ctrl+S pada keyboard.

Membuat Tabel

Untuk membuat tabel, Anda bisa klik menu Tabel > Sisip > Tabel atau tombol Ctrl+F12
pada keyboard. Kemudian, tentukan jumlah baris pada pengaturan [>Baris<] dan jumlah
kolom pada pengaturan [>Kolom<]. Jika ingin membuat judul kolom berulang saat
berganti halaman, Anda bisa beri centang pada [>Tajuk<] dan [>Ulangi baris tajuk pada
halaman baru<]. Setelah itu, klik tombol Sisip.
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Sisip Tabel *®

MNama: [il’abela |

Kolom: EE' Baris: E@

opsi
[T Tajuk

Ulangi Baris Tajuk pada halaman baru
Baris Tajuk: [1 D

[ Jangan penggal tabel ke halaman lain

|3 Batas
Format Otomatis
l Bantuan ‘ [ Sisip ‘ l Batal J
6.8 Membuat tabel

Jika ingin membuat baris / kolom baru pada tabel, Anda bisa klik kanan pada baris /
kolom yang ingin disisipi, lalu klik menu Baris / Kolom > Sisip. Kemudian, tentukan
jumlah baris / kolom yang ingin ditambahkan serta posisi disisipinya baris / kolom baru
tersebut. Selain klik kanan, Anda bisa lewat menu Tabel > Sisip > Baris / Kolom.
Kemudian, tentukan jumlah baris / kolom yang ingin ditambahkan serta posisi
disisipinya baris / kolom baru tersebut. Setelah itu, klik tombol Oke.

Mungkin Anda perlu menggabungkan beberapa bagian sel pada tabel, untuk melakukan
hal ini, blok pada sel yang ingin digabung lalu klik kanan dan pilih menu Sel > Gabung.
Atau dapat menggunakan menu Tabel > Gabung sel. Sedangkan untuk memecah sel, klik
kanan pada sel yang ingin dipecah lalu pilih menu Sel > Pisah. Kemudian, tentukan
jumlah baris / kolom hasil pisahan sel tersebut, dan terakhir klik tombol Oke. Atau dapat
menggunakan menu Tabel > Bagi sel. Kemudian, tentukan jumlah baris/kolom hasil
pisahan sel tersebut, dan terakhir klik tombol Oke. Bagi yang ingin menulis tugas akhir
dengan LibreOffice Writer, kami juga sudah menyertakan buku panduannya yang dapat
anda akses melalui Menu Utama > Panduan > Panduan LibreOffice Writer.

6.1.2 LibreOffice Calc

Untuk membuat suatu lembar kerja, Anda bisa menggunakan program LibreOffice Calc.
program ini sangat mirip dan memiliki fitur yang setara dengan padanannya, Microsoft
Excel. program ini juga sangat kompatibel dengan berkas yang dibuat dengan Microsoft
Excel.

Memulai Bekerja

Untuk membuka LibreOffice Calc, klik Menu Utama > Perkantoran > LibreOffice Calc.
Beberapa detik kemudian, Anda akan melihat jendela program LibreOffice Calc yang
sangat mirip dengan program Microsoft Excel 2003. Untuk membuka suatu lembar
kerja, klik menu Berkas > Buka. Berikut adalah format file yang didukung oleh
LibreOffice Calc :
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v Open Document Spreadsheet (format Default yang telah menjadi standar ISO)
v Microsoft Excel 97/2000/XP,
v Microsoft Excel 2007

Tidak Berjudul 1 - LibreOffice Calc - + %
Berkas Sunting Tampilan Sisip Format Perkakas Data Jendela Bantuan
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6.9 LibreOffice Calc

Antarmuka LibreOffice memiliki beberapa bagian, yaitu (dari atas ke bawah) :
1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif.
2. Baris Menu, menampilkan daftar perintah untuk bekerja berupa menu.
3. Baris alat standar, berisikan ikon-ikon perintah utama untuk LibreOffice Calc.
4

Baris alat pemformatan, berisikan ikon-ikon serta pengaturan untuk melakukan
formatting pada lembar kerja.

Baris formula, berfungsi untuk mengatur formula/rumus pada setiap sel.

o v

Bagian utama, disinilah Anda bekerja untuk membuat lembaran kerja/worksheet.

7. Navigasi lembar kerja, berfungsi untuk berpindah dari suatu sheet ke sheet yang
lainnya dalam satu buku kerja.

8. Baris Status,berisi kolom-kolom yang menampilkan berbagai status dari area
kerja

Selain baris alat tersebut, Anda juga bisa menambahkan baris alat lainnya melalui menu
Tampilan > Bilah alat > Baris alat yang ingin ditambahkan. Setiap baris alat memiliki
fungsi masing-masing dan berguna sekali untuk mempercepat pengerjaan lembar kerja.

Bekerja dengan Calc

Pertama kali dalam membuat lembar kerja, Anda harus membuat terlebih dahulu judul
kolom data pada baris pertama. Jika dibutuhkan, Anda bisa menggabungkan beberapa sel
dengan cara membloknya, lalu memilih menu Format > Gabung Sel. Agar judul kolom /
baris selalu muncul pada setiap halaman yang akan dicetak, Anda bisa mengatur area
pencetakan melalui menu Format > Jangkauan Cetak > Sunting. Kemudian, isi
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jangkauan dari judul kolom / baris pada bagian [>Kolom / Baris untuk diulang<]. Anda
bisa klik tombol di sebelah kanan kotak teks untuk membantu memilih jangkauan yang
diinginkan.

sSunting Jangkauan Cetak x |

lar:gkauan cetak . . e

- e ) | | o= |

Batal

Baris untuk diulang

|- nihil - L] | Bantuan
Kolom untuk diulang

|- nihil - L) |

6.10 Sunting Jangkauan Cetak

Setelah pembuatan judul kolom selesai, Anda bisa mengisi setiap kolom dengan data
yang ingin Anda buat. Anda bisa tekan tombol F2 untuk mengisi sel yang dipilih. Untuk
membuat suatu data lebih dinamis, Anda bisa memanfaatkan rumus-rumus atau formula
yang tersedia sangat banyak di Calc. Jika Anda belum terbiasa mengetikkan rumus
secara langsung, Anda bisa klik ikon [>f(x)<] pada baris input (formula) dan mengikuti
arahan yang diberikan. Rumus-rumus yang dapat Anda gunakan antara lain rumus
perhitungan, statistika, finansial, tanggal dan waktu, logika, matematika, dsb.

Wahana Pandu Fungsi *

'Fungsi | Struktur GEsfinngE

. Kategori | ABS
[ _:_J ABS( Bilangan }

Eungsi

Nilai mutlak suatu bilangan.
ACCRINT | |

ACCRINTM
ACOS

ACOSH

ACOT

ACOTH

ADDRESS

AMORDEGRC

AMORLINC

AND Rumus Hasil |#MNULL!
ARAEBIC =

AREAS
ASC ‘ ‘
ASIN

L

[ Larik Bantuan ]l Batal ] <= Kempbali | Lanjut == ] I Oke ]

6.11 Wahana Pandu Fungsi

Untuk memformat sel agar lebih menarik, Anda bisa blok sel yang ingin diformat, lalu
manfaatkan berbagai perintah pemformatan yang terdapat di baris alat pemformatan (di
atas baris formula). Selain itu, Anda bisa memanfaatkan pengaturan sel yang bisa Anda
akses melalui menu Format > Sel. Keyboard shorcut untuk pemformatan yang dijelaskan
pada penjelasan tentang LibreOffice Writer juga bisa Anda manfaatkan. Jika Anda ingin
menyisipkan suatu baris/kolom di antara baris/kolom yang sudah diisi, Anda bisa klik
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kanan pada nomor baris’kolom, lalu klik menu Sisip Baris / Kolom. Anda bisa
memanfaatkan seluas-luasnya jumlah sel yang sangat banyak untuk keperluan
pembuatan data.

Untuk memisahkan setiap lembar kerja, Anda bisa memanfaatkan fitur lembar kerja pada
Calc. Secara baku, terdapat satu lembar kerja yang bisa Anda gunakan untuk membuat
buku kerja dan bisa Anda ganti melalui navigasi lembar kerja yang terdapat di bagian kiri
scrollbar samping. Untuk menambah lembar baru, Anda bisa klik tanda “+” yang ada
disamping lembar kerja. Sebaliknya, jika Anda ingin menghapus suatu lembar, klik pada
lembar yang ingin Anda hapus, lalu klik menu [>Hapus lembar kerja<].

Salah satu fitur menarik yang terdapat di Calc untuk membantu pengolahan data adalah
fitur pengurutan. Dengan fitur ini, Anda bisa mengurutkan data Anda sehingga lebih
runtun dan berurut. Untuk menggunakan fitur ini, blok pada data yang ingin diurut dan
klik menu Data > Urutkan. Lalu atur skema pengurutan sesuai dengan keinginan Anda.

Mengurut x
Kriteria Pengurutan | Opsi
Kunci pengurutan 1
. . © Naik
f i A
) Turun
Kunci pengurutan 2
0 Naik
|- belum ditentukan - =
) Turun
Kunci pengurutan 3
Naik
- belum ditentukan -
Turun
[ Oke ‘ l Batal ] l Bantuan ] l Atur Ulang
6.12 Mengurutkan Data

Untuk menyimpan buku kerja yang Anda buat, klik menu Berkas > Simpan. Laluy,
tentukan lokasi penyimpanan berkas serta format berkas yang diinginkan. Kemudian,
klik tombol [>Simpan<]. Anda juga bisa menyimpan hasil pekerjaan Anda dengan
menekan tombol Ctrl+S pada keyboard.

Membuat Bagan

LibreOffice Calc memudahkan Anda membuat bagan, karena telah tersedia wahana
pandu bagan. Misalkan data yang dibuat telah selesai.
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6.13 Data untuk Bagan

Untuk membuat bagan, klik menu Sisip > Bagan pada baris menu. Setelah data yang
dibuat selesai, langkah pertama, pilih jenis dari bagan yang Anda inginkan.

Wahana Pandu Bagan x
Langkah-langkah Pilih jenis bagan
et
B | B Baris
2.Jangkauan Data & Pai
3.Rangkaian Data b5 Area
4.Elemen Bagan Q‘_ Garis Normmal
[ x¥ (Bepencar)
|*# Gelembung (] Penampilan 3p  Realistis
[ Jaring
lis2 Persediaan Bentuk
il Kolom dan Garis Kotak
Tabung
Kerucut
Piramida
| Bantuan | << Kembali l Lanjut >> I [ Selesai ] I Batal

6.14 Jenis Bagan

Pilihlah jenis bagan pada bagian kiri serta kanan. Centang penampilan 3D jika tampilan
diagram 3 dimensi. Kemudian, klik tombol tombol [>Lanjut<].

Wahana Pandu Bagan

Langkah-langkah Pilih jangkauan data

Jangkauan data

1
[$Lembar1.sF$12

3.Rangkaian Data

4.Elemen Bagan

—~

() Rangkaian data pada baris
(L) Rangkaian data pada kolom

|| Baris pertama sebagai label
|| Kolom pertama sebagai label

Bantuan

Lanjut >=> Selesai Batal

I << Kembali H

J
6.15 Jangkauan Data

JI
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Pada kotak teks [>Jangkauan data<], tentukan sel data yang akan dijadikan sumber
data. Anda bisa klik ikon di sebelah kanan kotak teks, lalu memblok sel yang diinginkan.
Setelah itu, tentukan urutan data dengan memilih opsi [>Rangkaian data pada baris<]
jika data ada di setiap baris (memanjang ke kanan), atau [>Rangkaian data pada
kolom<] jika data ada di setiap kolom (memanjang ke bawah). Selain itu, Anda bisa
memberi tanda centang pada [>Baris pertama sebagai label<] jika ingin baris pertama
dijadikan label data dan/atau memberi tanda centang pada [>Kolom pertama sebagai
label<] jika ingin kolom pertama dijadikan label data. Setelah selesai, klik tombol

[>Lanjut<].

Langkah-langkah

1.]enis Bagan

2.]angkauan Data

4.Elemen Bagan

Wahana Pandu Bagan

Kustomasi jangkauan data untuk tiap rangkaian data

Bangkaian data Jangkauan data

Nilai ¥ $lembarl.$C$5:3C516

Jangkauan untuk Nama

[$Lembar1.5C54 |
[ Tambah ] A | Kategori
Buang — [5Lembar1.5B$5:58516 |
Bantuan I << Kembali H Lanjut >> ] [ Selesai ] l Batal ]
6.16 Rangkaian Data

Langkah ketiga, Anda bisa mengkustomisasi data yang akan ditampilkan pada bagan.
Jika tidak perlu kustomisasi, klik saja tombol [>Lanjut<].

Wahana Pandu Bagan

Langkah-langkah

1.Jenis Bagan
2.Jangkauan Data
3.Rangkaian Data

Pengaturan judul, legenda, dan kisi-kisi

Judul [ | |5 Tampilkan legenda
Subjudul | | ) Kiri

(@) Kanan
sumbu X | | O Atas
Sumbu Y | | () Bawah

Sumbu Z

Tampilkan kisi-kisi

[) Ssumbu X [&5] Sumbu Y Sumbu Z
Bantuan << Kembali Lanjut >> [ Selesai J { Batal
6.17 Eleman Bagan

Langkah terakhir, tentukan judul grafik beserta opsi-opsi lainnya yang diberikan. Bila
Anda rasa ada yang kurang pada pengaturan bagan, Anda bisa meng-klik tombol

[>Kembali<]. Kemudian, bila sudah cukup, klik tombol [>Selesai<].
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Tidak Berjudul 1 - LibreOffice Calc - + x
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6.18 Hasil Bagan

6.1.3 LibreOffice Impress

Untuk keperluan membuat presentasi professional, Asril OS menyediakan program
bernama LibreOffice Impress. Program ini memiliki fitur yang lengkap untuk keperluan
membuat presentasi dan tampilannya pun mirip dengan Microsoft PowerPoint 2003.
Pada subbab ini, dijelaskan mengenai pengenalan program presentasi LibreOffice
Impress serta penjelasan singkat mengenai program ini.

Mulai bekerja

Untuk membuka LibreOffice Impress, klik Menu Utama > Perkantoran > LibreOffice
Impress. Anda akan melihat tampilan LibreOffice Impress yang mirip dengan Microsoft
Office PowerPoint 2003. LibreOffice Impress mendukung berbagai format, antara lain :

v Open Document Presentation (format default)
v Microsoft PowerPoint 97/2000/XP/2003

v Microsoft PowerPoint 2007

v LibreOffice Impress 1.0

Pengenalan antarmuka

Bagi yang sudah pernah membuat presentasi, antarmuka Impress tidak akan sangat
asing. Berikut adalah bagian-bagian dari antarmuka LibreOffice Impress:

1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif.
Baris menu, menampilkan daftar perintah Impress berupa menu.

3. Baris alat standar, menampilkan ikon-ikon perintah esensial untuk dokumen
Anda.

4. Baris alat pemformatan, menampilkan ikon-ikon atau pengaturan untuk
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melakukan pemformatan objek yang Anda pilih dalam presentasi.

Daftar slide, menampilkan slide yang terdapat dalam presentasi yang Anda
buat.
Bagian utama, menampilkan dan mengedit isi suatu slide.

Panel tugas, berisi berbagai macam pengaturan yang membantu Anda dalam
mengatur presentasi. Seperti pengaturan tata letak (layout ), palet (template),
animasi, dsb.

Baris alat menggambar, menampilkan ikon-ikon untuk menambah berbagai
objek baru pada suatu slide.

Baris alat Status, berisi kolom-kolom yang menampilkan berbagai status dari
area kerja.

Tidak Berjudul 1 - LibreOffice Impress - + x
Berkas Sunting Tampilan Sisip Format Perkakas Pertunjukan Salindia Jendela Bantuan
le-B-" O L8 e 8 OB = o BQ- e O-
H & % - ——)kowem [3)] i) were ;w0 ) O KBS
salindia ® Tugas Tinjau - %

‘Normal‘ Kerangka Catatan Kliping Penyusun Salindia

b Halaman Induk

1

b Tata Letak
+ Desail

Klik untuk menambah judul

Klik untuk menambah teks B
Baris Tajuk

Baris Total
Alur Baris
Kolom Pertama
Kelom Terakhir

Alur Kolom
+| || b Animasi Ubahan... |
b Transisi Salindia |

W/ -DoTW L 60 o 0D % NPEksa

Q Menu D ’7][:]- & Tidak Berjudul1-L...

3 28,58 /13,1615 0,00 x 0,00 | [ Salindial/1 Baku

032 0@

- —O———— + | 40%
W@ @ f; @ =2sel, 10Des 13, 23:33 &

6.19 LibreOffice Impress

Anda bisa menambahkan berbagai baris alat tambahan sesuai keperluan dengan cara klik
menu Tampilan > Bilah alat > baris alat yang ingin ditambahkan.

Bekerja dengan Impress

Membuat suatu slide presentasi dengan LibreOffice Impress bisa dilakukan langkah per
langkah, sehingga Anda bisa sangat mudah membuat suatu presentasi. Sebelum
mengerjakan isi slide, Anda terlebih dahulu dapat memilih tema dari slide Anda melalui
pengaturan Halaman Induk (master page) pada bagian panel tugas. Jika palet terasa
kurang, Anda bisa memasang berbagai palet tambahan melalui add-ons yang tersedia di
situs http://www.Libreoffice.org/



http://www.Libreoffice.org/
http://www.Libreoffice.org/
http://www.Libreoffice.org/
http://www.Libreoffice.org/

Program PerKgntoran

Tidak Berjudul 1 - LibreOffice Impress E
Berkas Sunting Tempilan Sisip Format Perkakas Pertunjukan Salindia Jendela Bantuan

le-8-0G0 A & 2| e w~- - O H- o *a -(e :[-
B3 % [——]koocm [3] 1)/ (wema | memn )0 BB -8 -

salindia bl |Norrnal‘ Kerangka Catatan | Kliping  Penyusun Salindia LlEEs Tinjau ~ %

— =l
=; k |

b Tata Letak

b Desain Tabel...

b Animasi Ubahan...
|| b Transisi Salindia

R/ -BoTW- L 60 & 0B 4 DpaOKna

‘=1 24,94 £15,35:% 0,00 x 0,00 | [+ Salindia1 /1 AbstractGreen 4 —0——— + | 40%

Klik untuk menambah teks
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6.20 Pilih Halaman Induk

Tata letak atau layout pada suatu slide bisa Anda buat sendiri dengan memanfaatkan
baris alat menggambar, atau dengan menggunakan layout yang sudah ada melalui
pengaturan [>Tata Letak<] pada panel tugas. Tentukan tata letak sesuai keinginan, dan
isilah slide Anda.

Untuk membuat presentasi lebih menarik, Anda bisa menambahkan animasi pada setiap
objek melalui pengaturan [>Animasi Ubahan<] pada panel tugas. Selain itu, Anda juga
bisa memberi animasi pada saat transisi antar slidemelalui pengaturan [>Transisi Slide<]
pada panel tugas.

Setelah sebuah slide selesai dibuat, Anda bisa membuat slide baru melalui menu Sisip >
Slide. Kemudian, Anda bisa mengerjakan slide baru Anda. Untuk berpindah dari suatu
slide ke slide lain, klik pada slide yang diinginkan pada daftar slide yang terlihat di
bagian kiri jendela program. Untuk menampilkan presentasi, klik menu Pertunjukan
Slide > Pertunjukan slide atau tekan tombol F5 pada keyboard. Jika ingin menyimpan
hasil pekerjaan anda, klik menu Berkas > Simpan. Lalu, tentukan lokasi penyimpanan
berkas serta format berkas yang diinginkan. Kemudian, klik tombol [>Simpan<]. Anda
juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol Ctrl+S pada
keyboard.

6.1.4 LibreOffice Draw

LibreOffice Draw adalah program menggambar yang disertakan dalam paket program
LibreOffice, jika kita kurang mahir menggunakan program Penyunting bitmap/raster
GIMP atau Penyunting vektor Inkscape kita dapat menggunakan program LibreOffice
Draw untuk menciptakan sebuah karya gambar sederhana. Pada dasarnya program
LibreOffice Draw adalah turunan dari program OpenOffice Drawing karena
menggunakan sumber kode yang sama sehingga tampilan, penggunaan menu dan
kurang lebih sama seperti pada OpenOffice Drawing. Untuk memulai menggambar
cukup sederhana yaitu dengan meng klik menu-menu jenis objek seperti yang ada di
menu toolbar.
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Tidak Berjudul 1 - LibreOffice Draw -+ %
Berkas Sunting Tampilan Sisip Format Perkakas Ubah Jendela Bantuan
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6.21 LibreOffice Draw

Ada banyak pilihan mulai menggambar garis, elips, oval, teks, kurva,konektor, garis
dan panah dan beberapa menu lainnya. setelah memilih salah satu menu tersebut (mis :
oval), klik dan tahan tetikus (mouse) pada lembar kerja dan gerakkan sampai ukuran
yang dirasa cukup dan lepaskan tetikus. anda dapat menyimpan hasil karya anda dengan
format odg, atau langsung mencetak menjadi dokumen pdf dengan memilih menu
ekspor sebagai pdf. Untuk membuka LibreOffice Draw klik Menu Utama > Perkantoran
> LibreOffice Draw.

*

6.2 PDF Chain

PDF Chain merupakan perkakas sederhana untuk melakukan manipulasi sederhana terhadap
dokumen PDF. Dengan program ini, Anda bisa memutar, memisah, menggabungkan, memberi
background halaman dari dokumen PDF. Anda juga dapat menambahkan halaman dari dokumen
lainnya. Seperti aplikasi penyunting normal lainnya, Anda harus menyimpan perubahan yang
dilakukan. Jika Anda ingin menjaga dokumen asli dan menyimpan perubahan menjadi sebuah
berkas baru, gunakan Simpan Sebagai. Untuk membukanya klik Menu Utama > Perkantoran >
PDF Chain masukkan password anda bila diperlukan. Berikut tampilan dari PDF Chain.



N g Zerkantoran

_ o
I Concatenate ||ﬁ=\ Backgraund!StampHAr:achrruemi%%oI;i
Add | Pages ‘ Rotation | Source file | Password | Pages
+ x 0 + +# Shuffle v
b Permissions
iTemangJ | Bersinkan | Simpan Sebagai |

6.22 PDF Chain

Untuk menambahkan dokumen ke dalam PDF Chain, gunakan tombol “+” yang ada di sebelah kiri
bawah, untuk menghapusnya gunakan “X” dan mengubah urutan dokumen dengan tanda panah atas
bawah. Anda dapat menentukan Concatenate, Burst, Background / Stamp, Attachment atau Tools
yang akan digunakan pada dokumen. Setiap dokumen yang dimasukkan, akan menampilkan
halaman, judul dan jumlah halaman. Anda dapat menentukan halaman yang mana yang akan
digunakan.

PDF Chain - + x
Concatenate | Burst Background / Stamp Attachment Tools
Add Pages Rotation Source file Password | Pages
& 1-end all 0° tutorial manux 3.0.pdf 153

]

+ ® (] 4+ ¥ shuffle Create new ID -

¥ Permissions
User password Encryption-  -Allo
| a | (©) None 5| Printing |£ Copy contents

. ) |3| Degraded printing  [c3| Screenreaders
(ST e - Folez || Modify contents |&] Modify annotations
| €a || | O128bit| | 5 Assembly (3] Fill in
I Tentang \ [ Bersihkan I Simpan Sebagai

6.23 Permissions

4

Setelah semuanya selesai, anda dapat mengatur Permissions dari dokumen yang akan disimpan
tersebut, anda dapat menentukan hal apa saja yang bisa pembaca lakukan terhadap dokumen
tersebut. Jika sudah selesai, silahkan simpan dengan tombol “Simpan Sebagai”, silahkan disimpan
sesuai dengan lokasi penyimpanan anda. Dikolom nama jangan lupa menggunakan menggunakan
format .pdf dibelakang nama dokumen yang digunakan, kemudian “Simpan”
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6.3 XCHM

xCHM merupakan perkakas sederhana untuk membuka file CHM.Tampilannya cukup sederhana,
untuk membukanya klik Menu Utama > Perkantoran > xCHM atau bisa juga dengan membuka
langsung file CHM yang ingin anda buka.

xCHM v. 1.21 - + x
Fle Edit History Help
= =] A £ « = B 3
Open.. Prnt. Fonts.. Contents | Copy Find Back  Forward  Home About

)(c ] Hello, and welcome to XCHM, the UNIX CHM viewer.
O

XCHM has been written by Razvan Cojocaru (rzvncj@gmail.com). Itis licensed under the GPL.
XCHM is based on Jed Wing's CHMLIB and wxWidgets.

If you'd like to know more about CHM, go to Pabs' CHM Specification page.
Pabs has contributed time and knowledge to the development of xCHM, and features such as the fast index search would not have been implemented
without his help. Portions of the fast index search are modified versions of Pabs' GPLd chmdeco code.

If you'd like to use the code in your own stuff please figure GPL out first.

Tips:
+ The global search is an 'AND" search, i.e. searching for 'word1 word2' (quotes not included) will find all the pages that contain both word1 and
wordz, in whatever order.
+ Allowing partial matches will find pages that contain words that anly start with the typed strings, i.e. searching for 'ans 4' (quotes not included)
will find pages that contain the sentence ‘The answer is 42.".
« Right clicking on the displayed page brings out a popup menu with common options.

Ctrl{emd)- is copy, Ctri(cmd)-F is find in page.

Enjoy.

@ venu [ B[] mm @®xcHmv o1 0182@ .09 @ ® (i @ mRab, 11Des 13, 21:51

6.24 xCHM

6.4 Adobe Reader

Adobe Reader merupakan aplikasi alternatif untuk membuka berkas PDF, karena secara default di
Asril OS di atur ke program “Xreader (Penampil Dokumen)”. Dengan adanya program Adobe
Reader ini, anda dapat membuka file PDF yang anda miliki dan mencetaknya dengan berbagai
macam hasil output. Untuk membukanya klik Menu Utama > Perkantoran > Adobe Reader 9 atau
bisa juga dengan klik kanan pada berkas PDF yang akan anda buka kemudian pilih menu “Buka
Dengan” kemudian pilih program “Adobe Reader 97, berikut tampilannya.

N = =L

File Edit View Document Tools Window Help

panduan.pdf [%]

B e oo w-H @ m :
+ Linux kurang memiliki dukungan dari produsen perangkat keras dalam hal penyediaan
perangkat lunak pengendali (driver). Hampir semua perangkat lunak pengendali yang saat
ini ada di Linux merupakan hasil jerih payah komunitas, dan sebagian kecil murni

Bookmarks

-
d dukungan dari produsen perangkat keras.
E cover + Linux masih kurang didukung oleh beberapa pembuat permainan. Kebanyakan permbuat
B KATA PENGANTAR permainan masih menggunakan sistern operasi Microsoft Windows sebagai platform
mereka.

¥ DAFTARISI

2] PENDAHULUAN 1.3 Apaitu Asril 0S?

E| 0.1 Ihwal Buku Ini

[l 0.2 Penulis
Lanjutan, Sampul
dan Tata Letak

|ﬂ 0.3 Lisensi
| 0.4 Merek Dagang

e

El 1.1 Apa itu Linwe?

|ﬂ 1.2 Kelebihan Linux
[ 1.3 Apa it Asril 052

El 1.4 Asal nama Asril
as

% 1.5 Fitur Asril 05

Asril OS merupakan Distro Linux Lokal Indonesia yang berisikan perangkat lunak (software) yang
dapat digunakan untuk keperluan desktop, laptop dan notebook. Asril OS dilengkapi dengan
berbagai pernak-pemnik khas Indonesia, distro ini cocok digunakan unfuk pengguna komputer di
Indonesia.

Asril OS dikembangkan oleh Asril Marhamah bersama Tim Pengembang Asril OS. Asril OS bisa
didapatkan oleh siapa saja tanpa perlu membayar untuk mengunduhnya. Pengembangan Asril OS
dimaksudkan sebagai distribusi alternatif dalam menggunakan perangkat lunak yang bebas dan
legal. Asril OS menawarkan lingkungan kerja dengan Desktop Cinnamon yang mudah dalam
penggunaan yang dilengkapi dengan Program Office, Desain Grafis, Multimedia, Pendidikan,
Islami, Internet dan lain-lain.

1.4 Asal nama Asril 0S

Asril 05, kalau dibaca bersambung menjadi asrilos. Frase asrilos terdiri dari dua kata yakni asri dan
los. Menurut Kamus Besar Bahasa Indonesia Asri yang berarti Indah dan los berarti bebas, lepas.
Maka digunakanlah semboyan "Indah, bebas, lepas" untuk distro yang sederhana ini. Asril OS bisa
juga diartikan sebagai Distro Linux yang dikembangkan oleh Asril Marhamah, sekaligus
memberikan identitas pada vane membuat distro limux ini.

6.25 Adobe Reader
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BAB 7 Program Multimedia dan Hiburan

Asril OS menyediakan berbagai Program Multimedia dan Hiburan yang bisa menghibur Anda di
saat sibuk bekerja untuk berproduktivitas. Selain itu, ada juga beberapa program multimedia yang
memang didedikasikan untuk mereka yang bekerja di studio musik atau video.

Asril OS secara default sudah menyertakan codec atau pustaka pemutar format multimedia yang
tertutup seperti MP3, DVD, WMA, dll. Jadi, Anda tidak perlu lagi memasang codec tambahan
untuk memutar format tersebut.

Pengatur volume suara untuk mengatur volume suara secara umum, Anda bisa klik ikon speaker
yang ada di bagian notification area, kemudian mengatur seberapa besar volume suara pada slider
yang disediakan.

7.1 Brasero

Program ini mendukung pembakaran CD/DVD dengan berbagai format, yaitu Data, Audio dan
Video. Untuk membuka program ini Klik Menu Utama > Suara & Video >Brasero. Pada jendela
utama program Brasero, Anda akan diminta untuk memilih salah satu proyek yang ingin dibuat,
antara lain : Proyek Audio, Proyek Data, Proyek Video, Salin Diska, dan Bakar Salinan.

Brasero e
Proyek Sunting Perkakas Bantuan
Buat proyek baru: Proyek baru-baru Ini:

Tidak ada proyek yang baru-baru ini digunakan

Y B Proyek audio
Qjﬁ/ Membuat CD audio tradisional

4 | Proyek data

I 3’) Membuat data CD/DVD

48 | Proyek video

I =
‘gj/) Membuat DVD video atau SVCD
Salin diska
Membuat salinan CD/DVD sesuai aslinya

Bakar salinan
* Membakar salinan CD/DVD

7.1 Brasero

AN

Proyek audio, membuat CD Audio/Musik tradisional (menggunakan batas waktu 79 menit)
yang bisa diputar di semua pemutar CD/DVD.

Proyek video, membuat SVCD/DVD untuk keperluan video.
Proyek data, membuat CD/DVD untuk penyimpanan data.
Salin diska, untuk menyalin/menggandakan CD/DVD.

A N N N N

Bakar salinan, untuk membakar berkas cetakan/image CD/DVD ke dalam kepingan
CD/DVD.
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7.2 VLC Media Player

VLC Media Player merupakan perangkat lunak (software) pemutar beragam berkas (file)
multimedia, baik video maupun audio dalam berbagai format, seperti MPEG, DivX, Ogg, dan lain-
lain. VLC Media Player juga dapat digunakan untuk memutar DVD,VCD, maupunCD. VLC Media
Player bersifat sumber terbuka (open source) dan tersedia untuk berbagai sistem operasi. Mulai dari
Microsoft Windows, beragam distro Linux, Mac OS, dan beberapa sistem operasi lainnya.

Salah satu kelebihan yang paling menonjol dari VLC Media Player adalah kelengkapan codec yang
dimiliki. Dengan kata lain, VLC dapat memutar hampir seluruh jenis berkas audio maupun video
yang ada. VLC Media Player adalah program multimedia player yang sangat portabel. Singkatnya,
program ini bisa dipakai untuk memutar berkas multimedia, baik yang ada di komputer, keping CD
atau DVD, hingga untuk streaming di internet.

Di balik tampilan programnya yang sederhana, pemutar berkas multimedia ini dilengkapi dengan
beragam fitur tambahan, seperti kemampuan subtitle, tag format, konversi, filter, skin, dapat
dioperasikan melalui berbagai interface, tersedia dalam bahasa Indonesia, dan masih banyak lagi.
Bahkan, program ini juga bisa dijadikan sebagai server untuk kebutuhan streaming di jaringan lokal
dan internet. Untuk membuka program ini, klik Menu Utama > Suara & Video > VL.C media palyer.

VLC media player

Media Playback Audio Video Tools View Bantuan

E O EREIMREES =
7.2 VLC media player

Untuk membuka berkas video pada VLC media player, klik menu Media kemudian pilih sumber
file yang akan di putar. Ada beberapa pilihan sumber media yang dapat kita pilih, diantaranya Open
File, Buka Direktori, Buka Disk, Buka Stream Jaringan dan lain-lain. Ditampilkan juga Tombol
Pintas yang bisa digunakan.
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VLC media player - 4

Playback Audio Video Tools View

[¥] open File... Ctrl+0
3 Buka Direktori... Ctri+F
(=) Buka Disk... Ctrl+D
&= Buka Stream Jaringan... Ctrl+N
Buka Perangkat Penangkap... Ctrl+C

Bantuan

[¥] open (advanced)... Ctrl+Shift+0

Buka Lokasi dari clipboard Ctri+Vv
Open Recent Media e

Ctri+Y

Simpan Playlist ke File...

Convert / Save... Ctrl+R
(=) Stream... Ctrl+5S

Quit at the end of playlist
Ctrl+Q

LARCI LI LIR=ITIRE e )

7.3 Sumber File

Sebagai contoh, kita memilih “Open File”, kemudian pilih berkas video yang ingin diputar,
kemudian klik tombol Buka.

Plih satu atau lebih file untuk dibuka

\| _,M media 1 asrilmarhamah 1 502040433C56E44A” Narutol NarutO Shippuden
Lokasi Nama ¥ Ukuran | Diubah
Q, cari ] H
# Baru-baru In... | |8 Naruto Shippuden Episode 003.mp4 79,8 MB  25/03/10
M crilmarham... | Bl Naruto Shippuden Episode 004.flv 62,7 MB  23/08/10
B Desktop ﬁ Naruto Shippuden Episode 005.rmvb 33,2 MB  15/03/07
|- sistem Berkas ﬁ Naruto Shippuden Episode 006-007.rmvb 63,6 MB  30/03/07
2,0 GB Volu... a Narute Shippuden Episode 008-009.rmvb 74.8 MEB 13/04/07
|-/ 50 GB Volume E Narute Shippuden Episode 010.rmvb 33.8 MEB 19/04/07
|2/ 50 GB Volume ﬁ Narute Shippuden Episode 011.avi 178,3 MB 13/05/07
|2/ 50 GB Volume E Naruto Shippuden Episode 012.avi 178,3 MB 13/05/07
|/ 52 GB volume & Naruto Shippuden Episode 013.avi 178,4 MB 11/05/07
™ Dokumen ﬂ Naruto Shippuden Episode 014.rmvh 51,2 MB 18/05/07
- ik ﬁ Naruto Shippuden Episode 015.rmvb 45.0 MB  24/05/07
 Gambar ﬁ Naruto Shippuden Episode 016.flv 98,8 MB 19/08/10
» video a Naruto Shippuden Episode 017.flv 98,7MB 19/08/10
=™ duhan ﬁ Narute Shippuden Episede 018.rmvb 33.5MB 22/06/07

8 Naruto Shippuden Episode 019.rmvb 36,8 ME 06/07/07

B narutn Shinnndan Enisnda 020 rmark 34 7me 2nun7mT T

| File Media =N
|  Batal | Buka

7.4 Open File

Maka file yang ada pilih akan langsung diputar. Sedangkan jika Anda ingin membuka video dari
kepingan CD/DVD, pilih menu Media > Buka Disk. Untuk memulai memutar berkas video yang
dibuka, klik tombol Play. Sedangkan jika anda ingin memutar semua file yang ada di suatu
direktori, silahkan pilih menu Media > Buka Direktori.

7.3 Audacity

Audacity adalah program yang memanipulasi bentuk gelombang audio digital. Selain rekaman
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suara langsung dari dalam program, ini impor banyak format file suara, termasuk WAV, AIFF, MP3,
dan Ogg Vorbis. Format PCM dari 8,16,24 dan 32-bit dapat diimpor dan diekspor. Hal yang dapat
dilakukan dengan Audacity yaitu :

1. Potong, Salin, Tempel, Hapus, Diam, Duplikat, Split
berlaku plug-in efek untuk bagian suara

built-in editor amplop volume

spektrogram disesuaikan trek modus tampilan

analisis frekuensi window untuk aplikasi audio analisis

oA W

Tingkat pemutaran kustom untuk melacak setiap, yang hidup-resampled dengan tingkat
Sampel proyek

7. sederhana untuk operasi menyelaraskan kompleks untuk trek dan kelompok trek
Meskipun Audacity adalah audio editor yang sangat kuat yang bekerja dengan trek jumlah yang
tidak terbatas ukuran hampir tak terbatas, tidak dapat melakukan semuanya. Audacity tidak bisa :

1. Audacity tidak dapat merekam lebih dari dua saluran sekaligus pada banyak sistem.
Beberapa dukungan untuk rekaman multitrack termasuk dalam versi 1.2.3, tetapi tidak
mendukung sistem sangat banyak belum.

2. Audacity membuka file MIDI, tetapi bukan editor MIDI, MIDI serta fitur yang sangat
terbatas.

Audacity - + %
Berkas Edit Lihat Tansportasi Trek Buat Efek Analisa Bantuan

L TL] [
EL IR [

ITHE
H 2 85T 'jH,@\?*;M 634420 Py G341z 0

o —— Y —— o x mm[ o] o[~ &] # A2IE[]o
||[ ALSA 4 | 4) | default 4] A| defauic + ][ 2 (Stereo) in :]‘
- 1:’0 ) ) ll,D ) '{,ﬂ X SI,D ) 4‘,0 X 5‘,0 ) E‘,D X 7‘,0 ) II,D X 9‘,ﬂ ) lq,ﬂ
“|Rrate Proyek (Hz): Awal Filihan: © Akhir O) Panjang Posisi Audio:
44100 | ¥ Patokan (] |00 jam 00 mnt00.000 dtk~| 00 jam 00 mnt 00.000 dtk~ 00 jam 00 mnt 00.000 dtk~]|

§ O ® 5 ® = Rab, 11Des 13,0954

7.5 Audacity

Untuk menjalankan Audacity, klik Menu Utama > Sound & Video > Audacity. Untuk panduan
lebih lanjut anda bisa baca buku panduan yang sudah kami sertakan, untuk membukanya klik Menu
Utama > Panduan > Panduan Audacity

7.4 Cheese

Cheese adalah aplikasi webcam yang terinspirasi dari aplikasi GNOME Photobooth untuk
mengambil gambar dan video dari webcam. Cheese juga disertai efek grafis fancy berdasarkan
gstreamer-backend. Untuk menjalankan Cheese, klik Menu Utama > Sound & Video > Cheese.
Berikut tampilan Cheese :
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Cheese T

Cheese

\EL”E||@.| ‘.AmbiIFoto ﬂ‘ﬂ|*

7.6 Cheese

Untuk mengambil foto tinggal klik pada Ambil Foto dan hasil foto akan tersimpan di folder
Gambar. Sedangkan jika kita ingin melakukan rekam video, klik menu Cheese yang ada di pojok
kiri atas, kemudian pilih video, bisa juga dengan klik icon foto, video dan foto banyak. Untuk
pengaturan pilih Cheese > Preferences. Anda juga dapat menambahkan efek dengan klik tombol
Efek.

7.5 Mobile Media Converter

Saat ini menggunakan linux bukan lagi merupakan suatu yang asing atau sulit, linux itu enak dan
menyenangkan dan semua bisa dipelajari dan di dapatkan di linux, termasuk salah satunya adalah
dalam hal converter video atau audio. Mobile Media Converter yang memungkinkan kita bisa
melakukan konversi berbagai jenis format audio video.

Mobile Media Converter adalah audio gratis dan video converter untuk mengkonversi antara audio
desktop populer dan format video seperti MP3, Windows Media Audio (wma), Ogg Vorbis Audio
(ogg), Wave Audio (wav), MPEG video, AVI, Windows Media Video(wmv), Flash Video (flv),
QuickTime Video (mov) dan umum digunakan perangkat mobile / ponsel seperti format audio AMR
(amr) dan video 3GP. Ipod / iPhone dan video MP4 PSP kompatibel yang didukung. Selain itu,
Anda dapat menghapus dan menambahkan format baru atau perangkat melalui internet.

Sudah terintegrasi YouTube downloader yang tersedia untuk di-download langsung dan konversi ke
salah satu format. Anda dapa tmemotong klip Anda untuk pembuatan ringtone atau tujuan lain dan
memotong video Anda untuk menghapus atas / bawah bar hitam atau bagian yang tidak diinginkan
dari gambar. Selain itu, sub judul tertanam dapat dikodekan ke video untuk menonton film atau
acara dengan teks pada perangkat yang tidak mendukung mereka. Akhirnya, built-in DVD ripper
tersedia untuk mengubah DVD Anda sendiri untuk salah satu format yang didukung. Program ini
memiliki GUI yang sangat mudah digunakan dan sederhana (Graphical User Interface) yang
membantu bahkan pengguna yang paling amatir. Anda hanya perlu memasukkan file input atau
hanya drag n drop input file .

Untuk menjalankan Mobile Media Converter klik Menu Utama > Sound & Video > Mobile Media

L Halaman 61



N gl ia dn Hifuran

Converter. Selanjutnya tampilan awalnya adalah sebagai berikut :

Mobile Media Converter - + %

( +4Fle J( ®DVW J( ) YouTube ) Clear |

drag/medialhere

7.7 Mobile Media Converter

Untuk menambahkan file anda bisa drag n drop atau melalui tombol “+ File” kemudian pilih tempat
penyimpanan file yang akan di convert kemudian klik buka, maka file yang anda pilih akan
langsung masuk ke daftar file.

x

IE I@[ media ” asrimarhamah Jl 502040433656E44A" Naruto I Naruto ShiEE“d-n

Lokasi ‘ Nama ¥ Ukuran | Diubah

Q, Cari [} l]

4 Baru-baru Ini Dig... | & Naruto Shippuden Episode 003.mp4 79.8 MB  25/03/10

B obileMediaConv... | Bl Naruto Shippuden Episode 004.flv 62,7 MB  23/08/10

B acrilmarhamah I8 aruto Shippuden Episode 005.rmvb 33,2 MB  15/03/07

B Desktop . Naruto Shippuden Episode 006-007.rmvb 63.6 MB  30/03/07

| sistem Berkas . Naruto Shippuden Episode 008-009.rmvb 74,8 MB  13/04/07

/2,0 GB Volume . Naruto Shippuden Episode 010.rmvb 33.8 MB  19/04/07

|- 50 GB Volume . Maruto Shippuden Episode 011.avi 178.3 MB 13/05/07

|- 50 GB Volume = . Maruto Shippuden Episode 012.avi 178,3 MB 13/05/07

|- 50 GB Volume . Naruto Shippuden Episode 013.avi 178.4 MB 11/05/07

|- 52 GB Volume . Naruto Shippuden Episode 014.rmvb 51,2 MB  18/05/07

™ okumen . Naruto Shippuden Episode 015.rmvb 45,0 MB  24/05/07

-k . Naruto Shippuden Episode 016.flv 98,8 MB  19/08/10

® Gambar I8 Naruto Shippuden Episode 017.flv 98,7 MB  19/08/10

» video [ Naruto Shippuden Episode 018.rmub 33,5 MB  22/06/07

= nduhan . Naruto Shippuden Episode 019.rmvb 36,8 MB  06/07/07 )
I Suppoerted Types = J

Batal |

7.8 Memilih File

Selanjutnya silahkan pilih tempat penyimpanan output file nya dan menentukan format output nya.
Anda juga dapat menentukan kualitas output nya.
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‘Mobile Media Converter =

¢ fﬁ@ J(_ _®DvD ) OYuTube ) [  Clear |

- Naruto Shippuden Episode 053.flv

L h o
[ /media/asrilmarhamah/502040433C56E44A/Naruto/Naruto Shippuden/ | v -

Conversion to:
| Mobile Audio - AMR-NB Audio 3

b ! ’ Convert! ). .

7.9 Tempat dan Format Output

Setelah semuanya selesai, silahkan konvert dengan klik tombol “Convert”, proses convert berjalan.

Mobile Media Converter

Processing...

Naruto Shippuden Episode 053.flv

W OK

7.10 Proses Convert berjalan

‘Mobile Media Converter

7.11 Convert Selesai
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7.6 Radio Tray Lite

Radio Tray merupakan program untuk mendengarkan siaran radio dari seluruh dunia. Untuk
membukanya klik Menu Utama > Sound & Video > Radio Tray Lite, maka radio tray akan terbuka
dengan menampilan icon di Tray Icon. Untuk memutar radio silahkan klik icon Radio Tray Lite
dan pilih jenis musik kesayangan anda beserta nama stasiun radio nya. Untuk dapat mendengarkan
radio dengan lancar, pastikan koneksi internet anda lancar, karena ini menggunakan streaming
radio.

Classical

C®G one £1m .4 )
7.12 Radio Tray Lite

7.7 Celluloid

Untuk memutar video selain VLC media player, Asril OS juga menyediakan program bernama
Celluloid yang tampilannya mirip dengan Windows Media Player yang ada di Microsoft Windows.
Untuk membuka program ini, klik Menu Utama > Suara & Video > Celluloid. Untuk membuka
berkas video pada Pemutar Film, klik menu “+” > Buka, kemudian pilih berkas video yang ingin
diputar, kemudian klik tombol Buka. Sedangkan jika Anda ingin membuka video dari kepingan
CD/DVD, klik menu “+” > Putar Disc. Untuk memulai memutar berkas video yang dibuka, klik
tombol Putar.

Celluloid

7.13 Media Player
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7.8 Hypnotix

Hypnotix merupakan inovasi baru untuk menikmati siaran televisi secara streaming dengan Free-
IPTV. Selain siaran TV ada juga untuk siaran Radio. Secara default Hypnotix menyediakan
berbagai siaran internasional dari berbegai negara. Hypnotix ini cukup mudah untuk digunakan,
anda tinggal klik menu TV Channels kemudian Pilih Negara dan saluran TV yang ingin anda
saksikan. Untuk mengaksesnya klik Menu Utama > Suara & Video > Hypnotix. Berikut tampilan
utama dari Hypnotix ini.

7.14 Hypnotix
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BAB 8 Program Desain Grafis

Untuk menunjang kebutuhan Desain Grafis, Asril OS telah menyertakan program grafis diantaranya
Inkscape, GIMP, Penampil gambar, Pengelola fotografi Pix, Pemindai Berkas, dan Scribus untuk
desain publishing. Semua program grafis yang ada berfungsi untuk menggantikan program grafis
komersial yang ada di sistem operasi Microsoft Windows Dengan program Legal. Walaupun ada
kemiripan, ada beberapa perbedaan yang harus Anda ketahui dan dikuasai. Namun dengan
pembiasaan diri, tidak akan sulit untuk menggunakan program grafis yang ada di Asril OS untuk
berproduktivitas dan berkreatifias.

8.1 Penampil Gambar

Desktop Asril OS 2.0.png - + x
Gambar Sunting Tampilan Ke Bantuan

4 Sehelumnya W Selanjutnya @& @ @ H H ¢

1024 x 600 piksel 121,7 kB 53% 59 /64

8.1 Penampil Gambar

Asril OS mendukung berbagai format gambar/fotografi yang bisa Anda buka menggunakan
program Penampil Gambar. Untuk membuka suatu gambar/foto, Anda bisa klik ganda berkas
gambar/foto yang ingin dibuka pada perambah berkas Nemo. Penampil Gambar dapat digunakan
untuk melihat gambar/foto yang ada di suatu folder. Anda bisa manfaatkan tombol [>Sebelumnya<]
atau [>Selanjutnya<]. Jika ingin melakukan slide show pada gambar/foto, Anda bisa tekan tombol
F5 pada papan tik atau klik menu Tampilan > Pertunjukan Slide. Penampil Gambar juga bisa
dimanfaatkan untuk memutar atau membalikkan foto. Untuk melakukan hal ini, Anda bisa
manfaatkan tombol putar yang ada di sebelah kanan atas.

8.2 Pix

Pix adalah program album foto yang mampu mengorganisasi rangkaian foto yang diambil disaat
bersamaan secara otomatis. Selain itu juga terdapat fasilitas penajaman, pemutaran, penghilangan
efek mata merah, pemotongan gambar, juga pengaturan seperti bukaan, saturasi, tinta, dan
temperatur. Dalam pengklasifikasian rangkaian, Pix mampu mendeteksi foto hingga pertanggal.
Kalau kurang nyaman dengan pengklasifikasian per tanggal, bisa kita ubah menjadi nama yang
sesuai dengan kejadian saat itu. Terdapat pula fitur slideshow di bagian bawah jendela utama.
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File Edit Lihat Pergi PenandaTaut Bantuan

« + % v 4 0| @A b m| Qv v E
Atur

o ¥ Gambar v
» ™ Siellarium

» W Video
» A Desktop

» ™ Dokumen .
= "
» ™ sistem Berkas ﬁ e

[R Tag (tertanam) -

Tampilkan: | Semua -

8 berkas (656,8 kB) - 5,1 GB dari ruang bebas

8.2 Pix

8.3 GIMP Editor Gambar

Untuk keperluan editing gambar/foto yang berbasis bitmap, Asril OS menyediakan program
bernama GIMP (www.gimp.org). Program ini merupakan salah satu bagian dari paket program
Grafik. Program ini merupakan program padanan dari penyunting foto terkenal di sistem operasi
Microsoft Windows, yaitu Adobe Photoshop. Jika Anda sudah ahli menggunakan Adobe Photoshop,
menggunakan GIMP tidaklah hal yang sulit yang penting adalah Anda membiasakan menggunakan
program ini.

Initializing Plug-ins

8.3 Splash GIMP Editor Gambar

8.3.1 Memulai program GIMP

Untuk membuka GIMP, klik Menu Utama > Grafik > GIMP Editor Gambar. Tunggu
sebentar hingga jendela utama program GIMP muncul. Tidak seperti Photoshop, jendela
GIMP terpisah-pisah menjadi tiga bagian, yaitu bagian toolbox (kiri), bagian utama
(tengah) dan jendela bantu (kanan). Berbeda dengan Photoshop yang menggabungkan
semua jendela tersebut menjadi sebuah jendela.
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8.4 GIMP Editor Gambar

Untuk membuat kanvas baru, klik menu File > New. Kemudian, tentukan ukuran kanvas
serta pengaturan lainnya. Sedangkan untuk membuka suatu gambar/kanvas, klik menu
File > Open dan pilih berkas gambar/kanvas yang ingin dibuka. Format kanvas default
yang digunakan oleh GIMP adalah XCF. Untuk format lainnya, GIMP mendukung
format: GIF, JPEG, PNG, PSD,EPS, BMP, dan ada puluhan format lainnya yang
didukung.

Bekerja dengan GIMP Seperti yang dijelaskan sebelumnya, jika Anda sudah terbiasa
menggunakan program Adobe Photoshop, Anda hanya memerlukan sedikit pembiasaan
untuk menggunakan GIMP karena penampilannya memang di desain semirip mungkin
dengan Adobe Photoshop.

Toolbox - Opsi Alat Lapisan - Kuas
B

=2 . 9 [Menu] (imported)-1.0 (RGE color, 1 layer) 1024x600 - GIMP sk T = ;“

: v

o - @ File Edit Select View Image Layer Colors Tools Filters Windows Help |
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BRA &g =
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&
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8.5 Membuka Gambar dengan GIMP
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8.3.2 Manipulasi Foto Dengan GIMP

Karena jendelanya yang terpisah- pisah, Anda bisa mengatur sedemikian rupa sehingga
semua bagian jendela yang dibutuhkan bisa Anda lihat dan langsung digunakan tanpa
perlu lagi memperlihatkan jendela tersebut. GIMP menyediakan berbagai toolbox yang
berfungsi untuk melakukan pemotongan, pemindahan dan menggambar. Untuk
mempermudah mengakses toolbox tersebut, Anda bisa menggunakan papan tik shorcut
yang tampil saat ikon di sorot seperti pada gambar.

= ?
S 2 s MDUe|~wma|_¢J‘
ansal |
bb s Bl m |
WEAQ| - =
A E 7 /4
ofa & &
& o u o

&
. o= 4 3 & *

s AIatL - @KUES‘DPDH .]Gradien =

Airbrush ‘ [ e i

MDde:l Nermal J -
( 2. Hard, 050 (51 x 51) H

4 + + |7

[ Kuas J
- SELX )48

‘,. 2. Hardness DE| F L_ v

3 ‘ _ [Basic. v ]
Ukuran 20,00 o = =
irak 10,0 '|

.. opo®l &l ¥
0pb B x 3 b S| x O

O Menu m B ma B [Menul (imported...
8.6 Peralatan GIMP

8.3.3 Keyboard Shortcut

Pada gambar tampak, untuk mengaktifkan Selection Tool dapat digunakan tombol R.
Dengan pembiasaan, papan tik shortcut ini akan teringat dengan sendirinya. Pengaturan
dari tiap-tiap tool terdapat di bagian bawah ikon-ikon tool. Sebelum membahas fungsi
setiap tool, sebaiknya anda memahami dulu konsep layer dan image. Untuk lebih jelas,
Image : adalah Image adalah gambar, atau dapat juga disebut file tunggal, sedangkan
Layer : Jika Anda membayangkan image adalah sebuah kue lapis, layer adalah tiap
lapisannya sehingga jika layer diatasnya berlubang, maka akan kelihatan layer di
belakangnya. Image juga dapat dijadikan layer dengan memindahkannya ke image lain.
Jika di photoshop sebuah image dapat di drag ke gambar lain untuk dijadikan layer, di
GIMP haruslah di copy terlebih dahulu. Inilah perbedaan mendasar yang seringkali
membingungkan pengguna photoshop. Beberapa tools yang sering digunakan para
desainer akan ditampilkan pada tabel berikut :
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Fungsi Tombol Keyboard
Rectangle selection tool R
Elipse selection tool E
Free/Glasso? select tool F
Fuzzy/Magic? select tool U
Select by color Shift+O
Scissors select tool I
Foreground select tool <tidak ada>
Paths tool B

Color picker 0]

Zoom tool Z
Measurement tool Shift+M
Move tool M
Allignment tool Q

Crop tool Shift+C
Rotate tool Shift+R
Scale tool Shift+T
Shear tool Shift+S
Perspective tool Shift+T
Flip tool Shift+F
Text tool T
Bucket fill tool Shift+B
Blend/Gradient? tool L

Pencil tool N
Paintbrush tool P

Erase tool Shift+E
Airbrush Tool A

Ink tool K

Clone tool C
Healing tool H
Perspective clone tool <tidak ada>
Burn/Sharpen? Tool Shift+U
Smudge tool S
Dodge/Burn? tool Shift+D

Ada 33 Tool dalam toolbox utama ini. Cukup banyak untuk penggunaan sehari-hari.
Setiap tool akan diikuti dengan beberapa opsi yang otomatis muncul di bagian bawahnya
atau Tool option. Untuk menampilkan jendela dialog layer/lapisan lainnya, klik menu
Windows > Dockable Dialog > pilih sesuai keinginan anda. Silahkan anda menempatkan
dan mengaturnya senyaman mungkin.
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Untuk mempermudah editing, Anda bisa memanfaatkan fitur layer/lapisan yang akan
memisahkan setiap objek yang ada di kanvas Anda. Pengaturan layer/lapisan bisa Anda
lakukan melalui toolbox bantu di bagian kanan layar. Dengan membedakan layer/lapisan
dari setiap objek, Anda bisa lebih mudah memanipulasi suatu objek tanpa perlu
menganggu objek lainnya. Berbagai menu untuk keperluan manipulasi gambar secara
keseluruhan dapat ditemukan pada menu Image. Sedangkan untuk memanipulasi suatu
layer/lapisan atau objek yang dipilih, Anda bisa manfaatkan menu Layer.

Bagi yang ingin bermain-main dengan warna, silahkan manfaatkan menu Colours untuk
melakukan manipulasi warna pada objek. GIMP menyediakan berbagai efek-efek yang
bisa Anda buka melalui menu Filters. Untuk memberi efek pada bagian tertentu, Anda
bisa memilih bagian yang ingin diberi efek dengan menggunakan toolbox untuk memilih
(selection tool atau menekan tombol R pada papan tik), lalu pilih efek yang diinginkan
pada menu Filters. Kemudian, atur pengaturan efek agar sesuai dengan keinginan Anda.

8.3.4 Lebih Lanjut Dengan GIMP

Untuk mempelajari lebih lanjut mengenai GIMP, Andabisa membuka layar bantuan
melalui menu Help > Help. Jika ingin membaca bantuan GIMP tanpa perlu koneksi
internet, Anda bisa menginstal paket "gimp-help-en" (Bahasa Inggris) melalui APT
dengan kata kain melalui perintah di terminal dengan mengetikkan sudo apt-get install
gimp-help-en. Jika Anda baru pertama kali mempelajari editing fotografi, Anda bisa
mempelajari dari banyak tutorial GIMP yang terdapat di internet. Kami juga sudah
menyertakan panduan GIMP, klik Menu Utama > Panduan > Panduan GIMP

8.4 Inkscape

Inkscape merupakan program penyunting grafis vektor yang secara default sudah terinstal di Asril
OS. program ini adalah padanan dari program penyunting grafis vektor komersial Corel Draw yang
ada di Microsoft Windows.

8.4.1 Memulai Inkscape

Untuk membuka program Inkscape, klik Menu Utama > Grafik > Inkscape. Tidak lama
kemudian, jendela program Inkscape akan dibuka. Penampilan dan tata letak dari
Inkscape sangat mirip dengan Corel Draw. Jika Anda sudah terbiasa menggunakan Corel
Draw, menggunakan Inkscape tidaklah menjadi hal yang sulit.
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8.7 Inkscape

Berikut adalah bagian dari program Inkscape :

1. Menu dan command bar, berisi perintah-perintah untuk program Inkscape.
Tool control bar, berisi pengaturan dari objek yang Anda pilih pada kanvas.
Kanvas, disinilah tempat untuk melihat dan mengedit objek-objek pada gambar.
Toolbox, berisi berbagai alat-alat menggambar objek serta alat-alat bantu.

A

Pallete, berisi pilihan warna yang bisa Anda gunakan untuk mewarnai suatu
objek.
6. Status bar, menampilkan status dari program, layer, lokasi kursor serta besaran
zooming.
Untuk membuka berkas yang sudah tersimpan, Anda bisa klik menu File > Open.
Kemudian, pilih berkas yang ingin dibuka. Hampir semua jenis berkas grafis didukung
oleh Inkscape, termasuk format dari Corel Draw (*.cdr).

8.4.2 Bekerja Dengan Inkscape

Pertama kali bekerja dengan Inkscape, Anda perlu mengatur besar dari ukuran kanvas
yang akan digunakan. Untuk melakukan hal ini, Anda bisa membuka Properti Dokumen
melalui menu Berkas > Properti Dokumen, atau Anda bisa tekan tombol Shift+Ctrl+D.
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8.8 Properti Dokumen

Kemudian, tentukan ukuran dari kanvas serta orientasinya yang diinginkan. Jika ingin
menggunakan ukuran Anda sendiri, Anda bisa melakukan pengaturan pada [>Ukuran
sendiri<]. Sekarang, Anda bisa menggambar objek yang diinginkan dengan
memanfaatkan toolbox yang berada dikiri jendela program. Anda bisa mengatur bentuk-
bentuk pada objek yang Anda buat sedemikian rupa sesuai dengan keinginan Anda.
Untuk mengatur bentuk garis pada objek, Anda bisa klik kanan pada objek dan memilih
menu [>Isi dan Sapuan<]. Maka akan muncul sebuah sidepane di bagian kanan jendela
program yang berisikan pengaturan garis objek. Untuk menyimpan hasil kerja anda, klik
menu Berkas > Simpan. Kemudian, tentukan nama dan letak berkas serta format berkas
yang akan digunakan. Format berkas default yang digunakan adalah SVG yang
merupakan format universal untuk grafis berbasis vektor.

8.4.3 Mempelajari Inkscape Lebih Lanjut

Untuk menggunakan Inkscape lebih lanjut, Anda bisa membuka tutorial- tutorial yang
bisa Anda akses melalui menu Help > Tutorial. Tutorial tersebut sangat cocok bagi para
pemula baik yang baru menggunakan Inkscape atau sama sekali belum pernah
melakukan editing grafis. Jika menginginkan yang lebih referensif, Anda bisa klik menu
Help > Inkscape Manual. Anda memerlukan koneksi internet untuk membuka manual
ini. Kami juga sudah menyertakan panduan Inkscape yang dapat anda akses dengan klik
Menu Utama > Panduan > Panduan Inkscape
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8.5 Scanner

Pemindai Ringkas merupakan program pemindai berkas yang sukup mudah untuk digunakan.
Pemindai Ringkas secara otomatis mendeteksi apabila ada Scanner yang terhubung dengan
komputer atau laptop kita. Sehingga kita dapat menggunakan Scanner kita dengan mudah. Untuk
menggunakannya klik Menu Utama > Grafik > Scanner

L4

No scanners detected

Please check your scanner is connected and powered on

8.9 Scanner

Untuk menggunakannya, tinggal klik “Scan” maka secara otomatis berkas yang ada di Scanner akan
di scan dan kita dapat melihat tampilannya. Kita dapat melakukan pengaturan melalui menu
“Gambar” dan mengatur sesuai dengan kebutuhan kita.

8.6 Drawing

Di Sistem Operasi Windows, kita mengenal MS. Paint, sebuah aplikasi sederhana yang digunakan
untuk keperluan mengedit gambar/foto. Di Linux Ubuntu pun kita dapat menggunakan Drawing
sebuah aplikasi sederhana untuk mengedit foto/gambar yang boleh dibilang padanan apliklasi dari
MS. Paint untuk Linux Ubuntu.

Drawing adalah editor foto sederhana untuk Linux dan lebih mudah digunakan jika dibandingkan
dengan Gimp, namun tetap memiliki beragam alat dan fitur yang dapat digunakan. Pinta dapat
digunakan untuk pengeditan yang cepat seperti mengubah ukuran gambar atau menyesuaikan warna
foto, dan bisa juga untuk kegiatan profesional yang berhubungan dengan layer.

Drawing adalah campuran yang baik antara MS Paint dan alat editior gambar profesional lainnya,

dalam pengeditan gambar sehari-hari direkomendasikan untuk menggunakan Pinta. Untuk
menggunakannya klik Menu Utama > Grafik > Drawing.
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BAB 9 Program Pendidikan

Asril OS menyediakan beberapa program pendidikan yang sangat cocok untuk anak-anak. Antara
lain Tux Paint, Tux Math, Tux Typing, gCompris, Otodidak, GNU PSPP, Stellarium dan lain-lain.
Dengan adanya program-program pendidikan ini diharapkan distro Asril OS bisa menjadi distro
linux yang disukai dan diminati oleh semua kalangan baik orang dewasa maupun anak-anak.

9.1 Tux Paint

Tux Paint adalah program menggambar sederhana yang didesain untuk anak mulai usia tiga tahun
ke atas. Tux Paint adalah program Open Source alias gratis yang dirilis dengan lisensi GNU General
Public License, yang bisa diunduh dan digunakan oleh siapa saja. Untuk mengaksesnya klik Menu
Utama > Pendidikan > Tux Paint.

Tux Paint

New \
: Breed & 4
v Software

Tux
Paint

© 2002-2009 Bill Kendrick et al.
Version: 0.9.21 - 2013-08-14

9.1 Tux Paint

Dibandingkan dengan Paint bawaan Windows, Tux Paint memiliki beberapa keunggulan
diantaranya tampilan yang menarik, tool gambar dengan banyak pilihan, stempel gambar unik, efek
suara lucu yang menyertai saat menggambar di kanvas, gambar yang bisa dicerminkan maupun
dibalik, dan cara menyimpan gambar yang sangat mudah dengan sekali klik mouse.

Disamping itu sudah diterjemahkan ke dalam bahasa Indonesia meskipun belum sempurna. Tidak
hanya anak-anak yang senang bermain Tux Paint bahkan banyak orang dewasa yang menggunakan
karena kelebihannya dibandingkan program Paint sejenis. Tux Paint bisa dijalankan di sistem
operasi Windows, Linux, Apple Mac OS, bahkan program ini bisa dimainkan pada beberapa seri
handphone.

Kelebihan dari Tux Paint ini antara lain:

v Sudah tersedia koleksi stempel lengkap dengan penjelasannya, serta beberapa di antaranya
sudah dilengkapi dengan efek suara.
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v Sudah di-internasionalisasi, sehingga menu ikon bisa ditampilkan dengan bahasa indonesia.
sayang paket stempel yang tersedia penjelasannya hanya dalam bahasa inggris, dan belum
dalam bahasa indonesia, meskipun sepertinya bisa dengan mudah kita ubah sendiri.

Kami juga sudah menyertakan panduan Tux Paint yang dapat anda akses melalui Menu Utama >
Panduan > Panduan Tux Paint

9.2 Tux Math

TuxMath adalah sebuah game arcade yang membantu anak-anak berlatih matematika. Tujuan utama
software ini adalah untuk membuat belajar matematika menjadi efektif dan menyenangkan. Selain
itu pada software ini membantu guru dalam pembelajaran. Siswa lebih mudah memahami tentang
pelajaran matematika. Software yang menarik dan mendorong minat siswa untuk lebih mengetahui
tentang pelajaran matematika. Untuk mengaksesnya klik Menu Utama > Pendidikan > Tux Math.

A

Play Alone

TR T R T
] Network Game
T W TINAE. T
“}' Play With Friends
. w BERM " . N
Factoroids!
Help
B N R
More Options

RE
%

9.2 Tux Math

9.3 Tux Typing

Tux Typing adalah sebuah game yang dirancang untuk memandu kita bagaimana menggunakan 10
jari kita dengan benar ketika berada di atas keyboard. Bagi yang masih terbiasa menggunakan 11
jari. Untuk mengaksesnya klik Menu Utama > Pendidikan > Tux Typing.



9§ Fish Cascade
Comet Zap

Lessons

?i Options

1} Quit

9.3 Tux Typing

9.4 GCompris

GCompris adalah perangkat lunak pendidikan yang berisi berbagai macam kegiatan untuk anak usia
2 sampai 10 tahun. Beberapa kegiatan berorientasi permainan tapi tetap mendidik. Di bawah ini
anda dapat melihat daftar kategori yang berisi berbagai macam kegiatan. Untuk mengaksesnya klik
Menu Utama > Pendidikan > GCompris.

v

SR R X X

pengenalan komputer: papan ketik (keyboard), tetikus (mouse), berbagai macam penampilan
tetikus,

aljabar : tabel memori, urutan, tabel pemasukan ganda, mencerminkan gambar,
ilmu pengetahuan alam: pintu kanal, siklus air, kapal selam, rangkaian listrik
geografi: menempatkan negara pada peta

permainan: catur, memori, sambung 4, oware, sudoku

membaca: latihan membaca

lain-lain: mengenali jam, teka-teki gambar, menggambar vektor, membuat animasi.



GCompris V13.11

GCompris adalah kumpulan permainan mendidik yang berisi
berbagai kegiatan untuk anak umur 2 tahun ke atas.

Number of activities: 141

9.4 (‘}E;)mpris

Saat ini GCompris berisi lebih dari 100 kegiatan dan masih terus dikembangkan. GCompris adalah
perangkat lunak bebas, yang berarti anda dapat menyesuaikan dengan kebutuhan anda,
mengembangkannya, dan yang paling penting, berbagi dengan anak-anak di seluruh dunia.

9.5 Otodidak

Otodidak merupakan program untuk belajar linux mandiri yang didesain untuk pemula maupun
lanjutan. Program ini didesain dengan tampilan GUI untuk mempermudah bagi yang ingin belajar
linux, tetapi tidak ingin mencobanya secara langsung. Dengan adanya program Otodidak ini, kita
dapat belajar linux dengan mudah dan disertai dengan gambar yang menarik. Program ini didesain
satu untuk semua, yaitu satu program untuk semua pengetahuan dasar linux. Setelah mempelajari
program Otodidak ini, diharapkan anda sudah bisa menggunakan linux dengan baik dan tidak ragu
lagi. Adapun yang ada bisa pelajari dari program Otodidak ini yaitu :

Simulator Terminal (Anda bisa belajar Terminal tanpa Terminal).

Kumpulan tutorial instalasi modem di Ubuntu.

Kumpulan penjelasan mengenai Ubuntu semisal kelebihan/kekurangan.

Tabel perbandingan aplikasi Windows dan Ubuntu.

Semua kumpulan pengetahuan Linux bergambar.

Tutorial instalasi aplikasi di Ubuntu.

Tutorial instalasi kodek MP3 di Ubuntu.

Kumpulan penjelasan mengenai 5 desktop environment di Linux.

LNk W=

Kumpulan perintah Terminal yang sering digunakan.

—_
o

. Kumpulan trik cepat menggunakan Terminal.

—_
—_

. Kumpulan pengetahuan dasar Linux, GNU, Free Software, Open Source, Repositori, dan
cara belajar Linux dalam Bahasa Indonesia dan disertai ilustrasi (didesain dengan Inkscape).

Untuk membuka program Otodidak ini, klik Menu Utama > Pendidikan > Otodidak. Maka anda
akan melihat tampilan awal Otodidak.
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Otodidak

Aplikasi Belajar Linux Mandiri

Pemula Lanjutan

deleA(INeIvmEM e |

=
L

Ubuntu sebagai contoh Linux yang akan kita pelajari

[ Tentang Otodidak |

9.5 Otodidak

Menu yang disediakan program Otodidak ini ada dua, yaitu untuk Pemula dan Lanjutan. Kita dapat
memilih sesuai dengan kebutuhan kita. Berikut ini tampilan dari menu Pemula dan Lanjutan.



Otodidak

Selamat Datang di Otodidak!

Tingkat Pemula

Ubuntu Instal Aplik asi MP3 IModem Terminal

«‘ Kembali

9.6 Menu Pemula

Otodidak

Selamat Datang di Otodidak!

Tingkat Lanjutan

Free as in Freedom TH
L

[ | | | open source [ |
Linux QMU Free Software Open Source
T pmerr /
i ‘ Kembali /
| T —
Repasitori Belajar?
9.7 Menu Lanjutan
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BAB 10 Program Islami

Asril OS sudah menyertakan Program Islami didalamnya, sehingga anda dapat menggunakannya
secara langsung dan aplikasi islami yang ada diantaranya Minbar Prayer Times, Hijr Applet, Ayat,
Hadist Web, Monajat dan Lafzi.

10.1 Waktu Shalat Minbar

Waktu Shalat Minbar merupakan program yang dapat memberikan informasi tentang waktu sholat
dan peringatan jika telah masuk waktu sholat. Program ini juga dilengkapi dengan adzan waktu
masuk sholat dan waktu sholat dapat diatur sesuai dengan daerah yang diinginkan. Pada dasarnya
Waktu Shalat Minbar akan berjalan pada saat masuk ke desktop Asril OS, kalau belum silahkan
menjalankan Waktu Shalat Minbar dengan klik Menu Utama > Perangkat Lunak Islami > Waktu
Shalat Minbar. Berikut tampilan Program Waktu Shalat Minbar.

.

Rabu, 25 Rajab 1439
11 April 2018
23:25

Jadwal Lokasi Tabel waktu

Subuh: 04:36 Q, Kalender Sholat

Fajar:
Preferensi

Duhur: 11:45
Acha 1as0 Arah kiblat
ar s 65 Barat 2 Bunyikan Adzan
Maghrib: 17:45
Isya: 18:51 Cirebon (Kota) Preferences
& 5jamdan 11 menit menjelang sholat Subuh.
About Quit Close

10.1 Waktu Shalat Minbar

10.1.1 Mengatur Waktu Sholat di Waktu Shalat Minbar
Agar jadwal waktu sholat sesuai dengan daerah setempat, perlu diadakan pengaturan.
Langkah - langkahnya sebagai berikut :
1. Buka aplikasi Minbar Prayer Times, klik tombol Preferensi

2. Akan muncul jendela yang berisi pengaturan Sunting Detil Kota, klik tombol
Cari Kota

3. Pada kotak pencarian ketik nama negara atau daerah setempat, jika
menemukan pilih nama negara atau daerah setempat, klik tombol Terapkan

4. Jika tidak menemukan daerah yang diinginkan, lanjutkan ke langkah berikut.
Cari tahu mengenai lokasi anda, letak Bujur, Lintang, dan Zona Waktu.

6. Jika sudah ketemu, masukkan koordinat tersebut pada jendela seperti pada
gambar langkah nomor 2.
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Sunting Detil Kota x

% Detil Kota ’\ Lanjut P Adzan

. A
Bujur: 108,53 ,|
Nama kota: Cirebon (Kota)

ZonaWaktu: (7.0 |3
e
| ok J[ satal |
10.2 Sunting Detil Kota

10.1.2 Mengatur pengingat Adzan di Waktu Shalat Minbar

Minbar Prayer Times dilengkapi alarm suara adzan untuk menunjukkan telah masuk
waktu sholat, untuk mengaktifkan dan merubah suara adzan dapat dilakukan sebagi
berikut :
1. Buka aplikasi Minbar Prayer Times, beri tanda pada “Bunyikan Adzan”
2. Jika ingin merubah suara adzan, pada langkah nomor 2, klik tombol Preferensi,
pilih tab Adzan, arahkan dimana file adzan berada / tersimpan di komputer
(ingat : file adzan harus berjenis .0gg)
3. Untuk mengatur pengingat waktu sholat akan muncul pada waktu sebelum
waktu sebenarnya, atur di tab Lanjut dengan cara memberi tanda pada “Ya,
beritahukan sebelumnya”

Sunting Detil Kota »®

& Detil Kota | % Lanjut » Adzan

Opsi

[E] Mulai diminimisasi ke baki.

Pemberitahuan

[£] ¥a, beritahukan sebelumnya: ED menit

Metoda Perhitungan

IUniversitas llmu Keislaman, Karachi (Syafii) 2

[ Oke ‘ I Batal ‘

10.3 Lanjut

10.1.3 Melihat Kalender Jadwal Waktu Sholat

Dengan aplikasi Minbar Prayer Times juga bisa melihat jadwal waktu sholat, untuk
melihatnya ikuti langkah berikut :
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1. Buka aplikasi Minbar Prayer Times, klik tombol Prayer Calendar
2. Muncul kalender waktu sholat

Kalender
< April > £ AN >| Subuh: 04:36
Fajar. 05:46
! Duhur: 11:45

2 3 4 5 6 7 8

9 10“12 13 14 15 Ashar: 14:50
16 17 18 19 20 21 22

Maghrib: 17:45
23 24 25 26 27 28 29
30 Isya: 18:51
Hariini Close
10.4 Kalender Shalat

10.2 Hijra Applet

Hijra Applet merupakan program kalender Hijriyah yang menampilkan penanggalan Islam yaitu
penanggalan hijriyah. Untuk menampilkannya anda bisa membukanya dengan klik Menu Utama >
Perangkat Lunak Islami > Hijra Applet atau dengan meng-klik icon Hijra Applet yang ada di Tray
Icon di panel.

e - 1439 iz, >

arandl puuasdl elag W1 eGMl iyl

05 04 03 02
22/03  21/03  20/03 19/03 1B/03
12 11 10 09 08 07
29/03 28703 27/03 26/03 25/03 24403
19 18 17 16 15 14
05/04 04/04 03704 02/04 01/04 31703
26 24 23 22
12/04 11704 10/04 09/04 O0B/04 07704
30 29 28
16/04 15/04 14704

2018 931433 LJH O

10.5 Hijra Applet

10.3 Monajat

Monajat Applet adalah program untuk menampilkan Do'a dan Dzikir yang akan ditampilkan di
Desktop secara berkala. Selain itu, Monajat Applet juga dilengkapi dengan jadwal Shalat yang
dapat kita atur sesuai dengan daerah tempat tinggal kita. Monajat Applet ini secara otomatis aktif
ditandai dengan adanya icon monajat applet di area notofikasi. Jika belum ada, anda juga bisa
membukanya melalui Menu Utama > Perangkat Lunak Islami > Monajat Applet for supplications.
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4 hours and 54 minutes till Fajr prayer

Do 0 D@ €1 =)@ Rab, 3 Mar 21, 23:45

10. 6 Monajat Applet

Untuk melakukan pengaturan jadwal shalat, klik kanan icon Monajat Applet yang ada di area
Notifikasi dan pilih “Configure”. Anda dapat menentukan auto start, manfaat serta waktu muncul di
tab “Generic”, daerah kita di tab “Location” dan Notifikasi Adzan di tab “Notification”, jika sudah
selesai semua simpan dengan klik tombol “Save”.

Monajat Configuration

| Generic m i i .

|| Autoe start
E Menunjukkan manfaat

e

Time:

L Gancel | save

10.7 Monajat Configuration

10.4 Ayat

Program Ayat merupakan aplikasi islami yang berisi Al-Qur'an yang terintegrasi dengan beberapa
fitur yang dapat membantu kita dalam mempelajari Al-Qur'an. Dalam Program Ayat ini sudah
disertakan Terjemahan untuk beberapa bahasa dan disertai juga dengan Tafsir dari beberapa bahasa,
selain itu, sudah disertakan pula pilihan tampilan seperti Tampilan Penuh, Tampilan Baca dan
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Latihan Hafalan. Anda juga bisa melakukan pencarian dengan menggunakan fasilitas pencarian
yang sudah disertakan. Anda juga dapat menambahkan Murottal dari berbagai Qori International
untuk mendengarkan lantunan Al-Qur'an dibacakan. Anda dapat menambahkannya baik langsung
dari aplilasi atau mendowloadnya secara manual terlebih dahulu. Semua sudah disertai dengan
beberapa pilihan, seperti untuk tampilan anda dapat memilih menggunakan Surat, Ayat, Halaman,
dan Juz. Untuk membukanya klik Menu Utama > Perangkat Lunak Islami > Ayat. Berikut tampilan
dari Program Ayat ini.

- =

(penguiangan  [J{SIRP  Cor Al-Husari Bd | cihan EX) 1 D jcai

‘ (v X -] o)) ‘ Surat h Ayat ﬁ Halamanw Juz h |
- _

e Terjemah |indonesian - Bahasa

(1) Dengan menyebut nama Allah Yang Maha Pemurah
0 lagi Maha Penyayang.

(2) Segala puji bagi Allah, Tuhan semesta alam.

(3) Maha Pemurah lagi Maha Penyayang.

(<] (4) Yang menguasai di Hari Pembalasan.
Q (5) Hanya Engkaulah yang kami sembah, dan hanya
kepada Engkaulah kami meminta pertolongan.
(&) Tunjukilah kami jalan yang lurus, 7 @p—-i}'* j{;;)__.)
(7) (yaitu) Jalan orang-orang yang telah Engkau beri Qé’"“‘-i‘:‘“"r”sﬁh"‘;s'h
a nikmat kepada mereka; bukan (jalan) mereka yang dimurkai

dan bukan (pula jalan) mereka yang sesat. (ST P A )
o

10.8 Ayat

10.5 Hadist Web

HaditsWeb adalah Program yang berisi hadits-hadits, yang Insya Allah senantiasa diupdate atau
ditambah setiap beberapa waktu tertentu. Sumber yang digunakan sebagai bahan penulisan program
ini berasal dari kitab-kitab hadits yang Insya Allah dapat dipercaya, dan juga dari website-website
Islam lainnya yang didalamnya terdapat pembahasan mengenai hadits.

Bagi Anda yang telah menggunakan, mengunjungi ataupun mendownload program ini, maka
dimohon dengan sangat agar menyebarkan program ini kepada rekan-rekan muslim dan muslimah
yang lain. Semoga program ini akan lebih banyak memberikan manfaat kepada sebanyak-
banyaknya kaum muslimin dan muslimah yang hendak belajar hadits.

Developer HadisWeb menyadari dalam program ini mungkin masih banyak kekurangannya, oleh
karena itu mudah-mudahan masukan yang sifatnya membangun dan positif dari seluruh pengguna
program ini akan semakin menambah penyempurnaan program ini ke arah yang semakin baik serta
informasi yang semakin lengkap. Untuk membukanya klik Menu Utama > Perangkat Lunak Islami
> HadisWeb.
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File WView Edit History Help
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10.9 HadistWeb

10.6 Lafzi

Lafzi adalah aplikasi pencari lafaz pada Al-Quran. Aplikasi ini dibuat untuk memudahkan pencarian
ayat dengan lafaz tertentu pada Al-Quran hanya dengan aksara Latin biasa berdasarkan pelafalan
pembicara bahasa Indonesia, tanpa perlu mengetikkannya dalam aksara Arab.

Aplikasi ini adalah hasil dari penelitian skripsi Departemen Ilmu Komputer, Institut Pertanian
Bogor oleh Muhammad Abrar Istiadi, S.Kom dengan pembimbing Ahmad Ridha, S.Kom MS. Lafzi
merupakan aplikasi berbasis web. Untuk menggunakan aplikasi Lafzi ini, bisa melalui klik Menu
Utama > Perangkat Lunak Islami > Lafzi atau melalui web browser dengan mengakses alamat
http://localhost/lafzi/. Adapun tampilan utama Lafzi seperti tampak pada gambar berikut ini.

Lafzi - Pencarian Lafaz Quran - Chromium

@ Lafzi- Pencarian Lafaz Quran X

€ > C @ localhost/lafzifweb/ + O :

2= Apl

» Google Play

@e® Pencarian lafaz Quran

Bantuan»  Pengaturan »

cComputer Science IPB | Lafzi Web | Lafzi Desktop | Lafzi Android | Tentang Lafzi
Copyright © 2012-2021 Computer Science IPB

10. 10 Lafzi
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BAB 11 Program Internet

Saat ini internet tidaklah lagi termasuk ke dalam kebutuhan tersier atau mewah. Kini, Internet
menjadi kebutuhan yang sangat penting bagi setiap orang untuk mengakses informasi atau
berkomunikasi dengan orang lain di seluruh penjuru dunia. Biaya untuk jaringan Internet sudah
tidak semahal seperti pada saat pertama kali diperkenalkan. Bahkan, beberapa tempat umum
menyediakan jaringan hotspot yang kebanyakan bersifat gratis agar Anda bisa mengakses internet
melalui notebook atau perangkat lain yang memiliki fitur Wi-Fi. Untuk memanfaatkan jaringan
Internet, Asril OS menyediakan berbagai program yang siap dipakai untuk keperluan Anda internet
seperti peramban web, klien e-mail atau surat elektronik dan pesan instan.

11.1 Koneksi ke Jaringan Internet

Sebelum berselancar di dunia maya menggunakan Asril OS, tentunya Anda harus menyambungkan
komputer ke jaringan Internet melalui LAN, Wi-Fi, Modem 3G/HSDPA, atau Modem ADSL.

11.1.1 Melalui kabel LAN

Pada umumnya, tempat-tempat kerja menyediakan jaringan Internet melalui jaringan
kabel (wired). Untuk melakukan koneksi internet melalui kabel, cukup sambungkan
kabel RJ-45 dari jaringan LAN Anda ke LANCard atau NIC yang ada di komputer
atau laptop Anda. Jika muncul pesan bahwa sambungan sudah terjalin pada area
notifikasi, berarti komputer telah sukses bergabung dengan jaringan tanpa masalah.

Jika koneksi ternyata gagal, berarti tempat Anda menerapkan pengaturan jaringan
secara manual. Untuk itu, Anda perlu menyetel pengaturan jaringan pada komputer
Anda terlebih dahulu. Untuk melakukan hal ini, klik kanan pada ikon koneksi jaringan
pada area notifikasi, kemudian klik menu [>Pengaturan Jaringan<]. Pada tab
[>Kabel<], klik tombol [>Opsi<] untuk menambahkan pengaturan jaringan baru.
Maka akan muncul jendela baru untuk membuat pengaturan jaringan baru. Pada kotak
teks [>Nama Sambungan<], ketik nama pengaturan jaringan Anda. Misalnya, nama
jaringan anda : "Sambunga kabel 1".

Menyunting Sambungan kabel 1 x

Nama sambungan: | Sambungan kabel 1

Umum Ethernet Keamanan 802.1x Tatanan IPv4 | Tatanan IPv6

Metode: | Otomatis (DHCP) =

Alamat

Alamat Netmask Gateway Tambah

Hapus

Server DNS tambahan: | |

Ranah pencarian tambahan: | |

ID klien DHCP: | |

"1 Memerlukan pengalamatan IPv4 agar sambungan ini lengkap

| Route... |

| Batal || Simpan... |

11.1 Pengaturan IP
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Anda bisa memberi centang pada [>Menyambung otomatis<] agar pengaturan
jaringan tersebut langsung diterapkan jika Anda bergabung dengan jaringan kabel ini.
Kemudian buka tab [>Tatanan IPv4<]. Pada tab ini, pilih opsi [>Atur sendiri<] pada
metode, kemudian klik tombol [>Tambah<] untuk menambabh setting IP jaringan.
Isilah[>Alamat<], [>Netmask<], dan [>Gateway<] sesuai dengan pengaturan jaringan
di tempat Anda.

Kemudian, isi kotak teks [>Server DNS<] dengan nomor IP dari DNS Server di
Internet, apabila ada lebih dari satu DNS Server bisa menambahkannya dengan

dipisah tanda koma (“,”). Anda bisa menanyakan bagaimana pengaturan jaringan di
tempat Anda kepada administrator jaringan di tempat Anda.

Beri tanda centang pada Tersedia untuk semua pengguna jika Anda menghendaki
pengguna lain dapat menyambung dengan jaringan ini. Anda akan ditanyakan
password root. Masukkan saja password root lalu klik Otentikasikan. Setelah semua
pengaturan selesai, klik tombol [>Terapkan<].

Untuk melakukan koneksi dengan jaringan kabel dengan pengaturan jaringan yang
baru dibuat, klik pada ikon koneksi jaringan pada area notifikasi. Pada bagian
[>Jaringan Kabel<], pilih nama pengaturan jaringan Anda. Maka tidak lama
kemudian akan muncul pesan bahwa jaringan telah berhasil terjalin.

11.1.2 Melalui hotspot atau Wireless LAN

Saat ini, banyak sekali terdapat tempat-tempat umum atau perkantoran yang
menerapkan jaringan melalui teknologi wireless LAN atau yang sering dikenal dengan
istilah hotspot. Dengan jaringan seperti ini, tidak perlu lagi direpotkan dengan
penggunaan kabel karena jaringan ini menggunakan gelombang microwave seperti
jaringan GSM Handphone. Untuk melakukan koneksi Internet melalui hotspot, sangat
mudah sekali. Jika kartu jaringan tanpa kabel sudah terdeteksi dengan baik oleh Asril
OS, cukup klik pada ikon koneksi jaringan pada area notifikasi, kemudian pada bagian
[>Jaringan Nirkabel<], pilih nama jaringan hotspot yang akan dikoneksikan. Tidak
beberapa lama kemudian, koneksi akan langsung terjalin.

Jika ternyata koneksi tidak terjalin, mungkin Anda perlu melakukan penyetelan
konfigurasi jaringan secara manual. Untuk melakukan hal ini, klik kanan pada ikon
koneksi jaringan pada area notifikasi, lalu klik menu [>Pengaturan Jaringan<]. Buka
tab [>Nirkabel<]. Pada tab ini, klik pada nama jaringan yang ingin Anda atur yang
diawali dengan teks [>Auto<], lalu klik pada tombol [>Ubah<]. Lalu buka tab
[>Pengaturan IPv4<]. Pada tab ini, pilih opsi [>Atur Sendiri<] pada bagian method.
Kemudian, klik tombol [>Tambah<] dan isikan [>Address<], [>Netmask<], dan
[>Gateway<] sesuai dengan pengaturan jaringan hotspot tersebut. Setelahsemua
pengaturan selesai, klik tombol [>Terapkan<]. Sekarang, Anda bisa mengulangi
melakukan koneksi kejaringan hotspot yang sudah Anda atur. Maka tidak akan lama,
koneksi akan terjalin.

>Catatan: Jika kartu jaringan wireless tidak terdeteksi dengan baik, Anda bisa menuju
ke Bab 15 pada subbab tentang konfigurasi kartu WLAN.
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11.1.3 Melalui modem ADSL

Saat ini, modem ADSL banyak digunakan untuk keperluan Internet melalui jaringan
telepon PSTN. Penggunaan modem ADSL tidak serepot menggunakan ISP berbasis
radio yang menjamur saat ini, karena tidak perlu membangun tower yang tinggi.
Cukup mengandalkan jaringan telpon PSTN yang sudah terpasang. Biasanya, modem
ADSL yang ada saat ini sekaligus berfungsi sebagai router untuk jaringan. Anda
cukup menyambungkan kabel LAN RJ-45 dari modem ADSL ke LAN Card pada
komputer, maka komputer akan langsung melakukan koneksi terhadap modem
tersebut. Tidak akan lama, koneksi akan terjalin dan Anda bisa mulai ber-internet ria.

11.1.4 Melalui Mobile Broadband

Setelah Modem Anda dikenali oleh Asril OS, sekarang lakukan setting parameter
kartu sesuai provider yang Anda pakai. Pertama-tama, klik kanan ikon koneksi
jaringan pada area notifikasi, kemudian pilih [>Pengaturan Jaringan<] jika tidak ada
bisa Klik Menu Utama > Preferensi > Pengaturan Sistem kemudian pada sub
Perangkat keras pilih Jaringan, maka akan keluar tampilan seperti dibawah ini :

Jaringan - + x
| Semua Pengaturan
Data seluler MATI |
Mode Pesawat Terban MATI
& Mirkabel
Jaringan |
@ Kabel Y
M Proxy jaringan
|E|— Opsi...
Berpindah ke Mode Lanjut | Tutup

11.2 Jaringan

Klik tab [>Data Seluler<] pada Jaringan pilih “Tambah Sambungan Baru” maka akan
keluar Sambungan Data Seluler Baru (pada contoh ini saya memakai HP Extrem
EVDO)
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Siapkan Sambungan Data Seluler
Pilih Negara atau Wilayah Operator Anda
Pilih Operator Anda

Pilih Jenis Langganan Anda
Konfirmasikan Tatanan Data Seluler

Sambungan Data Seluler Baru

Asisten ini membantu Anda menyiapkan dengan mudah sambungan data seluler ke
jaringan 3G.

Anda akan memerlukan informasi berikut:

* Nama operator seluler Anda
* Nama tipe langganan seluler Anda

+ (dalam beberapa kasus) APN (Access Point Name) tipe langganan data seluler Anda

a

11.3 Sambungan Baru

Silahkan lanjutkan dengan klik [>Lanjutkan<].

Siapkan Sambungan Data Seluler

Pilih Negara atau Wilayah Operator Anda
Pilih Operator Anda

Pilih Jenis Langganan Anda

Konfirmasikan Tatanan Data Seluler

Sambungan Data Seluler Baru

Daftar Negara atau Wilayah:

Negara atau wilayah

Inggris

Irak

Iran, Republik Islam L
Irlandia

Islandia

Isle Man

Israel

Italia

Jabaltar
lamaica

l Batal ” Kembali ” Lanjutkan

4

11.4 Negara atau Wilayah

Silahkan pilih Negara atau Wilayah tempat Anda berada karena kita berada di
Indonesia maka pilih Indonesia (untuk memudahkan pencarian pada Keyboard /Papan
Ketik tekan huruf I), kemudian klik [>Lanjutkan<].

Siapkan Sambungan Data Seluler

Pilih Negara atau Wilayah Operator Anda
Pilih Operator Anda

Pilih Jenis Langganan Anda
Konfirmasikan Tatanan Data Seluler

Sambungan Data Seluler Baru

(©) Pilih operator Anda dari daftar:

Operator

Esia

Fren

Indosat
SMART
Telkom Flexy

() Tak menemukan operatorku dan ingin memasukkannya secara manual:

Operator: 1

I Batal ” Kembali ” Lanjutkan

a

11.5 Operator Seluler

Selanjutnya pilih nama Operator selular yang Anda pakai, pilih sesuai dengan kartu
yang terpasang pada modem, Jika modem anda GSM maka yang ditampilkan adalah
operator GSM, jika modem anda CDMA maka yang ditampilkan adalah operator
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CDMA (jika tidak ada dalam pilihan ini klik Tak menemukan operatorku dan
masukkan secara manual, tulis nama Provider yang Anda pakai dengan cara manual)
klik [>Lanjutkan<].

Sambungan Data Seluler Baru

Siapkan Sambungan Data Seluler
Pilih Negara atau Wilayah Operator Anda Sambungan data seluler Anda ditata dengan tatanan berikut:
Pilih Operator Anda

& % Operator Anda:
Pilih Jenis Langganan Anda

. SMART, Indonesia
Konfirmasikan Tatanan Data Seluler

Batal H Kembali H Terapkan

11.6 Terapkan

Maka akan keluar ringkasan dari seting dial-up sesuai dengan operator Anda, klik
[>Terapkan<] untuk menerapkan pengaturan modem anda. Ini hanya perlu dilakukan
sekali, selanjutnya tinggal klik icon koneksi jaringan dari area notifikasi.

Jaringan CDMA

Terhubung
Anda kini terdaftar ke jaringan rumah. SMART connection

Jangan tunjukkan pesan ini lagi

Jangan tunjukkan pesan ini lagi

143009 [ 143009 [

11.7 Indikator Koneksi Berhasil

Sekarang Anda sudah bisa Online dimanapun selama Provider yang Anda pakai
mendapatkan sinyal bagus. Langkah ini bisa anda lakukan apabila modem anda sudah
dikenali dengan baik oleh Asril OS. Tetapi jika modem anda belum dikenali oleh Asril
OS, seperti modem yang saya pakai ini (HP Extrem EVDO) anda bisa melakukan
langkah berikut ini.

Silahkan buka Terminal (Menu Utama > Aksesoris > Terminal atau klik icon Terminal
di Laucher bar). Untuk identifikasi USB Modem anda, sebaiknya modem anda tidak
sambungkan terlebih dahulu, kemudian di terminal ketik lsusb, silahkan colokkan
USB Modem anda, kemudian ketik lagi lsusb. Perhatikan hasil yang ditampilkan
antara yang pertama dan yang kedua. Dari Device yang ada mestinya USB Modem
anda sudah terdaftar. Apabila USB Modem dikenali sebagai CD-ROM (cek dengan
ketik'Is /dev kalau ada srQ atau srl bagi yang memiliki Drive CD-ROM, berarti USB
Modem anda dikenali sebagai CD-ROM), agar USB Modem anda dikenal sebagai
USB Modem, keluarkan terlebih dahulu CD-ROM dengan ketik gject st0 (bagi yang
memiliki Drive CD-ROM gunakan eject srl). Untuk memastikan USB Modem anda
sudah dikenali sebagai USB Modem ketik lagi lsusb. Perhatikan hasil yang
ditampilkan. Ingat vendor dan product dari USB Modem anda tersebut, seperti pada
contoh ini adalah 1bbb:0106 (1bbb adalah vendor nya dan 0106 adalah product nya).
Perhatikan gambar berikut untuk lebih jelasnya.
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Terminal - + =
lsusb 7
e 003: 4f2:be Chicony Electronics Co., Ltd 2.8M UVC Webcam / CNF7129
8e2: 7 67 SanDisk Corp. Cruzer Blade
e e 081: 6b:9802 Linux Foundation 2.8 root hub
B5 Device 801: 6b: 08 Linux Foundation 1.1 root hub
4 Device 089: pd62:a Darfon Electronics Corp. Optical Mouse
4 Device 081: 6b:0881 Linux Foundation 1.1 root hub
Device 081: 6b: 08 Linux Foundation 1.1 root hub
Device 081: iiH Linux Foundation 1.1 root hub
1lsusb
= 003: p4f2: Chicony Electronics Co., Ltd 2.8M UVC Webcam / CNF7129
; 802: B 15567 SanDisk Corp. Cruzer Blade
DPVlCP 801: 6b:8802 Linux Foundation 2.8 root hub
5 Device 081: 6b:8801 Linux Foundation 1.1 root hub
4 Device 018: 62:a180 Darfon Electronics Corp. Optical Mouse
4 Device 081: ' inux Foundation 1.1 root hub
Device : ID 1d i Foundation 1.1 root hub
Device : ID i A Mobile Phones
Device ©81: ID 1déb: i Foundation 1.1 root hub

Device 003: p4f2: Chicony Electronics Co., Ltd 2.8M UVC Webcam / CNF7129
Device 082: §781:5567 SanDisk Corp. Cruzer Blade
Device 081: fb:9802 Li Foundation 2.8 root hub
DPuicp % iiH Linux Foundation 1.1 root hub
: Darfon Electronics Corp. Optical Mouse
Linux Foundation 1.1 root hub

; 9801 Linux Foundation 1.1 root hub
DPVlCP pO6: ID 5 T & A Mobile Phones
Device @81: ID 1déb: Li Foundation 1.1 root hub

11.8 Vendor dan Product USB Modem

Selanjutnya, memasang driver USB Modem anda, agar bisa dikenali oleh Asril OS.
Ketik di Terminal sudo modprobe usbserial vendor=0x1bbb product=0x0106.
Perhatikan pada bagian vendor=0x1bbb ganti sesuai dengan vendor dari USB Modem
anda dan pada product=0x0106 ganti sesuai dengan product dari USB Modem anda.
Masukkan password anda. Untuk mengecek apakah USB Modem anda sudah dikenali
oleh Asril OS, ketik dmesg | tail kemudian lihat hasil yang ditampilkan. Mestinya
sudah dikenali sebagai ttyUSB1, ttyUSB2 dan ttyUSB3 seperti yang ditampilkan pada
gambar berikut ini.

Terminal - + =

asrilmarhamah@PICO-DJH-Model eject sr@
asrilmarhamah@PIC0-DJH-Model sudo modprobe usbserial vendor=0x1bbb product=8x0106
[sudo] password for asrilmarhamah:
asrilmarhamah@PICO-DJIH-Model dme
[ 83.149799] eri eri qpneric converter detected
[ 83.150097] : eri ! ached to ttyUSBl
[ 83.150160] eri eric 2-1: ; 4 e neric" usb-serial driver is only for testing and one-of
f prototypes.

.158171] usbserial generic 2-1:1.2: Te i nux jer.kernel.org to add your device to a proper

.150179] usbsprlal generic 2-1:1.2: generic converter detected
.150428] 3 neric converter now attached to ttyUSB2

.158483] usbserial e eric" usb-serial driver is only for testing and one-of
f prototypes.
[ 83.150493] usbserial generic 2-1:1.3: Tell linux-us jer.kernel.org to add your device to a proper
driver.
[ 83.150503] usbserial neric 2-1:1.3: generic converter detected
[ 83.150777] usb 2-1 eric converter now attached to ttyUSB3
asrilmarhamah@PIC0O-DJH-Model l

11.9 Pasang Driver USB Modem
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Apabila hasil yang ditampilkan tidak sesuai dengan gambar atau ada tulisan yang
tidak jelas begitu, untuk mengeceknya bisa juga dengan mengetikkan - lihat
hasil yang ditampilkan, apakah sudah ada ttyUSBO, ttyUSBI1, ttyUSB2, ttyUSB3.
Apabila sudah ada, berarti USB Modem anda sudah dikenali oleh Asril OS. Langkah
ini biasanya diperlukan setiap kali kita ingin menyembungkan USB Modem Kkita.
Langkah selanjutnya bisa anda lakukan seperti yang sudah dituliskan diatas.

11.2 Web Browser

Kebanyakan orang memanfaatkan jaringan internet dengan melakukan browsing atau
meramban halaman web untuk keperluan mencari suatu informasi atau keperluan lainnya.
Untuk melakukan browsing pada Asril OS, Anda bisa memanfaatkan program bernama Firefox

Web Browser.

11.2.1 Perambah Web Firefox

Mozilla Firefox merupakan peramban web yang paling familiar. Untuk
menggunakannya kita bisa melalui icon Mozilla yang ada di Laucher ataupun melalui

Menu Utama > Internet > Firefox Web Browser.

@ Mozilla Firefox Web Brow.. % | @ More protection. Themo.. | @ Mozill FirefoxStartPage % | #

¢ [ search s © & a4 ® =

€) @ Voila Foundation U5 |
Nt

mozilla

More protection.
The most privacy.
Only from Firefox.

Try the new

010 2 @ % 4 @ Ol Kam, 28Jan 16, 07:44

vons (1 @ B [@ivore protection... ||
11.10 Tampilan awal Firefox Web Browser

Secara Untuk beranda Firefox di Asril OS ini secara default blank, kita dapat
merubahnya sendiri sesuai keinginan melalui Edit > Pengaturan. Untuk memudahkan
dalam membuka situs-situs yang sering kita kunjungi alangkah baiknya kita
memarkahnya. Kita bisa menambahkannya pada Menu Markah dengan cara membuka
situs yang akan kita markah, kemudian dari menu Markah > Markahi Laman ini. Jika
kita ingin menambahkan markah yang lain caranya adalah klik kanan pada baris
markah dan pilihlah Markah Baru.



Program Internet

-8
@ Mozilla FirefoxWeb Brow... x = @ More protection. Themo... % / @ Mozilla FirefoxStartPage  x |
Firefox | Search or enter address @ |[Q search %8 © & 4 © =
!
Q search
Need assistance with a feature in Firefox? Find answers to your
questions from our support team. Get help now.
¥ ® O A F* O &
Donnloads  Bookmarks  History Apps Add-ons sync Preferences
“® Menu 4 ™ G B [@Mozilla Firefox .. || 010 2 @ = v @ ()i Kam, 28Jan 16, 07:43

11.11 Firefox Web Browser

11.3 Xtreme Download Manager

Untuk keperluan Download Manager, Asril OS sudah menyertakan Download Manager yang
bernama Xtreme Download Manager (XDM). XDM ini sangat mirip dengan Internet Download
Manager yang ada di Windows, bagi yang sering menggunakan IDM, tidak akan kesulitan untuk
menggunakan XDM. Program ini dibuat oleh Subhro Dasgupta. Untuk membukanya klik Menu
Utama > Internet > XDM. Berikut tampilannya.

Active

Complete
Documenkt
Music
Video
Compressed

Application

+ Browser monitoring Queue and scheduler Help and support

11.13 Xtreme Download Manager

Pada bab Internet ini, kami belum menyertakan dokumentasi untuk semua program yang kami
sertakan.
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BAB 12 Program Utility

Asril OS sudah menyediakan beberapa program utility yang dapat anda gunakan seperti Program
GParted, MultiSystem, UNetbootin dan Pembuat Diska Pemulaian (Startup Disk Creator).

12.1 Gparted

GParted merupakan program editor partisi yang bisa digunakan untuk mengatur manajemen partisi
di harddisk anda. Dengan GParted anda dapat mengubah, mengcopy dan memindahkan partisi tanpa
kehilangan data anda. Untuk menggunakannya klik Menu Utama > Administrasi > Gparted,
masukkan password anda. Anda akan mendapatkan tampilan haeddisk anda beserta partisi yang ada
didalamnya.

/dev/sda - GParted - + x
GParted Sunting Tampilan Perangkat Partisi Bantuan
-EI -l 'mE - ] Efdevfsda (232.89 GiB}
I " E jdevisdas Jdev/sdag jdevjsda? Jdev/sdag
46.88 GIB 46.88 GiB 46.88 GiB 48.31 GiB
Partisi Sistem Berkas Titik Kait Ukuran Dipakai | Belu
Jdev/sdal 15 exta I 20.51 GIB  6.61 GiB
belum dialokasikan [ belum dialokasikan 1.23 MiB
- Jdewsda2 & extended 212.37 GiB
Jdev/sdad 1= I linux-swap 1.91 GiB
fdevfsdalo 15 M exta Jhome 21.52 Gi8  1.30 GiB
||
jdevisdas ntfs 46.88 GiB 33.88 GiB
jdevisdat = ntfs /mediajasrilmarhamah/0873C27910BF5674 46.88 GIB 35.31 GiB
jdevisda? ntfs 46.88 GIB  9.27 GiB
jdevisdag E] ntfs /mediajasrilmarhamah/41D15E71080395E8 48.31 GiB 41.86 GiB
S »
0 operasi akan diterapkan

12.1 GParted

12.2 Startup Disk Creator

Satu lagi program yang disertakan pada Asril OS yang dapat digunakan untuk membuat Live USB
yaitu Startup Disk Creator (Pembuat Diska Pemulaian). Program ini hanya mendukung Ubuntu dan
turunannya. Program ini sangat sederhana untuk digunakan. Untuk menggunakannya, klik Menu
Utama > Administasi > Startup Disk Creator. Berikut tampilan utamanya.
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Buat Disket Startup [

Untuk mencoba atau memasang Ubuntu dari diska lepas pasang, perangkat tersebut harus diatur
sebagai diska pemulaian.

Sumber cetakan cakram (.isc): atau CD:

Kandar-CDfCetakan Versi 05 Ukuran

Lainnya...

Diska untuk dipakai:
Perangkat Label Kapasitas  Ruang Kosong
Kingston DataTraveler G2 (/dev/sdcl) MULTISYSTEM 1.9 GB 706.6 MB

Hapus Isi Diska

Ketika menjalankan Ubuntu dari disk ini, maka dokumen dan pengaturan akan:

Disimpan dalam ruang tambahan
Berapa banyak: 0.0 MB

Dibuang saat shutdown, kecuali jika Anda menyimpannya di tempat lain

| Tutup | | Buat Disket Startup

12.2 Startup Disk Creator

Untuk memilih file ISO yang akan anda gunakan, jika belum ada klik [>Lainnya<] kemudian pilih
file ISO yang akan anda gunakan. Setelah terpilih, maka akan muncul informasinya di kotak dialog
diatas. Kemudian pilih FlashDisk anda yang akan digunakan sebagai Live USB, jika sudah selesai
semuanya klik [>Buat Disket Startup<]. Tunggu prosesnya sampai selesai, jika diminta password,
silahkan masukkan password anda.

12.3 apt-id

Apt-id bukanlah sebuah program yang berfungsi menggantikan peran apt-get, tetapi hanya sebuah
bash script yang mengatur penggunaan apt-get agar sesuai dengan kondisi komputer yang tidak
memiliki koneksi internet. Apt-id saya buat berdasarkan metode apt-get print-uris yang sudah lama
dikenal. Saya hanya menambahkan kemampuan untuk memfasilitasi update database APT (sudo
apt- get update) dan eksekusi otomatis untuk file-file hasil download.

Meskipun tujuan utamanya adalah untuk pengguna Ubuntu yang tidak memiliki koneksi internet,
apt- id juga dapat digunakan oleh pengguna Ubuntu yang memiliki koneksi internet. Terutama yang
koneksi internetnya masih terbatas. Apt-id dapat digunakan bergantian dengan metode online tanpa
menimbulkan masalah.

Untuk memahami cara kerja apt-id, kita perlu memahami dulu bagaimana cara apt-get bekerja.
Berikut ini adalah penggambaran cara kerja apt-get, di komputer yang memiliki koneksi internet.
Ketika kita memberikan perintah sudo apt-get install aplikasi_X, maka proses yang akan terjadi
adalah sebagai berikut :

1. Apt-get akan membaca database APT, lalu membuat daftar berisi paket-paket apa saja yang
diperlukan untuk menginstall aplikasi_X, serta di mana masing-masing file paket tersebut
(dalam bentuk file .deb) dapat di-download.

2. Apt-get akan men-download semua file .deb sesuai daftar yang telah dibuatnya.

3. Eksekusi — Apt-get akan menginstall semua file .deb tersebut untuk membentuk
aplikasi_X.

Bagaimana dengan perintah sudo apt-get update ? Sangat mirip, proses yang terjadi kurang lebih
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sebagai berikut :

1. Apt-get akan membaca daftar Software Sources, lalu membuat daftar berisi file-file apa saja
yang diperlukan untuk melakukan update APT, serta di mana masing-masing file tersebut
dapat di-download.

2. Apt-get akan men-download semua file sesuai daftar yang telah dibuatnya.
3. Eksekusi — Apt-get memproses semua file tersebut untuk memperbaharui database APT.

Untuk menggunakannya, anda dapat memanggil apt-id dari mana pun di terminal dengan cara
mengetikkan apt-id. Kami juga sudah menyertakan panduan apt-id yang dapat diakses dengan klik
Menu Utama > Panduan > Panduan apt-id

e

Berkas Sunting Tampilan Cari Terminal Bantuan
asrilmarhamah@PIC0-DJIH-Model apt-id

Selamat datang di apt-id. Apa yang ingin Anda lakukan?
membuat daftar download

eksekusi hasil download

about apt-id

keluar

Pilihan Anda :

12.3 apt-id

12.4 AllDeb

Alldeb adalah program shell script sederhana buatan Nifa Dwi Kurniawan dari Forum Ubuntu
Indonesia untuk membantu instalasi aplikasi Ubuntu tanpa koneksi internet langsung. Konsep
alldeb sama dengan exe di Windows atau dmg di Mac OS X. Konsep itu adalah single offline
installer. Pengguna cukup mengunduh 1 file untuk 1 aplikasi. Tidak dibutuhkan koneksi internet
langsung dari komputer pengguna untuk menginstal aplikasi. Dan instaler aplikasi bisa disimpan
untuk diinstal kembali kapan saja. Baik di komputer sendiri dan komputer orang lain.

Alldeb membuat sama pengalaman komputer Anda di Linux dengan di Windows. Instalasi aplikasi
di Ubuntu kini semudah di Windows.

Alldeb terbagi menjadi 2 bagian. Satu AllDeb Webmaker, dan satu AllDeb Manager. AllDeb
Webmaker ditujukan untuk membuat aplikasi alldeb. AllDeb Manager ditujukan untuk memasang
paket aplikasi yang telah dibuat. Jadi ada 2 aplikasi di sini, 1 aplikasi bertugas membuat paket-paket
yang dibutuhkan dan 1 aplikasi yang memasang dan memakai aplikasi.

12.4.1 Keuntungan AllDeb

Keuntungan menggunakan AllDeb yaitu :
1. Anda jadi lebih mudah menginstal aplikasi.

2. Anda tidak perlu menginstal aplikasi sembari memikirkan dependensi-
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dependensinya. Anda cukup mengunduh 1 paket untuk 1 aplikasi termasuk dengan
seluruh dependensinya. Manfaatnya adalah hemat waktu yang sangat banyak dan
hemat daya otak. Prinsip instalasi normal Ubuntu tidak bisa melakukan ini.

3. Anda bisa mengunduh paket alldeb di komputer lain tanpa requirement apa pun
dan menginstalnya di komputer Anda dengan sukes. Ini berkebalikan dari prinsip
instalasi aplikasi normal di Ubuntu, yang mempersulit hal ini. Kalaupun Ubuntu
bisa, itu pun harus dilakukan dengan requirement yang banyak macam dan
umumnya panjang-panjang. Anda bisa menyimpan instaler aplikasi (dalam hal ini
paket-paket alldeb) untuk digunakan ulang di masa depan. Hal ini menghemat
bandwidth internet karena Anda tidak usah mengunduh lagi aplikasinya jika Anda
instal ulang Ubuntu. Prinsip instalasi normal Ubuntu tidak bisa melakukan hal ini.

4. Anda bisa menginstal instaler yang telah disimpan pada Ubuntu di komputer lain.
Ini menghemat bandwidth internet berkali-kali lipat apalagi jika dibutuhkan pada
komputer kolektif (misalnya di lab sekolah dll.). Prinsip instalasi normal Ubuntu
tidak bisa melakukan hal ini.

5. Anda bisa membagikan instaler yang telah disimpan kepada orang lain. Ini sama
dengan kebiasaan Anda umumnya di Windows atau Mac OS X. Metode berbagi
pun tidak terbatas, bisa lewat internet, lewat CD, atau metode lainnya. Bahkan
Anda bisa menyertakannya dalam remasteran Anda. Prinsip instalasi normal
Ubuntu tidak bisa melakukan hal ini.

6. Anda bisa mengetahui dengan pasti berapa ukuran berkas suatu aplikasi dalam satu
kali lihat. Prinsip instalasi normal Ubuntu tidak bisa melakukan hal ini. Anda
hanya bisa melihat ukuran berkas satu per satu per paket, menjumlahkannya
sendiri satu per satu untuk keseluruhan dependensi untuk 1 aplikasi, dan yang
paling sulit menemukan seluruh dependensi lengkap untuk 1 aplikasi. Alldeb
menghemat waktu dan daya otak Anda dengan sangat baik.

7. Anda tetap bisa upgrade aplikasi yang diinstal dari paket alldeb secara normal di
Ubuntu. Tidak seperti instalasi dari kode sumber yang seringkalinya tidak
kompatibel dengan apt. Ini dikarenakan alldeb mempersatukan kecerdasan dpkg
dan apt dalam satu tempat, sehingga yang berubah hanya state instalasi (yakni
100% offline) sedangkan sifat-sifat dan kelebihan aslinya sama sekali tidak
dibuang. Salah satunya adalah upgradable.

8. Anda bisa mendirikan situs semacam Softpedia sendiri untuk Linux, karena
sekarang instalernya sudah single offline. Tidak seperti dulu lagi yang harus
resolve depencies.

12.4.2 AliIDeb Webmaker

Konsep kerja AllDeb Webmaker sebenarnya sangat sederhana. AllDeb Webmaker
bertugas mengumpulkan semua file .deb yang dibutuhkan untuk menginstall suatu
aplikasi menjadi satu, lalu mengemasnya menjadi sebuah file tunggal (file .alldeb).
Untuk menggunakannya, anda tinggal klik https://www.alldeb.net/ dan pilih Sistem
Operasi yang anda gunakan, kemudian carilah aplikasi yang ingin anda buat file
alldeb-nya.
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/ @ Alldeb Webmaker -
* » O | @ https://www.alldeb.net/webmaker/ %

Alldeb Webmaker

Sebuah at file alldeb

Panduan penggunaan | Log pembuatan | Tampilan klasik

12.4 AllDeb Webmaker

12.4.3 AlIDeb Manager

Konsep kerja AllDeb Manager juga sangat sederhana. AllDeb Manager akan
membuka file .alldeb, lalu membaca semua file .deb yang termuat di dalamnya.
Kemudian AllDeb Manager akan memeriksa apakah file-file tersebut telah cukup
untuk memenuhi dependensi yang diperlukan di komputer kita. Jika memenuhi, maka
installasi aplikasi dari file .alldeb tersebut dapat dilakukan. Untuk memudahkan
dalam penggunaanya, kami menyertakan versi GUI. Untuk membukanya klik Menu
Utama > Aksesoris > AllDeb Manager

- o

Silakan pilih file alldeb

File alldeb : || Browse... |

¥ tampilkan toaltip Apa yang ingin Anda lakukan?

¥ Install file alldeb

[ Ekstrak .deb ke fvar/cache/apt/archives

Keluar Install

== Anda bisa mendapatkan file alldeb aplikasi yang Anda inginkan di www.alldeb.net ==

12.5 AllDeb Manager

Kami juga sudah menyertakan buku panduan AllDeb yang dapat anda akses melalui
Menu Utama > Panduan > Panduan AllDeb
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BAB 13 Program Aksesoris

Bagi sebagian orang, memiliki komputer yang mempunyai semua program yang dibutuhkan dalam
kegiatannya setiap hari mungkin menjadi kebutuhan tersendiri. Misalnya saja, seorang siswa yang
memiliki kewajiban dalam mengerjakan tugas-tugas dari sekolah, akan sangat terbantu bila
memiliki kalkulator yang lengkap di dalam komputer atau laptopnya. Pada distro Asril OS, sudah
tersedia beberapa program aksesoris atau program tambahan yang sangat berguna dan siap dipakai
oleh pengguna, dalam subbab ini akan dibahas beberapa diantaranya.

13.1 Kalkulator

Seperti namanya, fungsi program ini untuk melakukan perhitungan dengan bantuan komputer.
Program ini dapat dijalankan melalui Menu Utama > Aksesoris > Calculator. Secara default,
program ini akan menampilkan kalkulator sederhana untuk melakukan perhitungan sederhana.
Untuk mengubahnya menjadi kalkulator yang lebih rumit, anda bisa pilih salah satu jenis kalkulator
pada menu “Mode”.

‘3

Edit Mode Help

A B N R N
A N I I RN A
L R B O AN

13. 1 Kalkulator

13.2 Tabel Karakter

Untuk membuat teks atau simbol yang tidak ada di papan ketik, akan lebih mudah menggunakan
program bantu yang bernama Tabel Karakter atau Character Map. Program yang juga memiliki
tampilan yang sederhana ini akan memiliki fungsi yang sangat penting sekali, jika kita memerlukan
untuk menulis karakter yang tidak terdapat dalam papan ketik. Program ini dapat ditemukan pada
Menu > Aksesoris > Character Map.
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File WView Search Go Help

I"Noto Sans

. oHE

- [soa | 1 | 10 [=]#

Character Table ||Character Detaits|

Script «
Brahmi U

Braille ~ A ~ ~ 5o A N

i

Buhid 1 ~ A4 ~ A D P o

Canadi...

S ~n A | AN Aa e) ~m | 00

Chakma

Text to copy: l | Copy |

U+1A00 BUGINESE LETTER KA

13.2 Tabel Karakter

Untuk menyalin simbol, Anda bisa klik ganda pada simbol yang ingin Anda salin, lalu klik tombol

[>Salin<].

Jika menggunakan program pengolah kata LibreOffice Writter, Anda cukup

menggunakan fitur karakter khusus melalui Menu Insert > Special Character.

13.3 Cuplikan Layar

Walaupun tidak sering, mungkin saja Anda membutuhkan tangkapan layar atau gambar dari
tampilan desktop yang sedang aktif. Dalam Asril OS menyediakan program bernama Screenshot,
program ini terdapat pada Menu> Aksesoris > Cuplikan Layar.

Efek

Ambil Cuplikan

. (& Cuplik seluruh layar

| | Sertakan penunjuk

Terapkan efek: | Nihil

Ambil Cuplikan scal

) Cuplik jendela yang aktif

1 Pilih wilayah tertentu

Ambil setelahtundaan [0 | — | + |

[#] Sertakan bingkai jendela

|

13.3 Cuplikan Layar
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Dengan menggunakan program yang satu ini, pekerjaan untuk mengambil gambar dari desktop
Anda sendiri dapat dilakukan dengan mudah, langkah-langkahnya adalah sebagai berikut:

v Pertama, siapkan terlebih dahulu desktop yang akan kita ambil gambarnya.
v Kemudian, buka program ini dan gambar pun siap untuk diambil.
Selain cara diatas, Anda juga bisa mengambil tangkapan layar dengan menekan tombol [>Prtscr<]

pada papan ketik, atau dengan ditambah tombol [>Fn<].
13.4 Penyunting Teks

Walaupun kelihatan sepele, program Teks Editor merupakan sesuatu yang tidak dapat dipisahkan
dari penggunaan sehari-hari. Asril OS menyediakan program Teks Editor bernama gedit. Program
ini berada di Menu > Aksesoris > Penyunting Teks.

. o3

Berkas Ubah Tampilan Cari Alat Dokumen Bantuan

Il Deuka ~ D;Simpanl & | mUnde ~ | Y 0 ﬂ | hd

|| untitled Document1 x |

Teks Polos *  LebarTab: 8 Baris 1, Kolom 1 SISIP

13.4 Penyunting Teks

Dengan menggunakan program ini kita dapat dengan mudah untuk membuat ataupun membaca
berkas teks yang diinginkan. Dengan kemampuan yang lebih tinggi, teks editor ini pun dapat
digunakan untuk menulis bahasa pemrograman karena penggunaan fitur penanda warna pada
sintaks kode yang membuat penulisan kode program menjadi lebih enak.

13.5 StarDict

Kamus merupakan salah satu kebutuhan utama di era yang serba global dewasa ini. Baik pihak
institusi, pengusaha, pekerja atau apapun profesi Anda, pasti membutuhkan program untuk
menerjemahkan bahasa asing ke Bahasa Indonesia atau sebaliknya. Untuk itulah Asril OS
dilengkapi dengan program kamus yang bernama StarDict dengan basis data kamus KBBI yang
terdiri dari :

1. Tesaurus Bahasa Indonesia Pusat Bahasa, 2. Kamus Besar Bahasa Indonesia, Edisi III,
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3. Bahasa Indonesia — Bahasa Inggris, 16. Bahasa Indonesia — Bahasa Malangan,

4. Bahasa Inggris — Bahasa Indonesia, 17. Bahasa Indonesia — Bahasa Minang,

5. Bahasa Indonesia — Bahasa Aceh, 18. Bahasa Indonesia — Bahasa Palembang,

6. Bahasa Indonesia — Bahasa Ambon, 19. Bahasa Indonesia — Bahasa Sasak,

7. Bahasa Indonesia — Bahasa Bali, 20. Bahasa Indonesia — Bahasa Simalungun,

8. Bahasa Indonesia — Bahasa Banjar, 21. Bahasa Indonesia — Bahasa Sunda,

9. Bahasa Indonesia — Bahasa Betawi, 22. Bahasa Indonesia — Bahasa Toba,

10. Bahasa Indonesia — Bahasa Bugis, 23. Loka Tarjamah Otomatis Indonésia-Sunda,
11. Bahasa Indonesia — Bahasa Gayo, 24. Loka Tarjamah Otomatis Sunda — Indonésia
12. Bahasa Indonesia — Bahasa Jambi, 25. Bahasa Denmark — Bahasa Indonesia

13. Bahasa Indonesia — Bahasa Jawa, 26. Bahasa Indonesia — Bahasa Denmark

14. Bahasa Indonesia — Bahasa Madura, 27. Bahasa Swedia — Bahasa Indonesia

15. Bahasa Indonesia — Bahasa Makassar, 28. Bahasa Indonesia — Bahasa Swedia

Database kosa kata yang tersedia untuk Bahasa Indonesia ke Bahasa Daerah masih terbatas, tidak
semua tersedia. Untuk itu gunakanlah dengan baik dan cermat. Selamat belajar Berbahasa. Untuk
menggunakannya klik Menu Utama > Aksesoris > StarDict.

StarDict = + %
Bersihkan | makan L‘ Q o~ -
& | makan e @O o oz 2 qQ
= || makan alami Y
— | makan ampun <-— malangan —> 3
makan anak makan
nakam
#3 |makan anak ayam <-- makassar >
makan angin makan
makan arwah Nganre
<-- minang —>
makan asam garam makan
makan ayapan makan
makan babi < befawi —=>
makan
makan bawang makan, madang
makan bebas < bugis —>
makan beku makan
manre
makan benak | <= jambi —>
makan berpantang makan
makan bersabitkan makan
<—sunda >
makan berserat makan
makan berulam lebok, nyatu, dahar, tuang
makan besar <-- Kamus Bahasa Aceh (Versi Beta) >
4 makan
makan buatan .
s pajéh
makan bubur panas-panas v
E sean i B i IET I = I
13.5 StarDict

13.6 Keyboard Virtual

Keyboard Virtual merupakan program bantu yang dapat kita gunakan untuk mengetik dengan
bantuan Keyboard Virtual. Ini dapat kita gunakan sebagai alternatif kalau sewaktu-waktu Keyboard
komputer kita mengalami masalah. Dengan adanya Program Keyboard Virtual ini kita dapat
menggunakan Keyboard dengan mouse kita. Untuk menggunakannya klik Menu Utama > Aksesoris
> Keyboard Virtual. Berikut tampilan dari program Keyboard Virtual tersebut.
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13.6 Keyboard Virtual

13.7 Penampil Dokumen

Buku elektronik atau e-book merupakan format distribusi buku yang sangat umum saat ini. Buku-
buku atau majalah luar negeri banyak mendistribusikan buku jenis ini selain juga mengedarkan
edisi cetaknya. Harga dari buku elektronik jelas lebih murah daripada buku cetak karena tidak
memerlukan kertas. Hampir semua buku elektronik di distribusikan dalam bentuk format PDF yang
merupakan format dari perusahaan Adobe, inc. Untuk membuka format ini di distro Asril OS, Anda
bisa menggunakan program bernama Penampil Dokumen. Klik ganda pada berkas PDF yang ingin
Anda buka pada peramban berkas, maka program penampil Dokumen akan membukakannya untuk
Anda.

o
File Edit View Go Bookmarks Help
+ ¥ ZIDHQ ‘ t‘-b &J [73,71% ¥ |

Index - x 1.3 Apa itu Asril 0S?
= Asril 05 merupakan Distro Linux Lokal Indonesia yang betisikan perangkat lunak (software) yang

COVER 1 dapat digunakan untuk keperluan desktop, laptop dan notebook. Asril OS dilengkapi dengan
KATA PENGANTAR 2 ':):‘;‘j:nng(:::aw'mk-pcmlk khas Indonesia, distro ini cocok digunakan untuk pengguna komputer di
DAFTARISI ) Asril 05 dikembangkan oleh Asril Marhamah bersama Tim Pengembang Asril OS. Asril OS bisa
didapatkan oleh siapa saja tanpa perlu untuk d . Penge igan Asril OS
~ PENDAHULUAN 5 dimaksudkan sebagai distribusi alternatif dalam menggunakan perangkat lunak yang bebas dan
A 28 perangl yang,
0.1 Thwal BukuIni 6 legal. Asril OS menawarkan lingkungan kerja dengan Desktop Cinnamon yang mudah dalam
penggunaan yang dilenglapi dengan Program Office, Desain Grafis, Mulimedia, Pendidilan,
0.2 Penulis Lanj... 6 Islami, Internet dan lain-lain.
C=lkens g 1.4 Asal nama Asril 0S
0.4 Merek Dag... 6 Astil OS, kalau dibaca bersambung menjadi astilos. Frase asrilos terdiri dari dua kata yakni asri dan []
~ BAB 1 Apa itu L 2 los. Menumt Kamus Besar Bahasa Indonesia Asri yang berarti Indah dan los berarti bebas, lepas
DaRR S Maka digunakanlah semboyan "Indah, bebas, lepas” untuk distro yang sederhana ini. Asril OS bisa
1.1 Apaitulinn? 8 juga diartikan sebagai Distro Linux yang dikembangkan oleh Asril Marhamah, sekaligus
memberikan identitas pada yang membuat distro linux ini,
1.2 Kelebihanli.. &
1.5 Fitur Asril OS
Astil 05 secara bawaan sudah terpasang banyak sekali program yang siap pakai untuk keperluan
14 Asalnama.. 9
L5 Fitur Astil oS 9 1

1.6 Info Lebih L.. 10
w BAB 2 Memasang... 12
2.1 Kebutuhan ... 12
2.2 Cara Mend... 12

13.7 Penampil Dokumen

Untuk mempermudah navigasi antar halaman, Anda bisa memanfaatkan side pane
yang tersedia di sebelah kiri jendela Penampil Dokumen. Anda juga bisa
memanfaatkan tombol arah atau tombol Page Up/Down. Untuk memperbesar ukuran
halaman dengan memanfaatkan fitur zooming dengan memilih ukuran zoom yang
diinginkan pada opsi yang terdapat di bagian kanan toolbar. Agar lebih enak dibaca,
Anda bisa membuka halaman dengan layar penuh melalui menu Tampilan > Layar
Penuh atau Anda bisa tekan tombol F11 pada papan ketik, sebagai tambahan anda
juga dapat menampilkan halaman buku elektronik dengan gaya presentasi yaitu
melalui menu Tampilan > Presentasi atau menekan tombol F5 pada papan ketik.
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BAB 14 Pengenalan Antarmuka Teks

Antarmuka dasar untuk pengoperasian sistem operasi Linux sebenarnya adalah antarmuka berbasis
teks, atau sering disebut Command Line. Antarmuka grafis atau desktop yang ada di dalam Linux
sebenarnya hanyalah alat bantu untuk pengoperasian bagi mereka yang sudah biasa bekerja dengan
Graphical User Interface (GUI) yang terdapat di beberapa sistem operasi modern. Ini mirip dengan
piranti lunak Microsoft Windows sebelum versi 95 yang hanya merupakan alat bantu pengoprasian
berbasis grafis untuk DOS.

Untuk memberikan suatu perintah pada antarmuka teks, para pengguna harus mengetik nama
perintah yang akan dijalankan beserta opsi-opsi/parameter-nya, kemudian menekan tombol Enter
untuk mengeksekusi perintah tersebut. Tidak seperti antarmuka grafis, penggunaan mouse secara
umum tidak diperlukan karena semua kontrol hanya dilakukan melalui papan ketik.

Tidak benar jika penggunaan antarmuka teks tidak bisa melakukan produktivitas. Anda masih bisa
berproduktivitas dengan berbagai aplikasi berbasis teks yang tersedia dan siap Anda gunakan.
Bahkan untuk para administrator, penggunaan antarmuka teks sangat disarankan ketimbang
antarmuka grafis karena memakan sumberdaya CPU dan RAM yang lebih kecil, sehingga tidak
menganggu kinerja komputer pada saat melakukan suatu tugas administrasi.

Pada bab ini, dijelaskan mengenai dasar pengoprasian antarmuka teks yang ada pada Asril OS.
Sasaran pembaca tidak hanya bagi Anda yang power user, melainkan juga para pemula/newbie yang
ingin mempelajari Linux lebih lanjut.

14.1 Membuka Antarmuka Teks

Ada dua jenis antarmuka teks yang bisa Anda buka, yaitu terminal dan virtual console. Terminal
merupakan antarmuka teks yang berjalan di dalam desktop dan berupa jendela aplikasi, sedangkan
virtual console merupakan antarmuka teks yang berjalan secara mandiri di luar desktop.

14.1.1 Membuka Terminal

Untuk membuka terminal, klik Menu Utama > Aksesoris > Terminal atau melalui menu
Laucher bar dengan klik icon Terminal, kemudian jendela terminal akan muncul di dalam
desktop.

Terminal -+ x

asrilmarhamah@PICO-DIH-Model

14.1 Terminal
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Untuk menampilkan baris menu, klik kanan > Tampilkan Baris Menu. Jika Anda ingin
membuka sesi kerja yang baru, Anda bisa membuat tab baru seperti layaknya fitur tabbed
browsing pada peramban web melalaui menu Berkas > Buka Tab atau dengan klik kanan
> Buka Tab, atau Anda bisa tekan tombol Shift+Ctrl+T pada keyboard.

Anda bisa mengkostumisasi penampilan terminal sesuai dengan keinginan Anda melalui
jendela pengaturan yang bisa Anda buka melalui menu Sunting > Preferensi Profil atau
klik kanan > Profil. Jika ingin membuat terminal dalam mode layar penuh, Anda bisa klik
menu Tampilan > Layar Penuh atau Anda bisa tekan tombol F11 pada keyboard.

14.1.2 Membuka Virtual Console

Linux telah menyediakan enam sesi antarmuka teks yang bisa Anda buka dengan cara
menekan tombol Ctrl+Alt+F1, Ctrl+Alt+F2 sampai Ctrl+Alt+F6. Berbeda dengan
menggunakan terminal, Anda harus melakukan login terlebih dahulu sebelum bekerja
dengan antarmuka teks. Ketik id pengguna kemudian tekan enter lalu masukkan sandi
(password tidak akan ditampilkan pada layar) Anda dan tekan enter sekali lagi. Berbeda
dengan terminal, Anda tidak bisa melakukan kustomisasi penampilan agar lebih menarik.
Bekerja disini layaknya bekerja dengan sistem operasi DOS (Disk Operating Systems).
Untuk kembali ke desktop, Anda bisa tekan tombol Ctrl+Alt+F8 sampai Ctrl+Alt+F12.
Bergantung dari sesi desktop yang digunakan (Secara default menggunakan Ctrl+Alt+F8
jika Anda tidak memanfaatkan fitur pindah pengguna untuk mengaktifkan lebih dari satu
sesi desktop).

14.2 Pengenalan Antarmuka Teks

Setelah Anda membuka terminal atau login di dalam virtual console, Anda akan diminta untuk
memasukkan perintah yang ingin Anda jalankan. Tempat Anda mengetik berada pada
kursor/penanda yang berkedip-kedip. Pada bagian kiri kursor tersebut, Anda akan melihat teks
seperti berikut :

Terminal

asrilmarhamah@PIC0-DJH-Model

14.2 Bagian-Bagian Terminal

v Teks tersebut memiliki berbagai informasi sebagai berikut :

v Teks “asrilmarhamah” sebelum tanda at (@) merupakan nama id pengguna yang login
menggunakan antarmuka teks,

v Teks “PICO-DJH-Model” setelah tanda at (@) merupakan nama komputer yang digunakan
pada saat bekerja,

v Teks “~” setelah nama komputer menunjukan folder yang saat ini dibuka. Folder “~” berarti
sedang membuka folder rumah/home.

v Tanda “$” pada bagian akhir menunjukkan Anda bekerja di level pengguna biasa. Jika Anda
bekerja dalam mode administratif, maka tandanya akan berubah menjadi “#”.

Untuk menjalankan suatu perintah, Anda bisa ketik perintah tersebut lalu menekan tombol enter.
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Sebagai contoh, untuk menampilkan isi suatu folder/direktori, Anda bisa ketik perintah “Is” lalu
tekan tombol Enter, maka Anda akan melihat antarmuka teks seperti berikut :

Terminal - +
Berkas Sunting Tampilan Cari Terminal Bantuan
asrilmarhamah@PIC0-DIH-Model 1s N
20110112 modul-remastering-ubuntu-mode-grafis-uck.pdf
C-9 REMASTERING DISTRO UBUNTU UNTUK MENUNJANG PEMBELAJARAN INFORMATIKA.pdf
Cara Remastering Ubuntu dengan Metode Remastersys.pdf

Lowongan Kerja.pdf

remastering ubuntu via remastersys.pdf
sites.conf

asrilmarhamah@PIC0-DJH-Model

14.3 Hasil Perintah Is

Untuk menjalankan perintah yang bersifat administratif, Anda bisa mengetik perintah “sudo”
sebelum perintah yang ingin Anda jalankan. Anda harus memiliki wewenang untuk menggunakan
sudo agar perintah bisa berjalan. Misalnya, jika ingin menghapus berkas “nasi.txt” pada folder /opt
(Dalam hal ini, Anda tidak memiliki hak untuk mengelola folder /opt), Anda bisa ketik perintah
“sudo rm /opt/nasi.txt”.

Terminal - 4+ ¥
asrilmarhamah@PICO-DJIH-Model sudo rm /opt/barongko.txt
[sudo] password for asrilmarhamah:

asrilmarhamah@PIC0-DJIH-Model

14.4 Penggunaan Perintah sudo

Note : Walaupun menyediakan id pengguna khusus untuk menjalankan perintah bersifat
administratif (yaitu root), secara default Anda tidak bisa menggunakannya untuk login. Anda bisa
login ke root dengan cara mengetik perintah “sudo su -”.

Terminal - + x
asrilmarhamah@PICO-DJIH-Model sudo su -
[sudo] password for asrilmarhamah:

14.5 Perintah sudo su -
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14.3 Perintah-perintah dalam Antarmuka Teks

Berikut adalah berbagai penjelasan dari perintah-perintah dalam pengelolaan berkas secara
sederhana menggunakan antarmuka teks.

14.3.1 Berpindah Folder/Direktori (cd)

Untuk berpindah dari satu folder ke folder lainnya, Anda bisa ketik perintah “cd” dan
diikuti dengan alamat folder yang dibuka (dipisah dengan spasi). Sebagai contoh, jika
ingin membuka folder Dokumen yang ada di dalam folder home, Anda bisa ketik “cd
~/Dokumen”. Jika Anda berada di dalam folder home, Anda cukup ketik “cd Dokumen”
saja.

Terminal .

asrilmarhamah@PICO-DJIH-Model cd Dokumen
asrilmarhamah@PICO-DJIH-Model l

14.6 Perintah cd

Jika ingin berpindah ke folder yang ada di level lebih atas, ketik perintah “cd ..”.

Terminal - + ®
asrilmarhamah@PIC0-DJH-Model cd Dokumen
asrilmarhamah@PIC0-DJH-Model cd s

14.7 Perintah cd ..

14.3.2 Melihat Isi Folder/Direktori (Is)

Untuk melihat isi dari suatu folder/direktory Anda saat ini, Anda cukup ketik opsi “Is”.

Terminal - + %=
asrilmarhamah@PICO-DJH-Model 1s
18. BAB VII PROMOSI WEBSITE.pdf 4. BAB I MENGEMAL WEBSITE.pdf
11. Daftar Website Rujukan.pdf 5. BAB II MENGENAL www.yola.com.pdf
12. Tentang Penulis.pdf 6. BAB IIT MEMBUAT WEBSITE DI www.yola.com.pdf
13. SINOPSIS.pdf 7. BAB IV FITUR www.yola.com.pdf

1. JUDUL.pdf . BAB V OPTIMALISASI FITUR www.yola.com.pdf
2. Pengantar Penulis.pdf 9. BAB VI PERNAK-PERNIK TAMBAHAN.pdf

3. Daftar Isi.pdf

asrilmarhamah@PICO-DJIH-Model |

14.8 Perintah Is

Anda juga bisa membuka isi folder lain selain folder saat ini dengan menambahkan
lokasi folder setelah perintah Is dengan dipisah spasi. Misalnya, ketik perintah “Is /usr”
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untuk menampilkan isi folder /usr.

Terminal T
asrilmarhamah@PICO-DJH-Model 15 /usr i

asrilmarhamah@PICO-DJH-Model [

14.9 Perintah Is /usr

Untuk informasi berkas/folder di dalam folder, Anda bisa menambahkan opsi “ -1” pada
perintah “Is” yang Anda jalankan.

Terminal ——
asrilmarhamah@PICO-DIH-Model 1s /fusr

root root 65536 Jan
root root 4096 Des
root root 46396 Des
root root 36864 Jan
root root 4896 Nov .
root root 12288 Des 26 -
47 root root 12288 Jan
root root 4896 Nov :
1C0-DIH-Model |

14.10 Perintah Is /usr -1

14.3.3 Membuka Berkas

Untuk membuka suatu berkas menggunakan suatu aplikasi, Anda bisa mengetik perintah
untuk menjalankan aplikasi kemudian diikuti dengana nama atau path dari berkas yang
ingin dibuka. Misalnya, jika ingin membuka berkas “Desain-Grafis.odt” pada folder
“Dokumen” dengan LibreOffice.org, Anda bisa ketik perintah “soffice Dokumen/Desain-
Grafis.odt”.

Terminal ——
asrilmarhamah@PICO-DJH-Model soffice Dokumen/Desain-Grafis.odt i
@PICO-DIH-Model |

14.11 Membuka Berkas

Sebagai catatan, jika Anda ingin membuka file dengan mode Terminal, pastikan nama
file tersebut tidak menggunakan karakter spasi dalam nama filenya, karena mode
Terminal tidak bisa membaca nama file yang mengandung karakter spasi, akan muncul
pesan file tidak ditemukan.

14.3.4 Membuat Direktori (mkdir)

Untuk membuat direktori / folder, Anda bisa menggunakan perintah “mkdir namafolder”
atau “mkdir path-folder”. Maka akan dibuat folder baru yang berada di bawah folder
Anda saat ini.
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Terminal - + x
asrilmarhamah@ mkdir Belajar
asrilmarh : cd Belajar

asrilmarhamah@PIC0-DJH-Model

14.12 Membuat Direktori

14.3.5 Menghapus Direktori (rmdir)

Untuk menghapus suatu direktory/folder, Anda bisa gunakan perintah “rmdir
namafolder” atau “rmdir path-folder”. Syaratnya, folder tersebut harus kosong tanpa
berisi berkas atau subfolder apapun.

Terminal - + x
asrilmarhar IC0-DJH-Model rmdir Belajar
asrilmarhar IC0-DJH-Model cd Belajar
bash: cd: Belajar: Tidak ada berkas atau direktori seperti itu

asrilmarhamah@PIC0-DJIH-Model

14.13 Menghapus Direktori

14.3.6 Menghapus Berkas (rm)

Untuk menghapus suatu berkas, gunakan perintah “rm” lalu diikuti dengan nama berkas
atau dilengkapi dengan path (alamat lengkapnya) jika diperlukan.

Sebagai contoh, anda ingin menghapus file barongko.txt yang ada di dalam folder
Dokumen, gunakan perintah rm Dokumen/barongko.txt

Terminal - 4+ ®
rm Dokumen/barongko. txt

14.14 Menghapus File

Jika ingin menghapus suatu isi folder sampai isinya secara rekursif, Anda juga bisa
gunakan perintah ini dengan menambahkan opsi “-R”. Sekali lagi, hati-hati dalam
menggunakan perintah ini.

Terminal - + =

14.15 Menghapus Folder
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14.3.7 Menggandakan Berkas (cp)

Untuk menggandakan berkas, gunakan perintah cp dengan format “cp berkas-sumber
folder-tujuan”. Seperti semua perintah di atas, Anda juga bisa menyebutkan path penuh
dari berkas-sumber atau folder-tujuan jika diperlukan. Contohnya, jika ingin
menggandakan berkas Desain-Grafis.odt yang ada di folder Dokumen ke dalam folder
Buras yang berada dalam folder Dokumen juga, gunakan perintah “cp Dokumen/Desain-
Grafis.odt Dokumen/Buras”.

Terminal . O
cp Dokumen/Desain-Grafis.odt Dokumen/Buras
cd Dokumen/Buras

1s

asrilmarhamah@PICO-DJH-Model l

14.16 Menggandakan Berkas

Sama dengan perintah rm, Anda bisa manfaatkan opsi “-R” jika ingin menggandakan
suatu folder secara rekursif. Sebagai contoh, anda ingin menggandakan folder Buras
yang ada didalam folder Dokumen ke folder Barobbo yang ada di folder Dokumen juga
maka gunakan “cp -R Dokumen/Buras Dokumen/Barobbo”.

Terminal e
: cp -R Dokumen/Buras Dokumen/Barobbo
cd Dokumen/Barobbo
1s

asrilmarhamah@PICO-DJIH-Model

14.17 Menggandakan Folder

14.3.8 Memindahkan Berkas/Folder (mv)

Untuk memindahkan berkas/folder, Anda bisa gunakan perintah “mv”. Penggunaanya
mirip dengan perintah “cp”. Hanya saja, jika memindahkan suatu folder, Anda tidak
perlu menggunakan opsi recursif “-R”. Contohnya, jika ingin memindahkan file
Barongko.txt yang berada di folder Dokumen ke dalam folder Buras yang ada di Folder
Dokumen juga, ketik perintah “mv Dokumen/Barongko.txt Dokumen/Buras”.

Terminal - 4+ x
mv Dokumen/Barongko.txt Dokumen/Buras
cd Dokumen/Buras
1s

odt

14.18 Memindahkan Berkas / Folder
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14.3.9 Mengubah Nama Berkas/Folder (mv)

Perintah yang digunakan untuk mengubah nama berkas sama dengan perintah untuk
memindahkan berkas/folder yaitu “mv”. Cara penggunaannya pun sama. Contoh, untuk
mengubah nama berkas Barongko.txt yang ada di folder Dokumen menjadi
Lemmang.txt, ketik perintah “mv Dokumen/Barongko.txt Dokumen/Lemmang.txt”.

Terminal - + x
mv Dokumen/Barongko.txt Dokumen/Lemmang.txt
cd Dokumen
1s
Desain-Grafis.odt Presentationl.dps

Contoh Desain Grafis.pdf Lemmang. txt
Daftar Program Asril 0S 2.8.odt 1lirik lagu.odt
asrilmarhamah@PICO-DJH-Model

14.19 Mengubah Nama Berkas

14.3.10 Mengubah Hak Akses Berkas/Folder (chmod)

Untuk mengubah hak akses berkas/folder, Anda bisa gunakan perintah chmod dengan
format “chmod hakakses berkas/folder”. Hak akses diisi dengan tiga angka oktal. Angka
ke-1 merupakan hak untuk pemilik, angka ke-2 merupakan hak untuk grup dan angka ke-
3 merupakan hak untuk selain pemilik dan grup. Masing-masing bagian diisi dengan
angka basis 8, dimana hak baca bernilai 4, hak tulis bernilai 2, hak eksekusi bernilai 1.

Sebagai contoh, untuk mengubah berkas “Barongko.txt” yang ada di folder Dokumen
agar hak baca,tulis dan eksekusi untuk pemilik, sedangkan yang lain hanya memiliki hak
baca dan eksekusi, Anda bisa ketik perintah “chmod 755 Dokumen/Barongko.txt”.

Terminal - + =

dPICO0-DJH-Model chmod 755 Dokumen/Barongko.txt
@PICO-DJH-Model

14.20 Mengubah Hak Akses Berkas

Untuk memberikan suatu hak akses secara rekursif pada suatu folder, Anda bisa
menambahkan opsi “-R”. Misalnya, jika ingin memberikan hak mutlak (hak
baca,tulis,eksekusi untuk semua aspek) pada folder Buras yang ada di folder Dokumen,
Anda bisa ketik perintah “chmod 777 -R Dokumen/Buras”.

Terminal - + =

asrilmarhamah@PICO-DJIH-Model chmod 777 -R Dokumen/Buras
amah@PICO-DIH-Model

14.21 Mengubah Hak Akses Folder
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Untuk menampilkan hak akses suatu berkas/folder, Anda bisa manfaatkan perintah “Is -
1”. Kemudian, Anda akan melihat seperti karakter yang dicetak tebal yang merupakan
hak akses dari berkas tersebut. Keenam karakter itu dibagi menjadi tiga, bagian pertama
merupakan hak akses pemilik, bagian kedua merupakan hak akses grup dan bagian
terakhir merupakan hak akses selain pemilik dan grup.

Terminal E——
@PICO-DJIH-Model cd Dokumen
@PICO-DJIH-Model 1s -1

X 3
1
X2
1
1
1
1
1
1

T R g

asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah

asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah
asrilmarhamah

4096

0]

4096
1799853
17377
2714854
158328
0]

21676

S e
235528

2 Barongko. txt

Contoh Desain Grafis.pdf
Daftar Program Asril 0S 2.8.odt
f Desain-Grafis.odt

2 Lemmang.txt
6 lirik lagu.odt

Presentationl.dps
-r--r-- 1 asrilmarhamah asrilmarhamah 212086

asrilmarhamah@PIC0-DJH-Model

14.22 Hak Akses Folder / Berkas

Keterangan : r : Hak Baca, w : Hak tulis, x : Hak eksekusi

14.3.11 Mengubah ID Pemilik / Grup pada Berkas/Folder (chown)

Untuk mengubah id pemilik atau grup pada berkas/folder, gunakan perintah chown
dengan format “chown id-pemilik namaberkas” jika ingin mengubah id pemilik
berkas/folder, “chown :grup namaberkas” untuk mengganti grup berkas dan “chown id-
pemilik:grup nama berkas” jika ingin mengubah id pemilik dan nama grup pada suatu
berkas sekaligus. Ingat, yang hanya bisa mengubah pemilik berkas hanyalah pengguna
administratif, sedangkan grup hanya bisa diubah oleh pemilik berkas.

Contohnya, jika ingin mengubah grup berkas menjadi “adm” pada berkas nasi.txt, Anda
bisa ketik perintah “chown :adm Dokumen/Barongko.txt”.

Terminal i
asrilmarhamah@PICO-DJIH-Model
asrilmarhama ICO-DIH-Model

chown :adm Dokumen/Barongko.txt

14.23 Mengubah Grup Berkas / Folder

Untuk mengetahui id pemilik dan grup dari suatu berkas/folder, Anda bisa manfaatkan
perintah “Is -1”. Kolom kedua dari setiap informasi berkas merupakan id pemilik berkas,
sedangkan kolom selanjutnya merupakan grup/kelompok pemilik berkas.
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cd Dokumen
s -1

asrilmarhamah asrilmarhamah 5

asrilmarhamah adm A Ja ® 21:32 Barongko.txt

asrilmarhamah asrilmarhamah 46896 i

asrilmarhamah asrilmarhamah 1799853 Ja 22:00 Contoh Desain Grafis.pdf

asrilmarhamah asrilmarhamah 17377 Ja 9§ ©8:03 Daftar Program Asril 05 2.8.odt

asrilmarhamah asrilmarhamah 2714854 Ja 22:00 Desain-Grafis.odt

asrilmarhamah asrilmarhamah 158328 :

asrilmarhamah asrilmarhamah 6] B 21:32 Lemmang.txt

asrilmarhamah asrilmarhamah 21676 ; :26 lirik lagu.odt

asrilmarhamah asrilmarhamah 235520 22 81:13 Presentationl.dps
rilmarhamah asrilmarhamah 212086

@PICO-DJIH-Model

1
X 2
1
1
1
i
1
1
1
i
ama

14.24 ID Pemilik Berkas / Folder

Keterangan : teks "asrilmarhamah" di sebelah kiri adalah id pengguna pemilik berkas,
sedangkan yang disebelah kanan merupakan id grup/kelompok pemilik berkas.

14.3.12 Membuat Berkas Tar (tar)

Tar merupakan program yang berfungsi untuk menyatakan beberapa berkas/folder ke
dalam satu berkas yang disebut dengan tarfile/tarball. Sangat berguna sekali untuk
melakukan backup.

Untuk membuat berkas tar, selain melalui aplikasi pengelola arsip pada desktop, Anda
juga bisa gunakan perintah tar dengan format “tar -cvf berkas.tar namaberkas/folder1l
namaberkas/folder2.....”. Anda juga bisa gunakan opsi “-v” agar menampilkan informasi
detail dari proses tar.

Terminal - 4+ =
asrilmarhamah@PICO-DJIH-Model tar -cvf Buras.tar Dokumen/Buras
Dokumen/Buras;

Dokumen/Buras/Barongko. txt
Dokumen/Bur esain-Grafis.odt
asrilmarhamah@PIC0-DJIH-Model

14.25 Membuat Berkas tar

Sedangkan untuk mengekstrak atau mengeluarkan isi suatu tarfile, Anda bisa gunakan
perintah dengan format “tar -xf berkas.tar folder-tujuan”.

Terminal - + ®
tar -xf Buras.tar Dokumen
cd Dokumen
= 1s
Daftar Program Asril 0S 2.@.odt 1lirik lagu.odt
Barongko. txt Desain-Grafis.odt Presentationl.dps

Contoh Des rafis.pdf Lemmang.txt
asrilmarhamah@PICO-DJH-Model

14.26 Mengekstrak Berkas tar
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14.3.13 Kompresi Gzip (gzip)

Gzip atau GNU Zip merupakan format arsip terkompresi dengan algoritma Lempel-Ziv
(LZ77). Untuk melakukan kompresi suatu berkas dengan format Gzip, gunakan perintah
“gzip namaberkas”. Ekstensi berkas hasil kompresi adalah *.gz. Sebaliknya, untuk
melakukan decompress, gunakan perintah “gunzip namaberkas”.

Terminal - + x
asrilmarhamah@PICO-DJH-Model gzip Dokumen/Barongko.txt i
asrilmarhamah@PICO-DJIH-M cd Dokumen
asrilmarhamah@PIC0-DJH-Model 1s
Daftar Program Asril 0S5 2.0.odt 1lirik lagu.odt
Barongko.txt.gz Desain-Grafis.odt Presentationl.dps

Contoh Desain Grafis.pdf Lemmang.txt
asrilmarhamah@PICO-DJH-M gunzip Barongko.txt.gz

asrilmarhamah@PICO-DJIH-M 1s
Daftar Program Asril 0S5 2.08.odt lirik lagu.odt
Barongko.txt Desain-Grafis.odt Presentationl.dps

Contoh Desain Grafis.pdf Lemmang.txt
asrilmarhamah@PICO-DJIH-Model

14.27 Kompresi Gzip

14.3.14 Kompresi Bzip2 (bzip2)

Bzip2 atau GNU Bzip2 merupakan format kompresi arsip dengan algoritma Burrows-
Wheller block sorting text compression. Untuk melakukan kompresi suatu berkas dengan
format bzip2, gunakan perintah “bzip2 namaberkas”. Ekstensi berkas hasil kompresi
adalah *.bz2. Sedangkan untuk melakukan decompress, gunakan perintah “bunzip2
namaberkas”.

Terminal - + %
bzip2 Dokumen/Barongko.txt i
cd Dokumen
odel 1s
Daftar Program Asril 05 2.0.odt 1lirik lagu.odt
Desain-Grafis.odt Presentationl.dps

Contoh Desain Grafis.pdf Lemmang.txt
asrilmarham N bunzip2 Barongko.txt.bz2
asrilmarhamah@PICO-DJIH-Model 1s

Daftar Program Asril 05 2.0.odt lirik lagu.odt
Barongko.txt Desain-Grafis.odt Presentationl.dps

Contoh Desain Grafis.pdf Lemmang.txt
asrilmarhamah@PIC0O-DJIH-Model

14.28 Kompresi Bzip2

INFO : Baik format gzip maupun bzip2 “hanya” melakukan kompresi terhadap sebuah
berkas. Jika ingin mengkompresi banyak berkas di dalam sebuah berkas, Anda harus
menggunakan perpaduan antara perintah tar dengan perintah gzip maupun bzip2. Anda
bisa menambahkan opsi “-z” pada perintah tar untuk membuat/mengextract tarball
dengan format kompresi GZIP. Sedangkan untuk membuatnya dengan format BZIP2,
gunakan opsi “-j” pada perintah tar.
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14.3.15 Pencarian Berkas (find)

Untuk mencari berkas, gunakan perintah find dengan opsi “find folder -name
“namaberkas”. Contohnya, jika Anda ingin mencari berkas bernama “Barongko.txt” di
dalam folder Dokumen, ketik perintah “find Dokumen -name “Barongko.txt”. Maka
akan muncul path/lokasi dari berkas/folder yang bernama Barongko.txt.

Terminal - + =
asrilmarhamah@PIC0-DJH-Model find Dokumen -name "Barongko.txt"
Dokumen/Buras/Barongko. txt
Dokumen/Barongko. txt

asrilmarhamah@PIC0-DJH-Model [

14.29 Mencari Berkas

TIP : Jika Anda ingin menulis nama berkas/folder lebih cepat, Anda bisa terlebih dahulu
mengetik satu/beberapa huruf awal dari nama berkas/folder tersebut, kemudian menekan
tombol Tab pada keyboard. Contohnya, jika ingin mengetik nama folder “Barobbo” lebih
cepat, Anda bisa ketik “B” saja atau “Ba”, kemudian menekan tombol Tab. Secara
otomatis, nama berkas akan dilengkapi.

TIP : Jika ingin menyebutkan banyak nama berkas/folder yang memiliki huruf awal sama
(misalnya, “Barongko.txt”, “Buras.txt”, “Bandang.txt”, “Bella.txt”) Anda cukup ketik
“B*” (B disertai tanda bintang “*”). Jika ingin menyebutkan huruf belakangnya
(misalnya ingin menyebutkan ekstensi berkas txt), Anda bisa ketik “*.txt”.

Sebenarnya, masih banyak lagi perintah-perintah untuk antarmuka teks yang bisa
Anda gunakan untuk bekerja. Untuk melakukan otomatisasi kerja, Anda juga bisa
membuat skrip yang disebut dengan shell script. Otomatisasi pekerjaan sangat
penting bagi administrator untuk memperingan dan mempercepat pekerjaannya
dalam jaringan. Untuk mempelajari shell script lebih lanjut, Anda bisa membaca
buku tentang Bash Scripting atau mencari referensi melalui internet.
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BAB 15 Pengaturan Perangkat Keras

Pengaturan perangkat keras yang terpasang di komputer menggunakan Asril OS sangat mudah
sekali. Anda hampir tidak perlu melakukan pemasangan driver perangkat keras, karena Asril OS
sudah menyediakan hampir semua driver perangkat keras esensial yang ada saat ini. Sehingga,
setelah pemasangan Asril OS, hampir semua perangkat keras esensial seperti kartu video, kartu
suara, dsb bisa berjalan dengan baik. Namun untuk memantapkan perangkat keras tersebut, Anda
perlu mengetahui bagaimana melakukan pengaturan perangkat keras yang ada. Semua hal
menyangkut perangkat keras dibahas dalam bab ini.

Walaupun hampir semua perangkat keras esensial mampu digunakan di Asril OS dengan baik dan
"out-of-the-box" (tanpa perlu pengaturan mendetail), sampai saat ini masalah driver perangkat keras
masih merupakan masalah dominan dan mengganggu dunia Linux. Tidak semua produsen
perangkat keras merilis driver-nya untuk platform Linux. Walaupun ada beberapa, itupun tidak
Open Source dan masih dikembangkan secara tertutup. Hampir semua driver yang saat ini ada di
Linux merupakan hasil jerih payah para komunitas tanpa bantuan dari produsen perangkat keras.
Namun, hal ini akan menjadi masalah waktu saja. Beberapa produsen perangkat keras mulai maju
untuk mengembangkan driver-nya untuk Linux mengingat Linux semakin populer saat ini sebagai
sistem operasi untuk Desktop.

15.1 Pengaturan Tampilan

Pengaturan Tampilan di Asril OS sudah diatur sedemikian rupa, sehingga resolusi layar monitor
sesuai dengan kemampuan monitor yang Anda miliki. Namun jika Anda ingin mengatur resolusi
monitor agar lebih optimal, atau memanfaatkan beberapa monitor yang terpasang di komputer,
Anda bisa melakukannya dengan fitur pengaturan Monitor. Klik Menu Utama > Preferensi >
Pengaturan Sistem pada sub Perangkat Keras pilih Tampilan. Tentukan resolusi layar pada pilihan
[>Resolusi<] serta Rotasi pada pilihan [>Rotasi<]. Jika semua pengaturan sudah selesai klik tombol
[>Terapkan<]. Mungkin saja, Anda akan diminta untuk me-restart mode grafis agar konfigurasi
bisa diterapkan.

Tampilan - + x

Semua Pengaturan

Laptop NYALq Atur sebagai Utama Layar kembar
Catatan: mungkin membatasi opsi resolusi
Resolusi | 1024 x 600 (16:9) -
Rotasi | Normal -
[ Pendeteksian Tampilan Terapkan \
Berpindah ke Mode Nomal Tutup

15.1 Pengaturan Tampilan
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15.2 Pengaturan Printer

Manajemen mesin pencetak atau printer yang ada di Asril OS diatur oleh sebuah perangkat lunak
server bernama CUPS (Common Unix Printing System). CUPS bertanggung jawab untuk menerima
permintaan pencetakan baik dari lokal maupun dari jaringan, melakukan job pencetakan dan
mengirim informasi ke printer untuk melakukan pencetakan.

Secara default, driver mesin pencetak akan langsung terpasang di Asril OS jika mesin pencetak
tersebut sudah tersedia di sistem pada saat printer pertama kalinya dipasang ke komputer. Anda
akan melihat pesan notifikasi bahwa printer baru telah ditambahkan.

Namun, jika mesin pencetak Anda tidak terdeteksi sama sekali atau printer terbagi di jaringan, Anda
bisa membuka alat konfigurasi mesin pencetak yang Anda bisa buka melalui Menu Utama >
Preferensi > Pengaturan Sistem pada sub Perangkat Keras pilih Printer.

Printers - localhost - + x
Server Pencetak Tampilan Bantuan

&= Tambah - | 0

There are no printers configured yet.

Tambah

Terhubung pada localhost 4

15.2 Sistem Konfigurasi Printer

Untuk menambahkan Printer, silahkan klik tombol [>Tambah>] maka anda akan melihat daftar
Printer yang terpasang ke komputer anda, apabila Printer anda sudah di kenali, maka akan tampil
nama printer anda tersebut (sebagai contoh Epson Stylus Photo R230) seperti tampak pada gambar
berikut.

Pencetak Baru - + x
Pilih Perangkat

Perangkat

Masukkan URI
» Pencetak Jaringan Deskripsi

Pencetak terhubung pada port USB.

| Batal ‘ Maju
15.3 Pencetak Baru
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Untuk melanjutkan klik tombol [>Maju<], secara otomatis Deskripsi Pencetak akan terisi, tetapi
anda juga dapat merubahnya sesuai dengan keinginan anda.

Pencetak Baru - + x

Deskripsi Pencetak

Nama Pencetak
Mama singkat untuk pencetak ini, contoh "Laserjet"

| EPSON-Stylus-Photo-R230 |

Deskripsi {opsional)
Deskripsi yang mudah dibaca, conteh "Pencetak HP dengan Dupleks"
[ EPsON Stylus Photo R230 ]

Lokasi (opsional)
Lokasi yang mudah dibaca. contoh "Lab 1"

Ilive }

[ Kembali ” Batal ” Terapkan

4

15.4 Deskripsi Pencetak

Jika sudah selesai semua, lanjutkan dengan klik tombol [>Terapkan>], maka akan muncul pilihan
untuk mencetak Halaman Uji, untuk mengetahui apakah Printer anda sudah terpasang dengan benar.
Untuk melakukannya, silahkan pilih [>Cetak Halaman Uji<], jika Cetak Halaman Uji dapat
dicetak dengan baik, berarti Printer anda sudah terpasang dengan benar.

Cetak halaman uji?

I Batal ] | Cetak Halaman Uji

15.5 Cetak Halaman Uji

Untuk pengaturan yang lain, anda bisa atur melalui Properti Pencetak.

Properti Pencetak - "EPSON-Stylus-Photo-R230' pada localhost *
Pengaturan Pengaturan
Kebijakan Deskripsi: I EPSON Stylus Photo R230
Kontrol Akses
Lokasi: I live

Opsi Pencetak I
Opsi Tugas URI Perangkat: I usb:ﬂEPSON,'StyIus%ZDPhoto%ZDRHD?5eria|=W67P6111]I [ Ubah... l

Tingkatan Tinta -
Pembuat dan model: I Epson Stylus Photo R230 - CUPS+Gutenprint v5.2.9 I [ Ubah...

Status Pencetak: I Diproses - Printing page 1, 30%

Pengujian dan Perawatan

Cetak Halaman Uji ] I Cetak Halaman Uji-Sendiri ] [ Bersihkan Kepala Pencetak l
| Terapkan | I Batal ] [ Oke l
15.6 Properti Pencetak
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Apabila sudah selesai semua, anda akan mendapatkan Printer anda sudah terdaftar pada Sistem
Konfigurasi Printer seperti tampak pada gambar berikut.

Printers - localhost - + =
Server Pencetak Tampilan Bantuan

== Tambah - |0

EPSON-5tylus-Photo-R230

Terhubung pada localhost 4

15.7 Sistem Konfigurasi Printer

15.3 Pengaturan Pemindai

Manajemen pemindai di Asril OS menggunakan perangkat lunak bernama Simple Scan atau
Pemindai Ringkas. Untuk melakukan pemindaian, Anda bisa buka program Pemindai Ringkas
melalui Menu Utama > Grafik > Simple Scan. Sebelum melakukan pemindaian, Pemindai Ringkas
melakukan pendeteksian terhadap mesin pemindai yang terpasang di komputer. Setelah pemindai
ditemukan, maka Anda akan melihat tampilan utama Pemindai Ringkas.

Pemindai Ringkas Soa o
Dokumen Halaman Bantuan

£l Q Scan D; Simpan (8 5 ¢ £ Potong

15.8 Pemindai Ringkas

Tampilan utama Pemindai Ringkas cukup sederhana. Hanya ada baris menu, berapa ikon yang
mudah dimengerti dan jendela utama hasil pemindaian. Sebelum melakukan pemindaian, Anda
dapat melakukan pengaturan pemindaian seperti penggunaan warna, resolusi, ukuran halaman, dan
sisi yang hendak dipindai pada jendela utama melalui menu Dokumen > Preferensi. Setelah
pengaturan selesai, Anda dapat melakukan pemindaian dengan klik pada tombol [>Scan<] pada
jendela utama.
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Pengaturan - %

Scan Source: =
Resolusi Teks | 150 dpi (default) - l
Photo Resolution: | 300 dpi (default) - I
Bidang Pindai: |Depan dan Belakang - l
Ukuran Halaman: |Aut0matic - l
Brightness: Darker \ Lighter
Contrast: - Q 1
Less Mare

Quality: Minimem Maximum

| Tutup

15.9 Pengaturan Pemindai Ringkas

15.4 Pengaturan Kartu Wireless LAN

Berbeda dengan sistem operasi yang lain, dalam Linux khususnya Asril OS, Anda tidak perlu lagi
dipusingkan dengan masalah kartu wireless LAN (WLAN), karena Asril OS sudah memasang
driver-nya secara otomatis, hampir sebagian besar dari jenis-jenis kartu WLAN yang ada saat ini
sudah di dukung oleh Asril OS. Namun, memang tidak dapat dipungkiri bahwa sampai saat ini
masih saja ada beberapa jenis kartu WLAN yang belum di dukung sepenuhnya oleh Asril OS.

Untuk dapat mengetahui apakah kartu WLAN yang kita miliki bekerja dengan baik, kita dapat
memeriksannya dengan mengetikkan perintah [>sudo iwconfig<] ini pada Terminal. Dengan
mengetikkan perintah tersebut, akan keluar output seperti berikut ini :

Terminal - + x
asrilmarhamah@PICO-DJH-Model sudo iwconfig
ppp@ no wireless extensions.

wlan@ 802.11b/g ESSID:"g\xC6isQ\XFFI\XEC)\XCD\XBA\XAB\XFZ\XFB\XE3F | \xC2T\xFB8\x1B\XE8\XE7\X8DVZ. c3\x9F\XCI\x9A"
Mode:Managed Frequency=2.412 GHz Access Point: Not-Associated
Bit Rate:11 Mb/s
Retry min limit:7 RTS thr:off  Fragment thr:off
Encryption key:off
Power Management:off
Link Quality=8/100 Signal level=0 dBm Noise level=8 dBm

Rx invalid nwid:® Rx invalid crypt:@ Rx invalid frag:®
Tx excessive retries:®@ Invalid misc:® Missed beacon:®

lo no wireless extensions.
ethe no wireless extensions.

asrilmarhamah@PICO-DJH-Model

15.10 Hasil sudo iwconfig

Perintah tersebut akan menampilkan semua perangkat jaringan yang terpasang di komputer. Jika
perangkat bukan merupakan WLAN, maka pada bagian kanan nama perangkat tersebut akan
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muncul teks [>no wireless extensions<]. Jika perangkat tersebut merupakan WLAN, maka akan
muncul beberapa detail pada bagian perangkat tersebut seperti pada bagian wlan0. Teks pada bagian
wlan0 menandakan bahwa driver WLAN sudah terpasang dan siap digunakan.

15.5 Pengaturan Bluetooth

Bluetooth saat ini menjadi sarana komunikasi antar perangkat mobile yang sangat banyak
digunakan saat ini. Dengan menggunakan Bluetooth, tidak perlu lagi memasang kabel LAN,
mengatur ESSID, Alamat IP, Gateway dan segala tetek bengek lainnya untuk melakukan
komunikasi antar perangkat. Cukup tentukan tujuan pengiriman data, maka data akan terkirim.
Untuk menggunakan Bluetooth pada komputer, Anda dapat menggunakan alat yang bernama
Bluetooth Adapter atau Bluetooth Dongle. Bahkan, alat ini sudah tertanam secara built-in pada
notebook-notebook terbaru.

Menggunakan Bluetooth adapter pada Asril OS tidaklah sulit. Sebagian besar Bluetooth adapter
yang ada saat ini sudah dapat digunakan di Asril OS tanpa perlu memasang driver-nya lagi. Jika
Bluetooth adapter sudah terpasang dan sudah aktif, maka akan muncul ikon berlambang Bluetooth
pada area notikasi atau tray icon.

Untuk melakukan sambungan terhadap suatu perangkat, berikut adalah langkah-langkahnya :
v Klik pada ikon bluetooth pada notifikasi area, lalu pilih menu [>Set up a New Device<].

v Pilih perangkat bluetooth yang ingin Anda sambungan dan tentukan Opsi PIN yang Anda
inginkan untuk proses berpasangan, kemudian klik tombol [>Lanjutkan<].

Penyetelan Perangkat Baru Bluetooth - + x

Pencarian Perangkat
Penyetelan Perangkat Perangkat Jenis
Menyelesaikan Penyiapan

Ringkasan Pengaturan

£ Mencari perangkat...

Tampilkan:

Jenis perangkat: | Semua jenis - |

Opsi PIN... |

| Batal || Lanjutkan |
Fl

15.11 Penyetelan Perangkat Baru

v Kemudian, Asril OS akan melakukan koneksi ke perangkat yang Anda pilih. Pada tahapan
ini, Anda juga diberitahukan informasi kode PIN yang harus Anda masukkan di perangkat
agar bisa melakukan koneksi dengan baik. Setelah sambungan terjalin, maka anda akan
diberi pilihan untuk pengaturan lebih lanjut. Jika tidak akan melakukan pengaturan tingkat
lanjut klik tombol [>Keluar<].
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Penyetelan Perangkat Baru Bluetooth - + x
Pencarian Perangkat
Penyetelan Perangkat Berhasil menyetel perangkat baru 'Zy_keith’
M.enyelesalkan S vipas Pilih layanan tambahan yang ingin dipakai pada perangkat yang Anda
Ringkasan Pengaturan miliki:

"] Gunakan telepon seluler Anda sebagai perangkat jaringan (PAN/NAP)

["] Akses Internet menggunakan telepon seluler Anda (DUN)

Keluar

15.12 Penyetelan Selesai

Untuk melakukan transfer berkas ke perangkat, klik kanan pada ikon bluetooth pada area notifikasi,
lalu klik menu [>Send Files to Device<]. Kemudian, pilih berkas yang ingin Anda kirim dan
tentukan Perangkat tujuan, kemudian klik [>Kirim<].

Pilih perangkat yang hendak dikirimi - + x

Perangkat Jenis

# Mencari perangkat...

Tampilkan:

Katagori perangkat: [Semua katagori 'l

Jenis perangkat: [Semua jenis - ]

[ Batal ] [ Kirim ]

15.13 Pilih Perangkat tujuan

15.6 Penganalisa Penggunaan Disk

Untuk menganalisa penggunaan disk dalam komputer, Anda bisa menggunakan bantuan program
Penganalisa Penggunaan Disk. Program ini berbasis grafis untuk menganalisa penggunaan disk
pada lingkungan Cinnamon, program ini akan dengan mudah memindai semua struktur pohon
filesistem, atau direktori khusus sesuai dengan pilihan Anda. Aplikasi ini bisa diakses melalui Menu
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Utama > Administrasi > Penganalisa Penggunaan Disk silahkan pilih yang akan di analisa.

Penganalisa Penggunaan Disk - + x
Penganalisa Tilikan Bantuan
PICO-DJH-Model
Folder Cara pakai Ukuran s
A 100,0 % 6,1GEB 1
b usr 80,7 % 49GEB 1
b var 8,0 % 485,3 MB
b opt 5.9 % 338.4 MB
b lib 3.8 % 226,2 MB
» boot 0,7% 39.8MB
b etc 0,5% 31.8MB
sbin 0,3% 15.3MB
bin 0,2% 9.9MB
b tmp 0.0 % 524,3 kB
lost+found
b media 0.0% 82kB
cdrom 0,0% 41kB
root |
( srv 0.0 % )4.1kB Lel Ei )

15.14 Penganalisa Penggunaan Disk



N g Zengguna

BAB 16 Pengaturan Pengguna

Sistem operasi Asril OS merupakan sistem operasi multiuser atau banyak pengguna. Linux bisa
digunakan oleh banyak pengguna yang memiliki ruang dan lingkungan masing-masing. Setiap
pengguna juga memiliki nama akun pengguna (userid) dan kata sandi. Nama pengguna dan sandi
ini akan diminta pada saat pertama kali menjalankan Asril OS. Oleh karena itu, pengetahuan tentang
manajemen pengguna sangat dibutuhkan dalam mempelajari Asril OS. Baik bagi mereka yang
sekadar pengguna rumahan yang hanya memilik satu jenis pengguna di sistem mereka, ataupun
mereka yang bertindak sebagai sistem administrator. Pada bab ini, dibahas mengenai cara untuk
memanajemen pengguna yang ada di Asril OS melalui fitur Pengguna dan Grup.

16.1 Pengaturan pengguna

Untuk melakukan pengaturan pengguna melalui antarmuka grafis, Anda bisa klik Menu Utama >
Administrasi > Pengguna dan Grup. Masukkan kata sandi anda, berikut tampilan Pengguna dan
Grup.

Pengguna dan Grup -+ x

Pengguna Grup

- !

Jenis Akun ‘Admlmstrator

Nama Asril Marhamah

adm, cdrom, dip,
Grup Ipadmin, plugdev,
sambashare, sudo

‘m Hapus
16.1 Pengguna dan Grup

16.2 Menambah Pengguna

Untuk menambah pengguna baru, klik pada tombol “Tambah”. Masukkan Jenis Akun, Nama
Lengkap, dan Nama Pengguna.

Jenis Akun | Standar

MNama Lengkap | |

Nama Pengguna | |

| Batal Tambah
16.2 Menu Tambah

i

Setelah itu klik tombol “Tambah”. Maka akan terdaftar di Pengguna dan Grup.

L Halaman 125



Pengaturan Pengguna

| Pengguna | Grup

asrilmarhamah

Asril Marhamah

Pengguna dan Grup

Gambar

Jenis Akun | Standar

Nama Masriadi

Kata sandi

Grup asril

Tambah l

| Hapus l

Belum ada kata sandi yang dibuat

16.3 Pengguna Baru

Untuk memberikan sandi pada Pengguna Baru, klik pada “Kata sandi” pada “Belum ada kata sandi

yang dibuat”, maka akan muncul jendela untuk mengatur kata sandi.

SandiBaru ||

Konfirmasi sandi |

[ Tampilkan sandi

Batal

Ubah

16.4 Sandi Baru

Silahkan masukkan sandi baru dan konfirmasi, pastikan indikator sampai “OK”, setelah selesai klik
“Ubah”. Sekarang, Anda bisa melihat pengguna baru sudah memiliki sandi. Untuk masuk ke sistem
menggunakan pengguna tersebut, silahkan Log Out dan masuk lagi dengan Nama Pengguna dan

Kata Sandi yang telah dibuat.

16.3 Mengganti Gambar Pengguna

Untuk mengganti gambar Pengguna, klik Pengguna yang akan di ganti gambarnya dan klik pada
bagian gambar, kemudian pilih gambar yang sesuai, jika ingin menggunakan gambar yang
tersimpan di komputer, klik Ramban untuk mencari gambar lainnya, lakukan pencarian pada folder
dimana Anda meletakkan gambar yang ingin digunakan, klik gambar tersebut kemudian buka,

kemudian klik Pilih.



Pengaturan Pengguna

?'Penggunaré Grup

Asril Marhamah
asrilmarhamah

| Tambah

Pengguna dan Grup

Gambar

Jenis Akun
Nama
Kata sandi

Grup

Hapus

16.5 Ganti Gambar Pen

16.4 Menghapus Pengguna

guna

Untuk menghapus pengguna yang sudah ada, klik Pengguna yang akan di hapus kemudian klik
tombol “Hapus” maka akan muncul pemberitahuan untuk menghapus pengguna. Jika sudah yakin,
klik tombol “Ya”, maka pengguna tersebut terhapus.

berhubungan dengan pengguna ini?

Apakah kamu yakin untuk menghapus secara pemmanen asril dan semua berkas yang

| Tidak || w

16.6 Pemberitahuan untuk menghapus Pengguna

16.5 Pengaturan Grup

Grup merupakan sekumpulan dari pengguna yang sama-sama memiliki suatu wewenang, seperti
wewenang pada sistem dan wewenang pada berkas sistem. Untuk melakukan pengaturan Grup, klik
tab “Grup”, maka akan muncul daftar grup yang ada di sistem. Anda bisa menambah, mengatur dan

menghapus Grup.

Pengguna | Grup

adm
asrilmarhamah
audio

avahi
avahi-autoipd
backup

bin
bluetooth
cdrom

colord
crontab
daemon
dialout.

dip

disk

fax

floppy

fuse

Tambah

Pengguna dan Grup

sunting

Hapus

16.7 Pengaturan Grup
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BAB 17 Aksara Nusantara

Asril OS adalah distribusi linux hasil remastering lokal Indonesia yang berusaha menampilkan ciri
khas Indonesia. Salah satu di antaranya adalah aksara - aksara Nusantara yang pernah dipakai di
negeri ini. Sayang sekali sekarang orang Indonesia sendiri justru tidak dapat membaca dan menulis
menggunakan aksara aslinya sendiri.

Aksara Nusantara yang ada di Asril OS ini diambil dari BlankOn Linux, kami percaya bahwa aksara
- aksara ini wajib dilestarikan dan digunakan kembali oleh orang-orang Indonesia. Oleh karena itu
Asril OS berusaha menyertakan aksara Nusantara di setiap rilisnya. Dengan adanya Aksara
Nusantara ini, Asril OS dapat digunakan untuk pengetikan aksara-aksara Nusantara.

Aksara-aksara yang dapat digunakan antara lain :

v Aksara Bugis
Aksara Sunda
Aksara Rejang
Aksara Bali (terbatas di beberapa aplikasi saja)
Aksara Jawa (terbatas di beberapa aplikasi saja)
Aksara Batak Toba

R X X X

Aksara-aksara tersebut merupakan bagian dari standarisasi internasional yang disebut dengan
Unicode (http://www.unicode.org). Dengan demikian, teks yang ditulis dengan Asril OS akan dapat
dibaca kembali pada sistem lain yang juga menggunakan standar Unicode.

Khusus aksara Bali dan Jawa tidak dapat digunakan penuh dengan aplikasi yang terinstal di Asril
OS karena keterbatasan dukungan perangkat lunak. Fonta Bali dan Jawa yang dikembangkan
menggunakan teknologi OpenType yang tidak sepenuhnya berjalan baik di beberapa perangkat
lunak terpasang seperti Chromium. Namun pada aplikasi-aplikasi biasa berbasis Gtk+ lainnya,
aksara Bali dan Jawa bisa digunakan sempurna.

17.1 Mengaktifkan Metode Input

Untuk dapat mulai mengetikkan aksara-aksara Nusantara, Anda perlu mengaktifkan metode
input terlebih dahulu. Untuk mengaktifkan metode input, klik Menu Utama > Preferensi >
Bahasa. Pada Tab Metode Input di opsi "Metode Input”, pilih ”SCIM”. Setelah itu keluarlah
dari desktop dan masuk kembali. Asril OS menggunakan SCIM sebagai alat metode inputnya.

17.2 Menggunakan Metode Input

Untuk memulai pengetikan, buka aplikasi yang hendak Anda isi dengan tulisan beraksara
Nusantara. Kemudian pada kotak isian teks, tekan tombol pemicu “Ctrl + Spasi”. Pada pojok
kanan bawah layar klik gambar keyboard. Pilih aksara Nusantara yang hendak Anda pakai pada
menu tersebut, kemudian Anda bisa memulai pengetikan kata dan kalimat yang Anda inginkan
dalam aksara Nusantara.
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17.3 Teknik Pengetikan

Pengetikan bisa dilakukan seperti mengetik biasa dalam aksara latin. Metode input pada Asril
OS akan secara otomatis menerjemahkan apa yang anda ketik dalam aksara Nusantara. Agar
aksara dapat ditampilkan sesuai dengan keinginan, ada beberapa trik-trik khusus dalam proses
pengetikan, secara umum pengetikan dapat dilakukan dengan melakukan hal-hal berikut ini :

v Tekanlah tombol spasi setiap satu suku kata, agar proses pemenggalan baris dan
pemilihan aksara lebih baik.

v Tekan kembali Ctrl+Spasi untuk kembali ke pengetikan biasa (matikan fitur aksara
Nusantara)

17.4 Pengetikan Aksara Nusantara

17.4.1 Aksara Bugis

v Untuk bunyi e, ketik dengan kombinasi vokal ”AE”.
v Tanda pallawa (. ), diperoleh dengan menekan tombol titik (.)

Contoh Pengetikan

Teks yang hendak di ketik Aksara Lontara Urutan Tombol tik
énka énka gare AMRAAR A aenka aenka gare
énka seuwa wétu AARCO AR AN AR A aenka seauwa waetu
maseriadi VORAMY maseriadi
manre @ manre
marengala VAN marengala

17.4.2 Aksara Bali

Pengetikan Aksara Bali yang tercantum dibawah ini saya ambil dari Buku Panduan
BlankOn Rote, saya belum mencobanya. (Saya tidak paham tentang tata cara penulisan
aksara Bali, kalau ada yang berkenang mungkin bisa memberikan masukan untuk
melengkapi Buku Panduan sederhana ini).

v Untuk menuliskan sebuah suku kata dalam vokal taling (&), tekan tombol Shift+E
setelah mengetik konsonan yang diinginkan. Misalnya dalam mengetik kata "Nenten”
tekan tombol (secara berurutan) N, Shift+E, N, T, E, N

v Untuk menuliskan vokal taling repa (ag), pada suatu suku kata, tekan tombol A + 1
setelah tombol konsonan yang diinginkan.

v Untuk menuliskan vokal taling repa tedung () pada suatu suku kata, tekan tombol A +
U setelah menekan tombol konsonan yang diifiginkan.

v Untuk menuliskan vokal pepet tedung () pada suatu suku kata, tekan tombol A + O
setelah konsonan yang diinginkan.

v Untuk menuliskan vokal suku ilut g), tekan tombol U selama 2 kali setelah menekan
tombol konsonan yang diinginkan.
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v Untuk menuliskan vokal panjang (kosonan + tedung) dalam suatu suku kata, tekan
tombol A dua kali setelah konsonan yang diinginkan. Misalnya, dalam mengetik

”Kaatur” (e sy ), tekan tombol (secara berurutan) K, A, A, T, U, Shift+R.

v Untuk menuliskan vokal ulu sari dalam suatu suku kata (dalam kondisi tertentu sesuai
aturan penulisan aksara Bali), tekan tombol I dua kali setelah konsonan yang
diinginkan. Misalnya, dalam mengetik kata ”Sari” (wm(%), tekan tombol (secara
berurutan) S, A, R, I, L.

v Untuk menuliskan tanda cecek untuk membunyikan konsonan ”NG” pada saat tertentu
(sesuai dengan aturan penulisan aksara Bali), tekanlah tombol Shift + N + G (secara
berurutan sambil menahan tombol yang sebelumnya ditekan) atau (secara berurutan)
Shift + N dan Shift + G. Misalnya jika ingin mengetik kata ”Kangkung”, tekan tombol
(secara berurutan) K, A, (Shift + N + G), K, U (Shift + N+ G) ().

v Untuk menuliskan tanda bisah untuk membunyikan konsonan "H” pada saat tertentu
(sesuai dengan aturan penulisan aksara Bali), tekanlah tombol Shift + H. Misal jika
mengetik kata "PISAH” (gwm), tekan tombol (secara berurutan) P, I, S, A, Shift + H.

v Untuk menuliskan tanda surang untuk membunyikan konsonan ”R”, tekanlah tombol

Shift + R. Misal jika mengetik kata "KASAR” (eamayv), tekan tombol (secara
berurutan) K, A, S, A, Shift + R.

v Untuk menuliskan konsonan-konsonan dengan aksara khusus (selain 18 konsonan
standar aksara Bali), gunakan kombinasitombol seperti tabel berikut :

Da Madu D + H + vokal

Ta Latik T+ T + vokal

Ta Tawa T + H + vokal

Sa Sapa S + S + vokal

Sa Saga S + H + vokal

Ba Kembang B + H + vokal

Pa Kapal P + H + vokal

Na Rambat N + N + vokal

Ka Mahaprana K+ H + vokal

Ga Gora G + H + vokal

Ca Laca C + H + vokal

Ja Jera J+ H + vokal

Ta Murda T+ T+ H + vokal
Da Murda Alpaprana D + D + vokal

Da Murda Mahaprana D + D + H + vokal

v Untuk mengetik karakter vokal tunggal (a kara, i kara, u kara). Gunakan kombinasi
tombol seperti tabel berikut :
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A kara Shift + A

A kara tedung Shift + A (2 kali)

I kara Shift + 1

I kara tedung Shift + I (2 kali)
U kara Shift + U

U kara tedung Shift + U (2 kali)
E kara Shift + E

O kara Shift + O

O kara tedung Shift + O (2 kali)
Al kara Shift + A, Shift + 1

v Fonta Bali yang disertakan belum mendukung beberapa aplikasi terkenal, seperti
OpenOffice.org, Chromium, dan aplikasi non GTK lainnya (rencananya Fonta akan di-
porting ke teknologi SIL Graphite).

v Belum menerapkan teknik ligatura untuk penggabungan antara suatu glyph dengan
tanda tedung (), seperti yang lumrah digunakan dalam teks aksara Bali.

v Masih terdapat beberapa kesalahan rendering jika tanda suara atas disandingkan
dengan konsonan tertentu (Ka Mahaprana, Ja Jera, Nya, dsb)



Contoh Pengetikan.

Teks wyang hendak | Aksara Bali Urutan tombol tik
ditulis
=
g;{?QJx W
J —
(m Swastyastu O, M, spasi, 5, W, A
T, Y, A8 TU
£ oopy
ANIQENCST
Sane Mangkin =) 5, A, N, Shift4E,
spasi, M, A, N, G, K,
I.N
b o
M@j'lfﬁ” /AN
Sang Arjuna S, A, Shift+N,
Shift+4+ G, spast,
Shift+ A, Shift+R,
J, U N, N A
Raja Airlangga R, A, I, A, spasi
Shift+ A, Shift 41,

BlankOn Linux (Dit-
ulis Blangkon Linuk)

Penjor (ditulis Penyjor
sesual dengan aturan

aksara Bali)

Desa Adat Krobolan

Sesapi Putih

Somat Ganteng

L o
ﬁﬁlf?%‘j* , 9(;]1'}@,‘1“ I:"‘-
"y 3

LA

TAMaASHABAS
e BPSTSIN

- O O
ARDBNNISY;

w’y@ % @\\

sShift4+R, L, A, N, G,
G, A

P, E N; ¥%; I,
Shift+ R

D, E, 5, 5 A, spasi,
shift+A, D, A, T,
spast, K, R, O, B, O,
K, AN

51 1
| e A

S5, A, P, I, spasi,
, I, Shift+H

5,0, M, A, T, spasi, G,
A, N, T, E, Shift+N,
Shift+G

Aksara Nusantara







I S don Pofikifias

BAB 18 CMS dan Produktifitas

Content Management System (CMS) — Content Management System atau sering disebut dengan
CMS adalah aplikasi web yang berisikan template untuk mengelola isi halaman web secara mudah.
Penggunaan Content Management System tidak memerlukan pengetahuan pemrograman web yang
handal karena proses instalasi dan cara penggunaannya sudah user friendly. CMS sendiri ada yang
dibuat khusus menyesuaikan kasus yang ada dan biasanya berbayar dan ada yang berupa template
instan yang fungsionalitasnya dibuat dengan menyeuaikan pada beberapa proses bisnis yang ada
didunia nyata yang dapat digunakan secara gratis.
Aplikasi Content Management System instant yang banyak terdapat di internet saat ini kebanyakan
dibuat menggunakan scripting language PHP dan database-nya adalah MySQL. Saat ini
perkembangan Content Management System cukup pesat, banyak vendor yang membuat CMS
instant yang didistribusikan secara gratis. Perkembangan CMS instant ini juga dipicu oleh
perkembangan web 2.0 yang memungkinkan interaksi dalam arti yang cukup luas antara pengelola
web dan pengunjung web.
Selain perkembangan teknologi web dan infrastruktur internet, perkembangan pesat Content
Management System juga dipicu oleh kebutuhan masyarakat dan pelaku bisnis yang menginginkan
web dapat mendukung kegiatan bisnis mereka secara mudah dalam hal pengelolaan content, cepat
dalam pembuatan web, serta murah dalam pengadaannya.
Bahkan saat ini, pengembangan aplikasi web CMS sudah banyak yang menggunakan konsep
freamework. Dengan konsep ini, sangat dimungkinkan untuk melakukan modifikasi terhadap
beberapa fitur Content Management System instant tersebut karena semuanya dibuat lebih modular.
Berikut adalah beberapa contoh web CMS instant yang dibuat oleh vendor dan dapat digunakan
secara gratis dan scripting language yang digunakan adalah PHP dengan database server MySQL.
Untuk menjalankan aplikasi berbasis CMS, kita memerlukan aplikasi server, aplikasi web dan
apliaksi database. Daripada memasang dan mengkonfigurasi satu per satu apliaksi tersebut, kita bisa
menggunakan aplikasi Web Server XAMPP yang sudah menyertakan server, web dan database
dalam satu paket. Dengan demikian kita dapat menjalankan aplikasi berbasis CMS dengan mudah
dan praktis.
Berikut ini beberapa pemanfaatan dari Content Management System atau CMS, yaitu :

1. Untuk membuat website perusahaan, bisnis, komunitas.

Untuk membuat website pribadi / personal blog.
Untuk membuat aplikasi web e-Commerce.
Untuk membuat aplikasi web e-Learning.
Untuk membuat aplikasi e-Office.

o Uk W

Untuk membuat aplikasi web e-Forum dan lain-lain.

18.1 Web Server

Web Server adalah suatu server yang memberikan service (layanan) kepada klien yang meminta
informasi berkaitan dengan web. Web server sendiri terdiri dari dua komponen. yang pertama
adalah komputer itu sendiri dan software web server yang dipakainya. jadi dapat diambil
kesimpulan mesin(komputer) apapun bisa saja menjadi web server asalkan software web server
tersedia di mesin(komputer) itu. salah satu software web server yang tersedia adalah Apache, tapi
selain itu masih banyak lagi web server lainnya seperti ISS, Xitami, dll.
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18.1.1 Web Server XAMPP

XAMPP adalah perangkat lunak bebas, yang mendukung banyak sistem operasi,
merupakan kompilasi dari beberapa program. Fungsinya adalah sebagai server yang berdiri
sendiri (localhost), yang terdiri atas program Apache HTTP Server, MySQL database, dan
penerjemah bahasa yang ditulis dengan bahasa pemrograman PHP dan Perl. Nama XAMPP
merupakan singkatan dari X (sistem operasi apapun), Apache, MySQL, PHP dan Perl.
Program ini tersedia dalam GNU General Public License dan bebas, merupakan web server
yang mudah digunakan yang dapat melayani tampilan halaman web yang dinamis. Untuk
mendapatkanya  dapat mendownload langsung dari web  resminya @ di

http://www.apachefriends.org/.

Untuk mengaktifkan layanan Web Server XAMPP anda dapat lakukan dengan membuka
XAMPP Control Panel melalui Menu Utama > Produktifitas > XAMPP Control Panel.

Welcome | Manage Servers | Application log

Server | Status |
@ MySQL Database Running Start
@ ProFTPD Running E—
= " Stop
¢ Apache Web Server Running s 1 |
Restart
Configure
Start All | Stop Al | Restart All |

18.1 XAMPP Control Panel

Pilih menu Manage Services untuk mengatur. Secara default sudah kami aktifkan dalam
artian sudah berjalan otomatis begitu komputer diaktifkan, sehingga anda bisa langsung
menggunakan aplikasi CMS yang sudah kami sertakan tanpa harus mengaktifkan Web
Server XAMPP terlebih dahulu. Melalui Control Panel ini, anda dapat menjalankan ataupun
menghentikan Web Server XAMPP. Jika belum aktif, bisa juga anda lakukan dengan
mengetikkan perintah di Terminal seperti berikut ini :

sudo /opt/lampp/lampp start <

untuk menjalankan Web Server XAMPP

sudo /opt/lampp/lampp restart <

untuk menjalankan ulang Web Server XAMPP

sudo /opt/lampp/lampp stop <*
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untuk menghentikan Web Server XAMPP

Untuk mengakses Web Server XAMPP dapat dilakukan dengan mengetikkan “localhost”
pada Web Browser, secara default keamanan kami aktifkan, anda dapat membukanya
dengan menggunakan user name xampp dengan password admin. Adapun tampilannya
seperti tampak pada gambar berikut ini :

Welcome to XAMPP - Chromium

(] welcome to XAMPP

= apl

Apache Friends Applications FAQs HOW-TO Guides PHPInfo phpMyAdmin

XAMPP Apache + MariaDB + PHP + Perl

Welcome to XAMPP for Linux 5.6.40

You have successfully installed XAMPP on this system! Now you can start using Apache, MariaDB, PHP and other components. You can
find more info in the FAQs section or check the HOW-TO Guides for getting started with PHP applications.

XAMPP is meant only for development purposes. It has certain configuration settings that make it easy to develop locally but that are
insecure if you want to have your installation accessible to others. If you want have your XAMPP accessible from the internet, make sure
you understand the implications and you checked the FAQs to learn how to protect your site. Alternatively you can use WAMP, MAMP or
LAMP which are similar packages which are more suitable for production.

Start the XAMPP Control Panel to check the server status.

C® 00O €1m= ()% Min, 21 Feb 21, 08:26

18.2 Web Serve XAMPP

Untuk mengakses phpMyAdmin dan melakukan perubahan pada DataBase anda dapat
lakukan dengan mengetikkan http://localhost/phpmyadmin/ pada Web Browser, untuk login
gunakan usernam root dengan password admin.

Semua username yang berhubungan dengan Web Server XAMPP kami atur semua
password nya adalah admin untuk kemudahan dalam penggunaan, namun anda dapat
menggantinya sesuai dengan kebutuhan anda.

18.1.2 Fitur Web Server XAMPP
Pada rilis kali ini, kami menyertakan XAMPP versi 5.6.40-0 dengan beberapa fitur sebagai
berikut :
1. Apache 2.4.18
MySQL 5.0.11
PHP 5.6.23
PEAR + SQLite 2.8.17/3.7.17 + multibyte support (mbstring)
Perl 5.16.3
PhpMyAdmin 4.5.2
OpenSSL 1.0.1e
ProFTPD 1.3.4c
. GD 2.0.35
10. Freetype 2.4.8

© PN U R W
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18.2 Aplikasi CMS

Asril OS menyertakan beberapa aplikasi CMS yang kami anggap bisa memenuhi kebutuhan anda
dalam menggunakan komputer sehari-hari dengan berbagai latar belakang dan profesi. Adapaun
aplikasi CMS yang kami sertakan pada rilis kali ini yaitu AhadPOS merupakan Aplikasi CMS untuk
melakukan transaksi Point Of Sales (POS), JIBAS merupakan Aplikasi CMS untuk melakukan
administrasi akademik pada dunia pendidikan, SLIMS merupakan Aplikasi CMS untuk melakukan
manajemen pada perpustakaan dan TCExam merupakan Aplikasi CMS untuk melakukan
manajemen ujian berbasis elektronik. Berikut penjelasan singkat dari Aplikasi CMS tersebut.

18.2.1 AhadPOS

AhadPOS adalah software POS / Point Of Sales (software kasir / jual-beli) untuk UKM,
dengan lisensi Open Source (GPL v2).

AhadPOS di desain untuk dapat :
1. Melakukan banyak transaksi jual-beli dengan akurat, mudah, dan cepat,
memungkinkan UKM untuk berkembang.

2. Memungkinkan pelacakan stok / inventory yang akurat secara real-time,
meminimalisir kemungkinan kebocoran, kecurangan, pencurian, dll

3. Pencatatan transaksi keuangan yang akurat, salah satu masalah di UKM adalah
pembukuan.

Dengan AhadPOS, maka ini langsung tercatat di databasenya secara otomatis, sehingga bisa
terlacak secara akurat.
Berbasis Web

AhadPOS sangat powerful, dan tetap mudah digunakan. Dengan memanfaatkan berbagai
fitur dari browser Firefox, maka AhadPOS bisa digunakan dengan cepat, walaupun berbasis
Web / menggunakan software browser. Karena berbasis Web, maka AhadPOS jadi memiliki
beberapa kelebihan dibandingkan software POS lainnya, Seperti :

1. Fleksibel.

2. Mudah di customize / disesuaikan dengan kebutuhan masing-masing penggunanya.

3. Bisa diakses dari berbagai jenis perangkat : tablet, notebook, dll. AhadPOS bahkan
telah digunakan dengan menggunakan Smartphone (Nokia E71) di sebuah lokasi.

4. Mudah di maintain / maintenance.

5. Dan banyak lagi keuntungan dari platform Web.
Untuk menggunakan aplikasi AhadPOS ini, bisa melalui klik Menu Utama > Produktifitas
> AhadPOS atau melalui web browser dengan mengakses alamat http://localhost/ahadpos/

Adapun tampilan awal AhadPOS seperti tampak pada gambar berikut ini


http://localhost/ahadpos/
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AhadPOS I - Login - Chromium

AhadPOS ¥ - Login X +

& 5 C O localhost/ahadpos/app/login

18.3 Halaman Login AhadPOS

Untuk menggunakannya silahkan login terlebih dahulu, secara default, gunakan user :
admin dan password : admin adapun tampilan menunya seperti tampak pada gambar

berikut.

AhadPOS ¥ - Chromium

AhadPOS ¢ B
& 2> C @ localhost/ahadpos/ - % @ i

@ Administrator

2 Config [ Transaksi @ Laporan & Tools

AhadPOS ¥

Logm —

Administrator | ETICETG 21-03-2020 07:06:29 dari 0.0.0.0

Powered by [RTLZELEWC Sponsared by

22-03-2020 07:29:48 VEE) oy YA a5V

18.4 Tampilan Menu Admin

Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan anda, silahkan dipergunakan dengan bijak. Selamat menggunakan AhadPOS.
Semoga dapat banyak bermanfaat bagi bisnis Anda. Info lebih lanjut mengenai AhadPOS
ini, anda dapat mengeceknya di blog resmi AhadPOS di https://ahadpos.wordpress.com/.
Sudah disertakan juga panduan yang dapat anda akses melalui Menu Utama > Panduan >

Panduan AhadPOS.
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18.2.2 JIBAS

JIBAS singkatan dari Jaringan Informasi Bersama Antar Sekolah. JIBAS lahir dari visi
"Kebersamaan untuk Kemajuan Pendidikan Indonesia". Misi JIBAS adalah membangun
jaringan informasi dan komunitas pendidikan yang bisa mewadahi interaksi dan aktifitas
setiap elemen pendidikan dari siswa, guru, orang tua, sekolah,yayasan, pemerintah dan
masyarakat umum.

Singkat kata, jaringan yang dibentuk JIBAS akan menggabungkan fitur dan layanan berupa
komunitas + konten + informasi + hiburan, mirip gabungan Facebook + Google + Yahoo +
Wikipedia tetapi khusus untuk pendidikan Indonesia. Jaringan ini bersifat terbuka dan
tumbuh mandiri. Terbuka artinya, berbagai pihak dapat ikut serta mengembangkan dan
menyediakan layanan pendidikan bagi komunitas yang terbentuk. Tumbuh mandiri
maksudnya, jaringan komunitas ini berkembang dari aktifitas dan interaksi dari setiap
anggotanya.

Salah satu wujud JIBAS yaitu sistem informasi manajemen sekolah yang membantu
operasional sekolah mulai dari akademik, keuangan, perpustakaan, pelaporan dan interaksi
guru-siswa. Diharapkan, sistem ini dapat membantu sekolah mengatur, mengelola dan
merapikan datanya. Dengan demikian, data ini menjadi informasi yang mengalir dan
bermanfaat bagi berbagai pihak yang berkepentingan. Tentunya, hal ini dapat menjadi salah
satu nilai tambah dari layanan komunitas pendidikan yang dibentuk. Karena Yahoo,
Facebook, Google dan Wikipedia, dan berbagai layanan yang diberikan situs lainnya
berasal dari kerapihan dan keteraturan data.

Sistem ini dipasang secara lokal di sekolah jadi memudahkan sekolah untuk
menggunakannya. Secara berkala, data operasional sekolah ini ditransfer secara online atau
offline ke basis data JIBAS pusat. Jadi, bagi sekolah yang berada di daerah atau belum
memiliki fasilitas Internet memadai, masih dapat terhubung ke jaringan JIBAS. Dari basis
data JIBAS pusat inilah kemudian dibentuk layanan komunitas, informasi sekolah dan
konten pendidikan yang dapat diakses oleh berbagai elemen pendidikan, dari mulai siswa,
guru, orang tua, sekolah, yayasan, pemerintah dan masyarakat umum.

JIBAS Education Community 3.0 - Mozilla Firefox - + X
T
/ |Ed 18As Education Commun... x | &

e e & [Q search ve & & ®|=

-~ SEKOLAH PENDIDIKAN INDONESIA o~

\uis i)

AKADEMIK KEUANGAN PERPUSTAKAAN KEPEGAWAIAN PELAPORAN ANJUNGAN

o e
», & 1 | 1 ™

INFO GURU INFO SISWA SMS GATEWAY AUTO RESPONSE PHOTO TAKE

%

—_—

SINKRONISAS!
DATA

18.5 Tampilan Utama JIBAS
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Untuk menggunakan aplikasi JIBAS ini, bisa melalui klik Menu Utama > Produktifitas >
JIBAS atau melalui web browser dengan mengakses alamat http://localhost/jibas/. Adapun
tampilan utama JIBAS seperti tampak pada gambar diatas.

Untuk menggunakannya silahkan klik menu yang ada di Tampilan Utama tersebut, secara
default, gunakan user : jibas dan password : password

Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan anda, silahkan dipergunakan dengan bijak. Info lebih lanjut mengenai JIBAS ini,
anda dapat mengeceknya di web resmi JIBAS di http://www.jibas.net/.

18.2.3 SLIMS
Apa itu SLIMS (Software Senayan Library Management System)

SLIMS adalah perangkat lunak sistem manajemen perpustakaan (library management
system) sumber terbuka yang dilisensikan di bawah GPL v3. Aplikasi ini pertama kali
dikembangkan dan digunakan oleh Perpustakaan Kementerian Pendidikan Nasional, Pusat
Informasi dan Hubungan Masyarakat, Kementerian Pendidikan Nasional. Aplikasi SLIMS
dibangun dengan menggunakan PHP, basis data MySQL, dan pengontrol versi Git. Pada
tahun 2009, SLIMS mendapat penghargaan tingkat pertama dalam ajang INAICTA 2009
untuk kategori open source.

Ketika dirilis pertama kali, SLIMS baru diunduh 704 kali. Angka ini melonjak menjadi
6.000 kali lebih pada Desember 2007 dan 11 ribu lebih Januari 2008. Adapun pada Oktober
lalu program itu sudah diunduh hampir 27 ribu kali. Dengan demikian, total sudah 250 ribu
kali lebih program itu diunduh. Saat ini SLIMS telah digunakan luas oleh berbagai
perpustakaan, baik di dalam maupun luar negeri.

Beberapa Fitur SLIMS :
1. Online Public Access Catalog (OPAC) dengan pembuatan thumbnail yang di-
generate on-thefly.
2. Thumbnail berguna untuk menampilkan cover buku.

3. Mode penelusuran tersedia untuk yang sederhana (Simple Search) dan tingkat lanjut
(Advanced Search)

4. Detail record juga tersedia format XML (Extensible Markup Language) untuk
kebutuhan web service.

5. Manajemen data bibliografi yang efisien meminimalisasi redundansi data.

6. Manajemen masterfile untuk data referensial seperti GMD (General Material
Designation), Tipe Koleksi, Penerbit, Pengarang, Lokasi, Supplier, dan lain-lain.

7. Sirkulasi dengan fitur: Transaksi peminjaman dan pengembalian, Reservasi koleksi,
Aturan peminjaman yang fleksibel, Informasi keterlambatan dan denda.

8. Manajemen keanggotaan.

9. Inventarisasi koleksi (stocktaking)
10. Laporan dan Statistik

11. Pengelolaan terbitan berkala

12. Dukungan pengelolaan dokumen multimedia (.flv,.mp3) dan dokumen digital.
Khusus untuk pdf dalam bentuk streaming.

13. Beragam format bahasa termasuk bahasa yang tidak menggunakan penulisan selain
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latin.

14. Menyediakan berbagai bahasa pengantar (Indonesia, Inggris, Spanyol, Arab,
Jerman).

15. Dukungan Modul Union Catalog Service.
16. Counter Pengunjung perpustakaan.
17. Member Area untuk melihat koleksi sedang dipinjam oleh anggota.

18. Modul sistem dengan fitur: Konfigurasi sistem global, Manajemen modul,
Manajemen User (Staf Perpustakaan) dan grup, Pengaturan hari libur, Pembuatan
barcode otomatis, Utilitas untuk backup.

Untuk menggunakan aplikasi SLIMS ini, bisa melalui klik Menu Utama > Produktifitas >
SLIMS atau melalui web browser dengan mengakses alamat http://localhost/slims/. Adapun
tampilan utama SLIMS seperti tampak pada gambar berikut ini.

e .
)." =7 Open Source Library Man... % "\1.

é! @ | localhost/slims/ s HQ Search ‘ ﬁ B + A O =

@ SENAYAN
Opel urce Library Management System

SEARCHING

18.6 Tampilan Utama SLIMS

Untuk menggunakannya silahkan klik menu yang ada di sebelah kanan atas, secara default,
gunakan user : admin dan password : admin adapun tampilan menu nya seperti tampak
pada gambar berikut.


http://localhost/slims/
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Silahkan  gunakan  sesuai  dengan

M E N U pd kebutuhan anda, anda dapat

mengaturnya sesuai dengan keinginan

anda, silahkan dipergunakan dengan

bijak. Info lebih lanjut mengenai SLIMS

A ini, anda dapat mengeceknya di web
resmi SLIMS di http://slims.web.id/

LIBRARY NEWS

LIBRARY INFORMATION Sudah disertakan juga panduan yang
dapat anda akses melalui Menu Utama
LIBRARY LOCATION > Panduan > Panduan SLiMS.

MEMBER AREA

LIBRARIAN

HELP ON SEARCH
LIBRARIAN LOGIN

ABOUT 5LIMS

18.7 Tampilan Menu

18.2.4 TCExam

TCExam merupakan sebuah software open source berbasis web yang dapat menghasilkan
dan mengelola tes atau ujian secara online. Sebuah e-tes (ujian berbasis komputer)
merupakan ujian elektronik yang dapat dieksekusi dengan menggunakan komputer pribadi
atau perangkat elektronik yang setara (misalnya iPad).

Sistem ini memungkinkan Anda untuk menyederhanakan siklus ujian secara keseluruhan,
termasuk pelaksanaan, evaluasi, presentasi, dan pengarsipan. Penyederhanaan ini
memungkinkan Anda untuk menghemat waktu dan uang sambil meningkatkan kehandalan
ujian.

Adapun fitur-fitur TCExam :

Sistem instalasi otomatis

Software server dengan platform independent

Dukungan multi bahasa (termasuk dukungan untuk TMX standar dan Unicode UTF-8)

Berdasarkan teknologi standar dan standar terbuka (PHP5, MySQL, PostgreSQL,
XHTML, JavaScript, PDF)

Termasuk lapisan abtraksi database dengan driver dari MySQL dan PostgreSQL
Antarmuka berbasis web, kompatibel dengan hampir semua web browser modern

b

7. Mencakup wilayah administrasi yang dilindungi, yang memungkinkan untuk
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10.
11.

12.

13.

14.
15.
16.

17.
18.

19.
20.
21.
22.

mengelola seluruh sistem

Mendukung tingkat akses yang berbeda baik untuk pengguna dan sumber daya
(halaman, bentuk, bagian)

Termasuk sistem keamanan tambahan untuk mengakses tes berdasarkan dari
pengecekan alamat IP

Mendukung jumlah tes, topik, pertanyaan, dan jawaban yang tak terbatas

Mendukung format teks dan penggunaan gambar dalam deskripsi tes, pertanyaan, dan
jawaban

Sekali ditetapkan, topik dapat digunakan sendiri-sendiri atau bersama-sama untuk tes
yang berbeda

Mendukung pertanyaan dengan jawaban banyak dan pertanyaan dengan jawaban
bebas

Menghitung nilai kumulatif secara otomatis untuk berbagai jawaban
Mencakup sistem manual untuk mengevaluasi jawaban bebas

Menghasilkan tes unik untuk setiap pengguna dengan memilih pertanyaan dan
jawaban secara acak yang mungkin

Mendukung waktu untuk mulai dan durasi tes

Dapat menghasilkan versi PDF dari tes, sehingga dapat dilakukan tanpa menggunakan
komputer

Menghasilkan laporan dan data statistik baik dalam XHTML dan format PDF
Memungkinkan kostumisasi format dan header dari dokumen PDF
Mendukung output dari hasil tes bagi pengguna akhir

Mengirimkan hasil tes kepada pengguna ke alamat email pengguna

Hirarki TCExam dimulai dari membuat :

1.

A

Group
User
Modul
Paket Soal

Butir Soal (dibuat satu persatu, berikut kunci jawaban benar dan salahnya, untuk
Multiple Choice)

Lalu terakhir adalah membuat Ujian (Test), di sini kita dapat menentukan beberapa
parameter seperti waktu mulai dan akhir ujian (Test), nilai per butir soal, group yang
dapat mengikuti ujian sampai KKM.

Terakhir menggandeng Test (Ujian) dengan paket soal dan modul yang sudah kita buat
sebelumnya.

Untuk menggunakan aplikasi TCExam ini, bisa melalui klik Menu Utama > Produktifitas >
TCExam atau melalui web browser dengan mengakses alamat http://localhost/tcexam/.
Adapun tampilan utama TCExam seperti tampak pada gambar berikut ini.


http://localhost/tcexam/
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-
TR x|+
<« c @ @ localhost - 9 1 mn o =
| TCESGI 2018-04-12 00:56:08
public | bantuan | informasi | login
Login
Tidak dapat login? Buat akun baru
username
password

1 forgot my password

login

Untuk mengakses bagian-bagian dari TCExam, anda harus log in menggunakan usemame dan password yang diizinkan oleh sistem administrator

[ERIAZIEGIER |CN |DEELIEN [ES|FAIFR [ HI [HE [HU [ |17 [P | MR [MS [NL[PLI RO RU TR [VN
TCExam ver. 13:3.0 - Copyright © 2004-2016 Nicola Asuni - Tecnick.com LTD

18.8 Halaman Login TCExam

Untuk menggunakannya silahkan login terlebih dahulu, secara default, gunakan user : admin
dan password : 1234 adapun tampilan menu nya seperti tampak pada gambar berikut.

T= TCExam X | =+
&« c o (@) localhost B - 9% I @ =
2018-04-12 00:56:39

[LLEHE user | modul | test | backup | public | bantuan | informasi | logout

TCExam

TCEXAM IS SUBJECT TO THE GNU-AGPL v.3 LICENSE LICENSE WITH THE FOLLOWING ADDITIONAL TERMS:

+ YOU CAN'T ALTER, REMOVE, MOVE OR HIDE THE ORIGINAL TCEXAM LOGO, COPYRIGHTS STATEMENTS, LINKS TO TECNICK.COM AND TCEXAM
WEBSITES, OTHER PROPRIETARY NOTICES, LEGENDS, SYMBOLS OR LABELS IN THE SOFTWARE.

+ TCEXAM NAME AND LOGO ARE TRADEMARKS OF TECNICK.COM LTD AND SHALL BE USED IN ACCORDANCE WITH ACCEPTED TRADEMARK
PRACTICE, INCLUDING IDENTIFICATION OF TRADEMARK OWNER'S NAME.

FOR ANY USAGE THAT REQUIRES DIFFERENT (COMMERCIAL) LICENSING TERMS, PLEASE CONTACT INFO@TECNICK.COM TO PURCHASE A
COMMERCIAL LICENSE.

Ini adalah area administratif dari TCExam, yang merupakan software yang memiliki platform dan bahasa user-friendly untuk membuat, mengelola dan melaksanakan
test online.

Dari menu yang ada disebelah kiri anda dapat mengakses bagian sistem yang berbeda-beda:

« User

Pada bagian ini berisi formulir untuk menyisipkan dan mengelola users, untuk memilihnya dan untuk menampilkan daftar user yang saat ini online.

silahkan anda melakukan registrasi dengan username and a password yang akan digunakan untuk mengakses area publik dari sistem dan melaksanakan test.
Ini memungkinkan untuk menentukan level akses yang berbeda baik untuk user dan bagian dan komponen yang berbeda dari sistem (halaman, formulir, bagian).
TCExam juga memiliki pelengkap berupa sistem keamanan untuk mencegah akses oleh yang tidak berwenang dengan memeriksa ip address.

Topik

Bagian ini berisi formulir untuk menyisipkan dan merubah topik test, berkaitan dengan soal dan jawaban.

Anda dapat memilih topik yang tak terhingga yang dapat digunakan bersama sama dalam test tertentu, dan untuk tiap-tiap topik anda dapat mendefinisikan soal
dan jawaban yang tak terhingga. Sistem akan secara acak memilih soal dan jawaban yang tersedia.

TCExam mendukung soal uraian dan soal pilihan ganda. Dan akhirmya akan dievaluasi menggunakan formulir evaluasi yang spesifik , sebagian juga dapat
dievaluasi secara automatik.

Semua diskripsi test, topik, soal dan jawaban didukung oleh kode proprietari (tcecode), yang dengan menggunakan form spesifik, membolehkan untuk
menggunakan gambar dan format text.

18.9 Tampilan Menu Admin

Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan anda, silahkan dipergunakan dengan bijak. Info lebih lanjut mengenai TCExam
ini, anda dapat mengeceknya di web resmi TCExam di http:/www.tcexam.org/. Sudah
disertakan juga panduan yang dapat anda akses melalui Menu Utama > Panduan > Panduan

TCExam.
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18.2.5 sikoperasi

sikoperasi merupakan aplikasi Koperasi Simpan Pinjam ini merupakan aplikasi yang
dideplov oleh Ansori dengan menggunakan bahasa pemrograman PHP dan databse MySQL.
Dimana kita tahu PHP merupakan bahasa pemrograman server-side scripting yang artinya
proses eksekusi kode program dilakukan disisi server bukan client dan juga PHP sering kali
digunakan untuk membuat sebuah situs website yang sangat dinamis.

Pada kesempatan ini saya akan coba bagikan aplikasi ini kepada temen temen semua secara
geratis, aplikasi ini sangat cocok untuk diterapkana dibidang Koperasi Simpan Pinjam
khususnya guna untuk sebuah pendataan baik itu dari data anggota maupun data lainnya
yang berkait dengan koperasi tersebut.

Aplikasi ini juga bisa kalian jadikan sebagi bahan pembelajaran dan bisa dijadikan sebagai
bahan penelitian akan tetapi tidak untuk diperjual belikan demi keuntungan semata,
kebijakan dan pelanggaran atas diperjual belikannya aplikasi ini ada pada pendeplov itu
sendiri jadi gunakanlah dengan bahan ilmu pembelajaran.

18.10 Tampilan Login sikoperasi

Fitur yang terdapat di aplikasi Simpan Pinjam ini diantaranya :
. Tampilan Fitur Home

. Fitur Master Data

. Fitur Transaksi

. FItur Laporan

. FItur Pengaturan

. Fitur Grafik

. Fitur Backup database

0O NN YU~ WN

. Fitur Bantuan aplikasi
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18.11 Menu sikoperasi

18.3 gBilling

gBilling adalah aplikasi sistem pembayaran warnet (warnet billing system) yang terdiri dari server
dan client, gBilling diharapkan bisa berjalan di multi-platform (Linux, BSD, MacQOS, atau
Microsoft Windows). gBilling di tulis dalam bahasa C, dengan GUI toolkit GTK2 (The GIMP
Toolkit), dan menggunakan SQLite sebagai sistem database dan penyimpanan data. gBilling akan
selalu berada di bawah lisensi GNU Public License (GPL) versi 2, silahkan baca lisensi ini sebelum
penggunaan, distribusi dan modifikasi gBilling. Sudah disertakan juga panduan yang dapat anda
akses melalui Menu Utama > Panduan > Panduan gBilling.

18.3.1 Mengapa gBilling

Karena gBilling adalah software bebas (free software), anda dapat mengambil keuntungan
dari aplikasi ini. Anda bisa memodifikasi sesuai keperluan anda, anda bisa mempelajari cara
kerja gBilling dan membuat aplikasi billing anda sendiri, anda bisa berpartisipasi
mengembangkan program ini, dan lain-lain. gBilling akan selalu ditulis dengan mangacu
pada portabilitas, gBilling tidak akan mengacu hanya pada satu sistem yang mana akan
membuang-buang waktu saja.

gBilling tidak dibuat untuk mendapat keuntungan atau penghargaan, gBilling dibuat untuk
mendukung sistem operasi yang bebas seperti Linux agar bisa digunakan dengan baik untuk
warnet. Sekali lagi gBilling adalah software bebas yang berada di bawah lisensi GNU
General Public License versi 2, bukan OSI Open Source, lisensi BSD dan sebagainya.

18.3.2 Fitur-fitur gBilling
Berikut fitur-fitur gBilling :
* Multiplatform (UNIX: Linux, MacOS, BSD, dan Microsoft Windows) untuk arsitektur
32 bit dan 64 bit

* Concurrent TCP/IP server model (IPv4)
e Multithread (per-client thread, dengan GLib Thread)
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* Orientasi penyimpanan database (SQLite embedding)

* Kontrol penuh dari server (logout, shutdown, restart, tutup/buka login client)
* Mendeteksi client yang tidak aktif (program client yang tidak aktif atau komputer client)
» Sistem logging dan export log ke format CSV

* Recovery (recovery data server/client untuk power loss, system crash)

* Autentikasi user (GLib data hashing)

* Chatting

* Sistem paket

» Sistem Item (Item-item yang dijual di warnet ditampilkan di client)

* Kostumisasi sesuai dengan warnet anda (nama warnet, slogan, alamat)

* Notifikasi event dengan suara (login, logout, chat, etc.)

* Rotasi tarif sesuai waktu yang ditentukan

* Free software

18.3.4 gBilling Server

Secara bawaan Asril OS sudah terpasang gBilling Server. Untuk menjadikan sebagai Client
anda dapat menghapus terlebih dahulu aplikasi gBilling Server dengan menggunakan
perintah berikut di Terminal :

sudo apt-get remove gbilling-server

Jika diminta password, silahkan masukkan password anda. Silahkan tunggu sampai proses
penghapusan selesai.

Jika anda sudah terlanjur menghapus aplikasi gBilling Server dan ingin memasang lagi anda
dapat menggunakan perintah berikut di Terminal :

sudo dpkg -i /usr/share/panduan/gbilling-server.deb

Jika diminta password, silahkan masukkan password anda. Silahkan tunggu sampai proses
pemasangan selesai.

Untuk menggunakan gBilling Server (secara bawaan) anda dapat meng-klik Menu Utama >
Produktifitas > gBilling Server. Berikut tampilan gBilling Server :

18. 12 gBilling Server

18.3.5 gBilling Client

Secara bawaan aplikasi gBilling Client belum terpasang di Asril OS. Untuk memasang
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gBilling Client, anda terlebih dahulu harus menghapus gBilling Server. Untuk memasang
gBilling Client anda dapat menggunakan perintah berikut di Terminal :

sudo dpkg -i /usr/share/panduan/gbilling-client.deb

Jika diminta password, silahkan masukkan password anda. Silahkan tunggu sampai proses
pemasangan selesai.

Jika anda ingin menghapus aplikasi gBilling Client, anda dapat menggunakan perintah
berikut di Terminal :

sudo apt-get remove gbilling-client

Jika diminta password, silahkan masukkan password anda. Silahkan tunggu sampai proses
penghapusan selesai.

Berikut tampilan gBilling Cient :

gBilling
warnet suka-suka
di samping kebon singkongnya Mpok Hindun

ZAENAB
O Reguler © Paket ® Admin

Usemame: |

Password: [

v |

[miei | € @

Paket: |

Kamis, 2 Desember 2010 | 20:46:15

gBilling Client 0.3.1

18.13 gBilling Client
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